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Basics

1 Basics

This chapter provides basic information on operating an instrument via remote control.
1.1 Remote Control Interfaces
For remote control, Ethernet or USB interface can be used. Optional interfaces are not available.

SCPI (Standard Commands for Programmable Instruments) SCPI commands - messages - are
used for remote control. Commands that are not taken from the SCPI standard follow the SCPI
syntax rules.

1.1.1 USB Interface

In addition to a LAN interface, the R&S®HMO1002 resp. R&S®HMO 1202 series includes a USB
device port. For this interface, the user can select if the instrument is accessed via virtual COM
port (VCP) or via USB TMC class. The traditional version of the VCP allows the user to communi-
cate with the R&S®HMO1002 resp. R&S®HMO 1202 series using any terminal program via SCPI
commands once the corresponding Windows drivers have been installed. Naturally, the free
software “"HMExplorer” is also available for the R&S®HMO 1002 resp. R&S®HMO1202 series. This
Windows application offers the R&S®HMO 1002 resp. R&S®HMO1202 series a terminal function,
the option to create screenshots and to read out the measured data from the HMO memory.

The modern alternative to the virtual COM port is to remote control the R&S®HMO1002 resp.
R&S®HMO1202 series via USB TMC class. TMC stands for “Test & Measurement Class” which
indicates that the connected measurement instrument can be recognized without special
Windows drivers if VISA drivers are installed and that it can be used directly in corresponding
environments. The GPIB interface serves as model to the structure of the TMC design. A major
benefit of the USB TMC class is that by sampling specific registers the controlling software can
determine if commands have been terminated and if they have been processed correctly. In con-
trast, the communication via VCP requires analysis and polling mechanisms within the control-
ling software which may significantly strain the interface of the measurement instruments. The
TMC status registers solve this problem with the USB TMC in the same manner as is the case
with the GPIB interface for the hardware, namely via corresponding control lines.

If you are using USB you need to install an USB driver, which can be downloaded free of charge
from the Rohde & Schwarz homepage.

The available USB VCP driver is fully tested, functional and released for Windows XP™,
Windows Vista™, Windows 7™ or Windows 8™, both as 32Bit or 64Bit versions.

The USB VCP or USB TMC interface has to be chosen in the SETUP menu and does not need
any setting.

e
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1.1.2 Ethernet (LAN) Interface

The settings of the parameter will be done after selecting the menu item ETHERNET and the
soft key PARAMETER. You can set a fix IP adress or a dynamic IP setting via the DHCP function.
Please ask your IT department for the correct setting at your network.

IP address

To set up the connection the IP address of the instrument is required. It is part of the resource
string used by the program to identify and control the instrument. The resource string has the
form:

TCPIP::<IP_address>::<IP_port>::SOCKET

The default port number for SCPI socket communication is 5025. IP address and port number
are listed In the , Ethernet Settings” of the R&S®HMO 1002 resp. R&S®HMO 1202 series, see also:
chapter 1.2.2,”Configuring LAN Parameters”.

Example:
If the instrument has the IP address 192.1.2.3; the valid resource string is:

TCPIP::192.1.2.3::5025::SOCKET

If the LAN is supported by a DNS server, the host name can be used instead of the IP address.
The DNS server (Domain Name System server) translates the host name to the IP address. The
resource string has the form:

TCPIP::<host_name>::<IP_port>::SOCKET

To assign a host name select SETUP button » PAGE 2|2 » DEVICE NAME.

Example: If the host name is ROHDET; the valid resource string is:

TCPIP::ROHDE1::5025::SOCKET

The end character must be set to linefeed.

SCPI Programmers Manual 5
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1.2 Setting Up a Network (LAN) Connection

1.2.1 Connecting the Instrument to the Network

Risk of network failure
Before connecting the instrument to the network or configuring the network, consult
your network administrator. Errors may affect the entire network.

The network card can be operated with a 10 Mbps Ethernet IEEE 802.3 or a 100 Mbps Ethernet
|IEEE 802.3u interface.

To establish a network connection, connect a commercial RJ-45 cable to one of the
LAN ports of the instrument and to a PC.

1.2.2 Configuring LAN Parameters

Depending on the network capacities, the TCP/IP address information for the instrument can be
obtained in different ways.

If the network supports dynamic TCP/IP configuration using the Dynamic Host Configuration
Protocol (DHCP), and a DHCP server is available, all address information can be assigned auto-
matically.

Otherwise, the address must be set manually. Automatic Private IP Addressing (APIPA) is not
supported.

By default, the instrument is configured to use dynamic TCP/IP configuration and obtain all
address information automatically. This means that it is safe to establish a physical connection to
the LAN without any previous instrument configuration.

Risk of network errors

Connection errors can affect the entire network. If your network does not support
DHCP, or if you choose to disable dynamic TCP/IP configuration, you must assign valid
address information before connecting the instrument to the LAN. Contact your net-
work administrator to obtain a valid IP address.

SCPI Programmers Manual 6
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Configuring LAN parameters
e Press the SETUP key and then the INTERFACE softkey.
e Press the ETHERNET and then the PARAMETER softkey.

If the instrument is set to use DHCP and cannot find a DHCP server, it takes about two
minutes until the Ethernet menu is available.

The ,Ethernet Settings” dialog box is displayed.

INTERFACE
ETHERMET

DHCF

Ethernet &

Fig. 1.1: Ethernet Settings dialog box

Some data is displayed for information only and cannot be edited. This includes the ,MAC"” (phy-
sical) address of the connector and the , Link” status information.

e Define the IP address of the instrument by entering each of the four blocks individually (ma-
nual mode) or choose the automatic IP-Mode.
a) In manual mode (MAN) define the first block number using the knob.
b) Press Next to move to the next block and define the number.
c) When the IP address is complete, press Down to continue with the next setting.

e Define the ,Subnetmask” and , Gateway” in the same way.

e Select the ,IP Port” - the port number for SCPI socket communication.

e Select the ,HTTP Port” used by the instrument.

e Select the , Transfer” mode. This mode can either be determined automatically (,Auto” set-
ting), or you can select a combination of a transfer rate and half or full duplex manually.

e Press SAVE to save the LAN parameters.

The ,,Link” status information at the bottom of the dialog box indicates whether a LAN
connection was established successfully.

e
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Checking LAN and SCPI connection

e Check the LAN connection using ping: ping XxX.yyy.zzz.XXx.

e |f the PC can access the instrument, enter the IP address of the address line of the internet
browser on your computer: http//:xxx.yyy.zzz.xxx

e The ,Instrument Home" page appears. It provides information on the instrument and the LAN
connection.

1.3 Switching to Remote Control

When you switch on the instrument, it is always in manual operation state (,local” state) and
can be operated via the front panel. When you send a command from the control computer, it is
received and executed by the instrument. The display remains on, manual operation via the front
panel is always possible.

1.4 Messages and Command Structure
1.4.1 Messages

Instrument messages are employed in the same way for all interfaces, if not indicated otherwise
in the description.

See also:

e Structure and syntax of the instrument messages: chapter 1.4.2, ,SCPI Command Structure”.
e Detailed description of all messages: chapter 2, ,Command Reference”.

There are different types of instrument messages:
e Commands
e [nstrument responses

Commands

Commands (program messages) are messages which the controller sends to the instrument.
They operate the instrument functions and request information. The commands are subdivided
according to two criteria:

According to the instrument effect:

e Setting commands cause instrument settings such as a reset of the instrument or setting the
frequency.

e (Queries cause data to be provided for remote control, e.g. for identification of the instrument
or polling a parameter value. Queries are formed by appending a question mark to the com-
mand header.

According to their definition in standards:

e The function and syntax of the Common commands are precisely defined in standard IEEE
488.2. They are employed identically on all instruments (if implemented). They refer to func-
tions such as management of the standardized status registers, reset and self test.

® |nstrument control commands refer to functions depending on the features of the instrument
such as voltage settings. Many of these commands have also been standardized by the SCPI
committee. These commands are marked as ,SCPI compliant” in the command reference
chapters. Commands without this SCPI label are device-specific, however, their syntax follows
SCPI rules as permitted by the standard.

e
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Instrument responses

Instrument responses (response messages and service requests) are messages which the instru-
ment is sent to the controller after a query. They can contain measurement results, instrument
settings and information on the instrument status.

LAN Interface Messages
In the LAN connection, the interface messages are called low-level control messages. These
messages can be used to emulate interface messages of the GPIB bus.

Command Long term Effect on the instrument

&DCL Device Clear Aborts processing of the commands just recei-
ved and sets the command processing software
to a defined initial state. Does not change the
instrument setting.

&GTL Go to Local Transition to the ,local” state (manual control).
&GTR Go to Remote Transition to the ,,remote” state (remote control).
&LLO Local Lockout Disables switchover from remote control to ma-

nual control by means of the front panel keys.

&NREN Not Remote Enable Enables switchover from remote control to ma-
nual operation by means of the front panel keys

Table 1.1: LAN Interface Messages

Universal Commands
Universal commands are encoded in the range 10 through 1F hex. They affect all instruments
connected to the bus and do not require addressing.

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and
sets the command processing software to a defined initial
state. Does not change the instrument settings.

IFC (Interface Clear) Resets the interfaces to the default setting.

IFC is not a real universal command, it is sent via a separate
line; it also affects all instruments connected to the bus and
does not require addressing

LLO (Local Lockout) The LOC/IEC ADDR key is disabled.
SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfi- End of the parallel-poll state.

gure)

Table 1.2: Universal Commands

SCPI Programmers Manual 9
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Addressed Commands
Addressed commands are encoded in the range 00 through OF hex. They only affect instruments
addressed as listeners.

Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a
sweep). The effect of the command is the same as with
that of a pulse at the external trigger signal input.

GTL (Go to Local) Transition to the ,local” state (manual control).

GTR (Go to Remote) Transition to the ,,remote” state (remote control).
PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received

and sets the command processing software to a defined
initial state. Does not change the instrument setting.

Table 1.3: Addressed Commands

1.4.2 SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more parameters. The
header and the parameters are separated by a ,white space” (ASCIl code 0 to 9, 11 to 32 deci-
mal, e.g. blank). The headers may consist of several mnemonics (keywords). Queries are formed
by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common commands).
Common and device-specific commands differ in their syntax.

Syntax for Common Commands
Common (=device-independent) commands consist of a header preceded by an asterisk (*) and
possibly one or more parameters.

*RST Reset Resets the instrument.

*ESE Event Status Enable Sets the bits of the event status enable registers.
*ESR? Event Status Query Queries the content of the event status register.
*IDN? Identification Query Queries the instrument identification string.

Table 1.4: Examples of Common Commands

SCPI Programmers Manual 10
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Syntax for Device-Specific Commands

For demonstration purposes only, assume the existence of the following commands for this
section:

e ACQuire:POINts:ARATe

CALCulate:QMATh<m>:STATe

CHANnNel<m>:DATA:POINts

BUS<b>:STATe

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by upper case
letters, the long form corresponds to the complete word. Either the short form or the long form
can be entered; other abbreviations are not permitted.

Example: CALCulate:QMATh<m>:STATe ON is equivalent to CALC:QMAT<m>:STAT ON.

Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the
manual, the instrument itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels or sour-
ces, the required instances can be specified by a suffix added to the command.

Numeric suffixes are indicated by angular brackets (<1...2>, <m>) and are replaced by a single
value in the command. Entries without a suffix are interpreted as having the suffix 1.

Example:
Definition: CHANnel<m>:STATe ON
Command: CHAN2:STAT ON

This command activates channel CH2.

Different numbering in remote control

For remote control, the suffix may differ from the number of the corresponding selec-
tion used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix
1 is the default state and used when no specific suffix is specified.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or omitted.
These mnemonics are marked by square brackets. The instrument must recognize the long
command to comply with the SCPI standard. Some commands are shortened by these optional
mnemonics.

Example:
HardCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP

e
SCPI Programmers Manual 11
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Special characters

A vertical stroke in parameter definitions indicates alternative possibilities in the
sense of ,or”. The effectof the command differs, depending on which parameter is
used.

| Example:

HardCOPy:PAGE:ORlentation LANDscape | PORTrait
HCOP:PAGE:ORI LAND specifies landscape orientation.
HCOP:PAGE:ORI PORT specifies portrait orientation.

Mnemonics in square brackets are optional and may be inserted into the header or

omitted.
(] Example:
HardCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP.
{} Parameters in curly brackets are optional.

Table 1.5: Special characters

SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The parameters
must be separated from the header by a , white space” (ASCIl code 0 to 9, 11 to 32 decimal, e.g.
blank). Allowed parameters are:

e Numeric values

e Special numeric values

e Boolean parameters

° Text

e Character strings

e Block data

The parameters required for each command and the allowed range of values are specified in the
command description.

Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent. Values
exceeding the resolution of the instrument are rounded up or down. The mantissa may com-
prise up to 255 characters, the exponent must lie inside the value range -32000 to 32000. The
exponent is introduced by an ,E” or ,e". Entry of the exponent alone is not allowed. In the case
of physical quantities, the unit can be entered. Allowed unit prefixes are G (giga), MA (mega),
MOHM and MHZ are also allowed), K (kilo), M (milli), U (micro) and N (nano). If the unit is mis-
sing, the basic unit is used.

Example: TIMebase:SCALe 10us = TIM:SCAL 1e-5

SCPI Programmers Manual 12
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Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:
* G (giga)

¢ MA (mega), MOHM, MHZ

K (kilo)

M (milli)

e U (micro)

e N (nano)

If the unit is missing, the basic unit is used.

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a query, the nu-
meric value is provided.

e MIN/MAX/DMAX/DEF

e MINimum and MAXimum denote the minimum and maximum value

Example:
CHAN1:DATA:POIN DEF
CHAN1.DATA:POIN?, Response: 6000

Boolean Parameters

Boolean parameters represent two states. The ,ON” state (logically true) is represented by ,,ON”
or a numeric value 1. The ,,OFF” state (logically untrue) is represented by ,,OFF” or the numeric
value 0. The numeric values are provided as the response for a query.

Example:
CHANZ2:STAT ON
CHANZ2:STAT?, Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered using a
short or long form. Like any parameter, they have to be separated from the header by a white
space. In the case of a query, the short form of the text is provided.

Example:
HardCOPy:PAGE:ORlentation LANDscape
HCOP:PAGE:ORI?, Response: LAND

Block data

Block data is a format which is suitable for the transmission of large amounts of data. The ASCII
character # introduces the data block. The next number indicates how many of the following
digits describe the length of the data block. In the example the 4 following digits indicate the
length to be 5168 bytes. The data bytes follow. During the transmission of these data bytes all
end or other control signs are ignored until all bytes are transmitted. #0 specifies a data block of
indefinite length. The use of the indefinite format requires a NLAEND message to terminate the
data block. This format is useful when the length of the transmission is not known or if speed or
other considerations prevent segmentation of the data into blocks of definite length.

SCPI Programmers Manual 13
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Overview of Syntax Elements
The following table provides an overview of the syntax elements:

The colon separates the mnemonics of a command. In a command line the separa-
ting semicolonmarks the uppermost command level.

The semicolon separates two commands of a command line. It does not alter the

path.
, The comma separates several parameters of a command.
? The question mark forms a query.
* The asterisk marks a common command.

Quotation marks introduce a string and terminate it.

The hash symbol introduces binary, octal, hexadecimal and block data.
— Binary: #810110

Octal: #07612

Hexa: #HF3A7

— Block: #21312

+*
|

A ,white space” (ASCII-Code 0t0 9, 11 to 32 decimal, e.g. blank) separates the
header from the parameters.

Table 1.6: Syntax Elements

Structure of a command line

A command line may consist of one or several commands. It is terminated by one of the follow-
ing:

e a <New Line>

e a <New Line> with EOI

e an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ,,;”. If the next com-
mand belongs to a different command system, the semicolon is followed by a colon.

Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is formed
by adding a question mark to the associated setting command. According to SCPI, the re-
sponses to queries are partly subject to stricter rules than in standard IEEE 488.2.

e The requested parameter is transmitted without a header.

Example:
HCOP:PAGE:ORI?, Response: LAND

e Maximum values, minimum values and all other quantities that are requested via a special
text parameter are returned as numeric values.

Example:
CHAN1:DATA:POIN DEF
CHAN1.DATA:POIN?, Response: 6000

SCPI Programmers Manual 14
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e Truth values (Boolean values) are returned as O (for OFF) and 1 (for ON).

Example:
CHANZ2:STAT ON
CHANZ2:STAT?, Response: 1

e Text (character data) is returned in a short form.

Example:
HardCOPy:PAGE:ORlentation LANDscape
HCOP:PAGE:ORI?, Response: LAND

Command Sequence and Synchronization

A sequential command finishes executing before the next command starts executing. Com-
mands that are processed quickly are usually implemented as sequential commands. Setting
commands within one command line, even though they may be implemented as sequential
commands, are not necessarily serviced in the order in which they have been received. In order
to make sure that commands are actually carried out in a certain order, each command must be
sent in a separate command line.

As a general rule, send commands and queries in different program messages.

1.5.1

Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC, *OPC? or *WAI
can be used. All three commands cause a certain action only to be carried out after the hardware

has been set. By suitable programming, the controller can be forced to wait for the correspon-
ding action to occur.

Command

Action

Programming the controller

*OPC

Sets the Operation Complete bit in the
ESR after all previous commands have
been executed.

e Setting bit 0 in the ESE

e Setting bit 5 in the SRE

e Waiting for service request
(SRQ)

*OPC?

Stops command processing until 1 is
returned.This is only the case after the
Opera-tion Complete bit has been set in
the ESR. This bit indicates that the previ-
ous setting has been completed.

Sending *OPC? directly after

the commandwhose processing
should be terminated beforeother
commands can be executed.

*WAI

Stops further command processing until
allcommands sent before *WAI have been
executed.

Sending *WAI directly after the
commandwhose processing
should be terminated beforeother
commands are executed

Table 1.7: Synchronization using *OPC, *OPC? and *WAI

SCPI Programmers Manual
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Command synchronization using *WAI or *OPC? appended to an overlapped command is a
good choice if the overlapped command takes time to process. The two synchronization tech-
niques simply block overlapped execution of the command. For time consuming overlapped
commands it is usually desirable to allow the controller or the instrument to do other useful work
while waiting for command execution. Use one of the following methods

*OPC with a service request

Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

e Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.
Send the overlapped command with *OPC

e \Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

e Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.

e Send the overlapped command with *OPC?

e \Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

e Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

e Send the overlapped command without *OPC, *OPC? or *WAI

e Poll the operation complete state periodically (by means of a timer) using the sequence:
*OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

*OPC? with short timeout

e Send the overlapped command without *OPC, *OPC? or *WAI

e Poll the operation complete state periodically (by means of a timer) using the sequence: «short
timeout; *OPC?

e A return value (LSB) of 1 indicates that the overlapped command has finished. In case of a
timeout, the operation is ongoing.

e Reset timeout to former value

e Clear the error queue with SYStem:ERRor? to remove the ,-410, Query interrupted” entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application sup-
ports threads, separate threads can be used for the application GUI and for controlling the
instrument(s) via SCPI. A thread waiting for a *OPC? thus will not block the GUI or the communi-
cation with other instruments.

1.6 Status Reporting System
The status reporting system stores all information on the current operating state of the instru-

ment, and on errors which have occurred. This information is stored in the status registers and in
the error queue. Both can be queried via LAN interface (STATus... commands).

SCPI Programmers Manual 16



SCPI Commands R&S®HMO1002/1202 series Remote Control

1.6.1

Basics

Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and has diffe-
rent functions. The individual bits are independent of each other, i.e. each hardware status is
assigned a bit number which is valid for all five parts. Bit 15 (the most significant bit) is set to
zero for all parts. Thus the contents of the register parts can be processed by the controller as
positive integers.

15|14 (13 (12 COMDition part 1 & =logical AND
L * * ¢ ¢ éb= logical OR
1614|1312 PTRansition part 1

15]14 12 MWTRansition part

15]14 EVEMt part

i
i

Fig. 1.4: The status-register model

to higher-order register
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b e pooalf— P lef—] P3| b0 feff—] P2
D O ] o = | =

e oo o ] | o ]
-t = =

EMABle part

Description of the five status register parts
The five parts of a SCPI register have different properties and functions:

CONDition

e The CONDition partis written into directly by the hardware or the sum bit of the next lower
register. Its contents reflect the current instrument status. This register part can only be read,
but not written into or cleared. Its contents are not affected by reading.

PTRansition

e The two transition register parts define which state transition of the CONDition part (none, 0
to 1, 1 to 0 or both) is stored in the EVENTt part. The Positive-TRansition part acts as a transi-
tion filter. When a bit of the CONDition part is changed from 0 to 1, the associated PTR bit
decides whether the EVENTt bit is set to 1.

PTR bit =1: the EVENt bit is set.
PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by reading.
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NTRansition
e The Negative-TRansition part also acts as a transition filter. When a bit of the CONDition part is
changed from 1 to 0, the associated NTR bit decides whether the EVENTt bit is set to 1.

NTR bit =1: the EVENTt bit is set.
NTR bit =0: the EVENt bit is not set.

This part can be written and read as required. Its contents are not affected by reading.

EVENt

e The EVENTt part indicates whether an event has occurred since the last reading, it is the
.memory” of the condition part. It only indicates events passed on by the transition filters. It
is permanently updated by the instrument. This part can only be read by the user. Reading the
register clears it. This part is often equated with the entire register.

ENABIe

e The ENABIe part determines whether the associated EVENt bit contributes to the sum bit
(see below). Each bit of the EVENTt part is ,,ANDed” with the associated ENABIe bit (symbol
,&"). The results of all logical operations of this part are passed on to the sum bit via an ,,OR”
function (symbol ,+").

ENABIe bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABIe bit = 1: if the associated EVENt bit is ,, 1", the sum bit is set to ,, 1" as well.

This part can be written and read by the user as required. Its contents are not affected by rea-
ding.

Sum bit
e The sum bit is obtained from the EVENt and ENABIe part for each register. The result is then
entered into a bit of the CONDition part of the higher-order register.

Hierarchy of status registers

STB, SRE

e The STatus Byte (STB) register and its associated mask register Service Request Enable (SRE)
form the highest level of the status reporting system. The STB provides a rough overview of
the instrument status, collecting the information of the lower-level registers.

ESR, SCPI registers

e The STB receives its information from the following registers:

e The Event Status Register (ESR) with the associated mask register standard Event Status
Enable (ESE).

e The STATus:OPERation and STATus:QUEStionable registers which are defined by SCPI and
contain detailed information on the instrument.

Output buffer

® The output buffer contains the messages the instrument returns to the controller. It is not part
of the status reporting system but determines the value of the MAV bit in the STB and thus is
represented in the overview.
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All status registers have the same internal structure.
As shown in the following figure, the status information is of hierarchical structure.

0
1
Errorfevent  Qutput 2
queue buffer 3 |cOVerload
4 | TEMPerature
5
6
- _ T
0 8 | NOALigndata
1 9 [ LIMit
-&- 2 10
=B 3 11
e —————— 4 - MAY 12 | MASK
8- 5—ESB —— 13 R
& —g ROS/MSS 1; figure for this
L™ L] register
SRE 5TB —E STATus:QUEStionable
[a5] STATus:0OPERation
‘SFI{Q 0 | ALIGnment
1 | SELFtest
2 | AUToset
3 | WTRigger
4
5
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1 [-&= (1 8
2|-& |2 10
3|-& (3 11
4 [-&-4 12
5|-& 15 13
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1 -&- 1 E & = |ogical AND
ESE ESR b= logical OR

Fig. 1.5: Overview of the status registers hierarchy

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the STB is
structured according to SCPI. By analogy, the ESE can be used as the ENABle part of the ESR.

1.6.3 Contents of the Status Registers
In the following sections, the contents of the status registers are described in more detail.

Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough overview of the in-
strument status by collecting the pieces of information of the lower registers. A special feature is
that bit 6 acts as the sum bit of the remaining bits of the status byte.
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The STB can thus be compared with the CONDition part of an SCPI register and assumes the
highest level within the SCPI hierarchy. The STB is read using the command *STB or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register. Each bit of the STB
is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set in the SRE and the associa-
ted bit in the STB changes from 0 to 1, a service request (SRQ) is generated. The SRE can be set
using the command *SRE and read using the command *SRE?.

Bit No. | Meaning
0...1 Not used

Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the
2 SRE, each entry of the error queue generates a service request. Thus an error can
be recognized and specified in greater detail by polling the error queue. The poll
provides an informative error message. This procedure is to be recommended since
it considerably reduces the problems involved with remote control.

QUEStionable status sum bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the

3 associated ENABle bit is set to 1. A set bit indicates a questionable instrument
status, which can be specified in greater detail by polling the QUEStionable status
register.

MAV bit (message available)

4 The bit is set if a message is available in the output buffer which can be read. This
bit can be used to enable data to be automatically read from the instrument to the
controller.

ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status

5 register is set and enabled in the event status enable register. Setting of this bit
indicates a serious error which can be specified in greater detail by polling the event
status register.

MSS bit (master status summary bit)

6 The bit is set if the instrument triggers a service request. This is the case if one of
the other bits of this registers is set together with its mask bit in the service request
enable register SRE.

OPERation status register sum bit

The bit is set if an EVENt bit is set in the OPERation status register and the associ-

7 ated ENABle bit is set to 1. A set bit indicates that the instrument is just performing
an action. The type of action can be determined by polling the OPERation status
register.

Table 1.8: Meaning of the bits used in the status byte

Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI register. The
event status register can be read out using command *ESR?. The ESE corresponds to the ENA-
Ble part of a SCPI register. If a bit is set in the ESE and the associated bit in the ESR changes
from 0 to 1, the ESB bit in the STB is set. The ESE register can be set using the command *ESE
and read using the command *ESE?.
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Bit No. | Meaning
Operation Complete

0 This bit is set on receipt of the command *OPC exactly when all previous com-
mands have been executed.

1 Not used

Query Error

This bit is set if either the controller wants to read data from the instrument without
2 having sent a query, or if it does not fetch requested data and sends new instruc-
tions to the instrument instead. The cause is often a query which is faulty and hence
cannot be executed.

Device-dependent Error

3 This bit is set if a device-dependent error occurs. An error message with a number
between -300 and -399 or a positive error number, which denotes the error in grea-
ter detail, is entered into the error queue.

Execution Error

4 This bit is set if a received command is syntactically correct but cannot be perfor-
med for other reasons. An error message with a number between -200 and -300,
which denotes the error in greater detail, is entered into the error queue.
Command Error

5 This bit is set if a command is received, which is undefined or syntactically incor-
rect. An error message with a number between -100 and -200, which denotes the
error in greater detail, is entered into the error queue.

User Request

This bit is set when the instrument is switched over to manual control.

Power On (supply voltage on)

6

7

This bit is set on switching on the instrument.

Table 1.9: Meaning of the bits used in the event status register

STATus:OPERation Register

In the CONDition part, this register contains information on which actions the instru-

ment is being executing. In the EVENTt part, it contains information on which actions

the instrument has executed since the last reading. It can be read using the commands
STATus:OPERation:CONDition? or STATus:OPERation[:EVENt]?. The remote commands for the
STATus:OPERation register are described in chapter 2.14.1, ,STATus:OPERation Register”, on

page 138.
Bit No. Meaning
0 ALIGnment
This bit is set as long as the instrument is performing a self alignment.
1 SELFtest
This bit is set while the selftest is running.
2 AUToset
This bit is set while the instrument is performing an auto setup.
3 WTRIgger
This bit is set while the instrument is waiting for the trigger.
4 to 14 | Not used
15 This bit is always 0.

Table 1.10: Bits in the STATus:0PERation register

e
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STATus:QUEStionable Register

This register contains information about indefinite states which may occur if the unit is operated
without meeting the specifications. It can be read using the commands
STATus:QUEStionable:CONDition and STATus:QUEStionable[:EVENT].

CHAMNR&l1
CHAMNREZ

TEMP WARM
TEMP ERRor

STATus:QUESt onable

e =R I = R ]
M Bl 2o 0@~ @O & WK =D

0
1
2 L] - - R
3 |COverloas — S TAT-QUES:COV & STAT:QUES:TEMP
4 | TEMPerature
5
6
7
8 | NOALigndata
9 |LiMi
1? j ésmr:qum:uu
STAT:QUES:MASK
13 MASK 0 | MASK1 0 | MEASY
14 ! 1 | MEASZ
15 2 2
3 3
4 4
3 5
& &
7 7
8 8
g 9
10 10
11 11
12 12
14 14
15 1=

Fig. 1.6: Overview of the STATus:QUEStionable register
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Bit No. Meaning
0to 2 Not used
COVerload
3 This bit is set if a questionable channel overload occurs (see
. STATus:QUEStionable:COVerload regis-ter”, on page 24).
TEMPerature
4 This bit is set if a questionable temperature occurs (see ,STATus:QUEStionable:TE
MPerature register”, on page 24).
5to 7 Not used
8 NOALigndata
This bit is set if no alignment data is available - the instrument is uncalibrated.
LIMit
9 This bit is set if a limit value is violated (see ,, STATus:QUEStionable:LIMit
register”,on page 25).
10 to 11 | Not used
MASK
12 This bit is set if a mask value is violated (see , STATus:QUEStionable:MASK
register”,on page 25).
13 to 14 | Not used
15 This bit is always O.

Table 1.11: Bits in the STATus:QUEStionable register

STATus:QUEStionable:COVerload register
This register contains all information about overload of the channels. The bit is set if the assigned
channel is overloaded.

Bit No. Meaning
0 CHANnRel1
1 CHANnRel2

Table 1.12: Bits in the STATus:QUEStionable:COVerload register

STATus:QUEStionable:TEMPerature register
This register contains information about the instrument’s temperature.

Bit No. Meaning
0 TEMP WARN
This bit is set if a temperature warning on channel 1, 2, 3 or 4 occured.
1 TEMP ERRor
This bit is set if a temperature error on channel 1, 2, 3 or 4 occured.

Table 1.13: Bits in the STATus:QUEStionable:TEMPerature register

e
SCPI Programmers Manual

23




SCPI Commands R&S®HMO1002/1202 series Remote Control

1.6.4

Basics

STATus:QUEStionable:LIMit register

This register contains information about the observance of the limits of measurements.This bit
is set if the limits of the main or additional measurement of the assigned measurement are
violated.

Bit No. Meaning
0 MEAS1
1 MEAS2

Table 1.14: Bits in the STATus:QUEStionable:LIMit register

STATus:QUEStionable:MASK register
This register contains information about the violation of masks. This bit is set if the assigned
mask is violated.

Bit No. Meaning
0 MASK1

Table 1.15: Bits in the STATus:QUEStionable:MASK register

Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several devices in
a measuring system. To do this and react appropriately, the controller must receive and evaluate
the information of all devices. The following standard methods are used:

e Service request (SRQ) initiated by the instrument

e Serial poll of all devices in the bus system, initiated by the controller in order to find out who
sent a SRQ and why

e Parallel poll of all devices

e Query of a specific instrument status by means of commands

e Query of the error queue

Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the controller.
Usually this service request initiates an interrupt at the controller, to which the control program
can react appropriately. As evident from figure 1.5, an SRQ is always initiated if one or several of
bits 2, 3, 4, b or 7 of the status byte are set and enabled in the SRE. Each of these bits combines
the information of a further register, the error queue or the output buffer. The ENABIe parts of
the status registers can be set such that arbitrary bits in an arbitrary status register initiate an
SRAQ. In order to make use of the possibilities of the service request effectively, all bits should be
setto ,1” in enable registers SRE and ESE.

The SRQ is the only possibility for the instrument to become active on its own. Each controller
program should cause the instrument to initiate a service request if errors occur. The program
should react appropriately to the service request.
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Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried. However,
the query is realized via interface messages and is thus clearly faster. The serial poll method is
defined in IEEE 488.1 and used to be the only standard possibility for different instruments to
poll the status byte. The method also works for instruments which do not adhere to SCPI or IEEE
488.2. The serial poll is mainly used to obtain a fast overview of the state of several instruments
connected to the controller.

Query of an instrument status
Each part of any status register can be read using queries. There are two types of commands:

e The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level registers.
e The commands of the STATus system query the SCPI registers (STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the queried re-
gister. This number is evaluated by the controller program. Queries are usually used after an SRQ
in order to obtain more detailed information on the cause of the SRQ.

Decimal representation of a bit pattern

The STB and ESR registers contain 8 bits, the SCPI registers 16 bits. The contents of a status
register are specified and transferred as a single decimal number. To make this possible, each bit
is assigned a weighted value. The decimal number is calculated as the sum of the weighted
values of all bits in the register that are set to 1.

Bits 0 |1 |2 3 4 5 6 7

Weight

1 2 4 8 16 32 &4 128

Fig. 1.7: Decimal representation of a bit patter

Example:
The decimal value 40 = 32 + 8 indicates that bits no. 3 and 5 in the status register (e.g. the QUE-
Stionable status summary bit and the ESB bit in the STatus Byte ) are set.

Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of the error
queue are detailed plain text error messages that can be looked up in the Error Log or queried
via remote control using SYSTem:ERRor [ :NEXT] ? or SYSTem:ERRor : ALL?. Each call of
SYSTem:ERRor [ :NEXT] 2 provides one entry from the error queue. If no error messages are
stored there any more, the instrument responds with 0, ,,No error”.

The error queue should be queried after every SRQ in the controller program as the entries de-
scribe the cause of an error more precisely than the status registers. Especially in the test phase
of a controller program the error queue should be queried regularly since faulty commands from
the controller to the instrument are recorded there as well.
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Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status reporting
system to be reset. None of the commands, except *RST and SYSTem: PRESet, influence the
functional instrument settings. In particular, DCL does not change the instrument settings.

Event Switching on DCL, SDC | *RST STA- | *CLS
supply-voltage | (DeviceCl | orSYS- Tus:
Power-On-Sta- | ear,Select | Tem:PRE- | PRE-
tus-Clear edDevice- | Set Set
Clear)
Effect 0 1
Clear STB, ESR - yes - - - yes
Clear SRE, ESE - yes - - - -
Clear EVENt parts of the re- yes
. - yes - - -
gisters

Clear ENABIle parts of all
OPERation and QUEStionable

registers; Fill ENABIle parts of ) yes ) i ves |-
all other registers with ,,1".
Fill PTRansition parts with } s ) ) os |-
»1"; Clear NTRansition parts Y ¥
Clear error queue yes yes - - - yes
Clear output buffer yes yes yes 1) 1) 1)
Clear command processing

yes yes yes - - -

and input buffer

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE
TERMINATOR> clears the output buffer.

Table 1.16: Resest of the status reporting system

General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In contrast, the
priority of remote control is the , predictability” of the instrument status. Thus, when a command
attempts to define incompatible settings, the command is ignored and the instrument status
remains unchanged, i.e. other settings are not automatically adapted. Therefore, control pro-
grams should always define an initial instrument status (e.g. using the *RST command) and then
implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Otherwise, the
result of the query may vary depending on which operation is performed first (see also Pre-
venting Overlapping Execution).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its own. Each
controller program should instruct the instrument to initiate a service request in case of malfunc-
tion. The program should react appropriately to the service request.

e
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Error queues

The error queue should be queried after every service request in the controller program as the
entries describe the cause of an error more precisely than the status registers. Especially in the
test phase of a controller program the error queue should be queried regularly since faulty com-
mands from the controller to the instrument are recorded there as well.
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2 Command Reference

This chapter provides the description of all remote commands available for the R&S®°HMO 1002
resp. R&S®HMO1202 series. The commands are sorted according to the menu structure of the
instrument. A list of commands in alphabetical order ist given in the , List of Commands” at the
end of this documentation.

21 Common Commands
Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These commands
have the same effect and are employed in the same way on different devices.The headers of
these commands consist of ,*” followed by three letters. Many common commands are related

to the Status Reporting System.

Available common commands:

B A L Y e 28
LS o e 28
FESE ValUB> e 29
o =] o USRI 29
B DN 2 e e 29
S0 = ORI 29
faLO ] I U P 29
P S C A CTION > ittt e e e e e e 30
R ST e e 30
S R =R 61e] 0] (T ol £SO PSRRI 30
T B e e 30
Sl 1 2 (PSRRI 30
Sl S 1L 2SRRI 31
B4 N U ORI 31
*CAL?

Calibration Query

Initiates a calibration of the instrument and subsequently queries the calibration status. Re-
sponses > 0 indicate errors.

*CLS

Clear Status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of the QUEStio-
nable and the OPERation registers to zero. The command does not alter the mask and transition

parts of the registers. It clears the output buffer.

Usage: Setting only
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*ESE <Value>
Event Status Enable

Sets the event status enable register to the specified value. The query returns the contents of the
event status enable register in decimal form.

Parameters:
<Value> Range: 0to 255

*ESR?

Event Status Read

Returns the contents of the event status register in decimal form and subsequently sets the
register to zero.

Return values:

<Contents> Range: 0 to 2565
Usage: Query only
*IDN?

|DeNtification: returns the instrument identification.

Return values:
<ID> Rohde&Schwarz,<device type>,<serial number>,<firmwareversion>

Example: Rohde&Schwarz, HM01002,020720087,05.450
Usage: Query only
*OPC

OPeration Complete

Sets bit 0 in the event status register when all preceding commands have been executed. This bit
can be used to initiate a service request. The query form writes a ,,1” into the output buffer as soon
as all preceding commands have been executed. This is used for command synchronization.

*OPT?
OPTion identification query

Queries the options included in the instrument. For a list of all available options and their descrip-
tion refer to the CD-ROM.

Return values:

<Options> The query returns a list of options. The options are returned at fixed
positions in a comma-separated string. A zero is returned for options
that are not installed.

Usage: Query only
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*PSC <Action>
Power on Status Clear

Determines whether the contents of the ENABIe registers are preserved or reset when the
instrument is switched on. Thus a service request can be triggered when the instrument is
switched on, if the status registers ESE and SRE are suitably configured. The query reads out the
contents of the ,, power-on-status-clear” flag.

Parameters:

<Action> 0]1
0: The contents of the status registers are preserved.
1: Resets the status registers.

*RST

ReSeT

Sets the instrument to a defined default status. The default settings are indicated in the descripti-
on of commands.

Usage: Setting only
*SRE <Contents>
Service Request Enable

Sets the service request enable register to the indicated value. This command determines under
which conditions a service request is triggered.

Parameters:

<Contents> Contents of the service request enable register in decimal form.
Bit 6 (MSS mask bit) is always 0.
Range: 0 to 255

*STB?

STatus Byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

TRiGger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual trigger
signal (Manual Trigger). This common command complements the commands of the TRIGger
subsystem.

Usage: Event
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*TST?
self TeST query

Triggers selftests of the instrument and returns an error code in decimal form (see Service Manu-
al supplied with the instrument). ,,0” indicates no errors occured.

Usage: Query only

*WAI
WAIt to continue

Prevents servicing of the subsequent commands until all preceding commands have been exe-
cuted and all signals have settled (see also command synchronization and *OPC).

Usage: Event

2.2 Acquisition and Setup

2.2.1 Starting and StoppiNg ACQUISITION  ..uuiiuuiiiiiie e 31
2.2.2 TIME BASE i e 32
2. 2.3 ACUISITION ittt e e e et e e e et e e e e e e e e e e e e 34
2. 2.4 VBIHICAl oo e 40
2.2.5 LOGIC ChANNEI ittt ettt e e e e e a e 45
2.2.6 WaVefOrmM DAt ..o 51
2.2.7 Waveform Data EXPort 10 Fil8  ...oviiiiiiiiiiie e 58
2. 8 PrODES oo 59

2.2.1 Starting and Stopping Acquisition

RUN e 31
RUNCONTINOUS oo 31
SIN G e 32
RUN S NG et 32
ST P e 32
RUN

Starts the continuous acquisition.

Usage: Event
Asynchronous command

RUNContinous
Same as RUN.

Usage: Event
Asynchronous command
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SINGle
Starts a defined number of acquisition cycles.

Usage: Event
Asynchronous command

RUNSingle
Same as SINGle.

Usage: Event
Asynchronous command

STOP
Stops the running acquistion.

Usage: Event
Asynchronous command

2.2.2 Time Base

TIMebase:SCALE <TiMESCAlE> ..o e 32
TIMEDASEIRATIME? oo 32
TIMebase:ACQTime <ACQUISITIONTIMES  ...oiiiiiie e 33
TIMebase:RANGE <ACQUISIIONTIMES  ..vvviiiiiie e 33
TIMEDASEIDIVISIONS? oottt e et e e e et e e e e e s e e e e e e 33
TIMebase:POSItIoN <OffSEI>  oiiiiiii e 33
TIMebase:REFerence <ReferencePoint> ... 33

TIMebase:SCALe <TimeScale>
Sets the horizontal scale for all channel and math waveforms.

Parameters:

<TimeScale> Range: 1E-9 to 50
Default unit: s/div
*RST: 100E-6

TIMebase:RATime?

Queries the real acquisition time used in the hardware. If FFT analysis is performed, the
value can differ from the adjusted acquisition time (TIMebase:ACQTime).

Return values:
<HWAcqTime> Default unit: s

Usage: Query only
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TIMebase:ACQTime <AcquisitionTime>
Defines the time of one acquisition, that is the time across the 12 divisions of the diagram:
Timebase Scale*12.

Parameters:
<AcquisitionTime> Range: 12ns to 600s
Default unit: s

TIMebase:RANGe <AcquisitionTime>
Defines the time of one acquisition, that is the time across the 12 divisions of the diagram:
Timebase Scale*12.

Parameters:
<AcquisitionTime> Range: 12ns to 600s
Default unit: s

TIMebase:DIVisions?
Queries the number of horizontal divisions on the screen.

Return values:
<HorizDivCount> Range: 12

Usage: Query only

TIMebase:POSition <Offset>
Defines the trigger position (trigger offset) - the time interval between trigger point and reference
point to analize the signal some time before or after the trigger event.

See also: TIMebase:REFerence

Parameters:
<Offset> Range: -500 to 500
Default unit: s

*RST: 0

TIMebase:REFerence <ReferencePoint>

Sets the reference point of the time scale (Time Reference) in % of the display. The reference
point defines which part of the waveform is shown. If the trigger position is zero, the trigger
point matches the reference point. See also: TIMebase:POSition

Parameters:

<ReferencePoint> Range: 10 to 90
Default unit: %
*RST: 50
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2.2.3 Acquisition

AUTOSCAIE oot 34
ACQuIire:MODE <ACqUISIIONMOUE™  ...uiiiiiiiiii e 34
ACQuire:INTerpolate <Interpolation> ... 35
ACQuire:AVERage:COUNt <AverageCouUNT> ..o 35
ACQUIre:AVERAGE:COMPIEIE? ..ttt ettt e e neeeeen 35
ACQuire:WRATe <WaveformBRates ..ot 35
ACQUITE I POINTS IV ALUECT? e e 36
CHANRNel<m>:TYPE <DecimationMOde> ..ottt 36
CHANRel<m>:ARIThmetics <TrAMAMETIC>  ....uiiiiiiiiiiiiiiiiiiiiiiiiiiiii e 37
TIMebase:ROLL:ENABIe <ROII> oo 37
ACQuire:FILTer:FREQency <FilterFrequenCy> ... 37
ACQUITEIPOINTSIARATE? oot 38
A C QUITE I S R AT 7 ittt ettt e e ettt e et e oottt e et e et e e ettt e e et e e et e e e e ean 38
ACQuIire:STATE <AQUISITION STATE>  oiiiiiiiii i 38
ACQUIre:TYPE <AQUISITION TYPE>  oiuiiiiiiiiiiiiiie et 38
ACQuire:PEAKdetect <PeakDetect> ......oiiiiiiiiiiii e 39
ACQuire:HRESoIUtion <HIGNRES> i 39
AUToscale

Performs an autoset process: analyzes the enabled channel signals, and obtains appropriate
horizontal, vertical, and trigger settings to display stable waveforms.

Usage: Event
Asynchronous command

ACQuire:MODE <AcquisitionMode>
Selects the method of adding waveform points to the samples of the ADC in order to fill the
record length.

Parameters:
<AcquisitionMode> RTIMe | ETIMe

RTIMe (Real Time Mode)

At slow time base settings the sampled points of the input signal are
used to build the waveform, no waveform points are added. With fast
time base settings, the sample rate is higher than the ADC sample rate.
Waveform samples are added to the ADC samples with sin(x)/x inter-
polation.

ETIMe (Equivalent time)
The waveform points are taken from several acquisitions of a repetive

signal at a different time in relation to the trigger point.

*RST: RTIM
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ACQuire:INTerpolate <Interpolation>
Defines the interpolation mode.

Parameters:
<Interpolation> LINear | SINX | SMHD

LINear: Linear interpolation between two adjacent sample points.
SINX: Interpolation by means of a sin(x)/x curve.
SMHD: Sample & Hold causes a histogram-like interpolation.

*RST: SINX

ACQuire:AVERage:COUNt <AverageCount>
Defines the number of waveforms used to calculate the average waveform. The higher the
number, the better the noise is reduced.

Parameters:
<AverageCount> Only numbers from the 2nd progression are permitted.
Range: 2 to 1024

*RST: 2

ACQuire:AVERage:COMPlete?
Returns the state of averaging.

Return values:
<AverageComplete> 0] 1

0: The number of acquired waveforms is less than the number
required for average calculation.
See ACQuire:AVERage:COUNT.

1 The instrument acquired a sufficient number of waveforms to
determine the average.

Usage: Query only

ACQuire:WRATe <WaveformRate>
Defines the mode to set the sample rate (samples per second saved in the memory) and the
waveform acquisition rate (waveforms per second).

Parameters:
<WaveformRate> AUTO | MWAVeform | MSAMples

AUTO

To display the best waveform, the instrument selects the optimum
combination of waveform acquisition rate and sample rate using the full
memory depth.
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MWAVeform

Maximum waveform rate: The instrument combines sample rate and
memory depth to acquire at maximum waveform acquisition rate. In
combination with persistence fuction, the mode can display rare signal
anomalies.

MSAMples

Maximum sample rate: The instrument acquires the signal at maximum
sample rate and uses the full memory depth. The result is a waveform
with maximum number of waveform samples, high degree of accuracy,
and low risk of aliasing.

*RST: AUTO
ACQuire:POINts[:VALue]?
The query returns the record length, the number of recorded waveform points.

Return values:
<RecordLength> Record length in Sa

*RST: 960000
Usage: Query only
CHANnNel<m>:TYPE <DecimationMode>

Selects the method to reduce the data stream of the ADC to a stream of waveform points with
lower sample rate.

Suffix:

<m> The command affects all channels regardless of the indicated channel
number. The suffix can be omitted.

Parameters:

<DecimationMode> SAMPIe | PDETect | HRESolution

SAMPle
Input data is acquired with a sample rate which is aligned to the time
base (horizontal scale) and the record length.

PDETect (Peak Detect)
The minimum and the maximum of n samples in a sample interval are
recorded as waveform points.

HRESolution (High Resolution)
The average of n sample points is recorded as waveform point.

*RST: SAMPle
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CHANnel<m>:ARIThmetics <TrArithmetic>
Selects the method to build the resulting waveform from several consecutive acquisitions of the

signal.

Suffix:

<m> The command affects all channels regardless of the indicated channel
number. The suffix can be omitted.

Parameters:

<TrArithmetic> OFF | ENVelope | AVERage | FlLTer

OFF
The data of the current acquisition is recorded according to the decima-
tion settings.

ENVelope
Detects the minimum and maximum values in an sample interval over a
number of acquisitions.

AVERage

Calculates the average from the data of the current acquisition and a
number of acquisitions before. The number of used acquisitions is set
with ACQuire:AVERage:COUNT.

FiLTer

Sets a low-pass filter with 3 db attenuation at a configurable limit
frequency set with ACQuire:FILTer:FREQency. The filter removes higher
frequencies from the channel signals.

*RST: OFF
TIMebase:ROLL:ENABIe <Roll>
Enables the roll mode.

Parameters:
<Roll> ON | OFF

*RST: OFF
ACQuire:FILTer:FREQency <FilterFrequency>
Sets the limit frequency if CHANnel<m>:ARIThmetics is set to , FILTer".
Parameters:

<FilterFrequency> Limit frequency with 3dB attenuation
Default unit: Hz
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ACQuire:POINts:ARATe?
Retrieves the sample rate of the ADC, that is the number of points that are sampled by the ADC
in one second.

Return values:
<AcquisitionRate> ADC sample rate in Hz

Usage: Query only

ACQuire:SRATe?
Returns the sample rate, that is the number of recorded waveform samples per second.

Return values:
<SampleRate> Waveform samples per second (Sa/s)

Usage: Query only

ACQuire:STATe <Aquisition State>
Sets the aquisition state of the instrument.

Parameters:
<Aquisition State> RUN | STOP | COMPlete | BREak

RUN
The aquisition is running.

STOP
The acquisition will stop if finished.

COMPIlete
The current aquisition is finished and completed.

BREak
Set = break/interrupt of current acquisition
Read = acquisition is finished but interrupted

*RST: RUN
ACQuire:TYPE <Aquisition Type>
Sets the type of the aquisition mode.

Parameters:
<Aquisition Type> REFresh | ROLL | AVERage | ENVelope | FILTer

REFresh
The aquisitions are displayed as they are done.
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ROLL
The aquisitions are done in roll mode.

AVERage
The aquisitions are averaged.

FilLTer
Sets a low-pass filter with 3 db attenuation at a configurable limit
frequency

*RST: OFF

ACQuire:PEAKdetect <PeakDetect>
Enables the peak detection.

Parameters:
<PeakDetect> AUTO | OFF

*RST: OFF

ACQuire:HRESolution <HighRes>
Enables the high resolution mode.

Parameters:
<HighRes> AUTO | OFF

*RST: OFF



Command Reference

2.2.4 \Vertical

CHANRNEISM>ISTATE <STATE> oottt 40
CHANRNel<m>:COUPIING <COUPIING> oot 40
CHANRNEI<M>:SCALE <SCAIE> oo 41
CHANNEl<M>RANGE <RANGE>  .ooiiiiiiii e 41
CHANRNEl<mM>:POSIION <POSITION>  1.iiiiiiiiii e 41
CHANRNEl<mM>:0FFSet <OffSET>  oiiiiiiiiiii e 41
CHANnNel<m>:BANDwidth <BandwidthLimit> .. ..ccciciiiiiiiiii e 42
CHANRNel<mM>:POLarity <POIArity> ...t 42
CHANRNel<m>:0OVERIoad <OVErIoad> ...ccuuiiiiiiiiiie e 42
CHANRNEI<M>SKEW <SKEW> ..o 43
CHANnNel<m>:THReshold <Threshold> ... 43
CHANnel<m>:THReshold:FINDlevel

CHANnNel<m>:THReshold:HYSTeresis <ThresholdHysteresis> ........cccccviveiiiiiiiiiiieeieeeiiiee, 43
CHANRNEl<mM>:LABEl <Label> i 44
CHANRNEl<mM>:LABELSTATE <STAte> oottt 44

CHANnel<m>:STATe <State>
Switches the channel signal on or off.

Suffix:

<m> Selects the input channel (1, 2).
Parameters:

<State> ON | OFF

CHANnel<m>:COUPIling <Coupling>
Selects the connection of the indicated channel signal.

Suffix:

<m> Selects the input channel (1, 2).

Parameters:

<Coupling> DCLimit | ACLimit | GND
DCLimit: DC coupling
ACLimit: AC coupling
GND: Ground
*RST: DCL
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CHANnNel<m>:SCALe <Scale>
Sets the vertical scale for the indicated channel.

Suffix:

<m> Selects the input channel (1, 2).
Parameters:

<Scale> Scale value in Volts per div.

Range: 1e-3to 10
*RST: 5E-3
CHANnel<m>:RANGe <Range>

Sets the voltage range across the 8 vertical divisions of the diagram. Use the command alterna-
tivly instead of CHANnel<m>:SCALe.

Suffix:

<m> Selects the input channel (1, 2).
Parameters:

<Range> Range: 8e-3 to 80

*RST: 4E-2

CHANnel<m>:POSition <Position>
Sets the vertical position of the indicated channel and its horizontal axis in the window.

Suffix:
<m> Selects the input channel (1, 2).
Parameters:
<Position> Position value, given in divisions.
Range: -5tob (R&S®HMO1002 series)
-15t0 15 (R&S®HMO1202 series)

*RST: 0.00E+00

CHANnNel<m>:0FFSet <Offset>
The offset voltage is subtracted to correct an offset-affected signal.

Suffix:

<m> Selects the input channel (1, 2).
Parameters:

<Offset> Offset value in V

Range: Values depend on vertical scale and probe attenuation

*RST: 0.00E+00
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CHANnel<m>:BANDwidth <BandwidthLimit>
Selects the bandwidth limit for the indicated channel.

Suffix:
<m> Selects the input channel (1, 2).

Parameters:
<BandwidthLimit> FULL | B20

FULL: Full bandwidth.
B20: Bandwidth limit 20 MHz

*RST: FULL

CHANnNel<m>:POLarity <Polarity>

Turns the inversion of the signal amplitude on or off. To invert means to reflect the voltage values
of all signal components against the ground level. Inversion affects only the display of the signal
but not the trigger.

Suffix:

<m> Selects the input channel (1, 2).
Parameters:

<Polarity> NORMal | INVerted

*RST: NORM

CHANnel<m>:0VERIload <Overload>
Retrieves the overload status of the specified channel from the status bit. When the overload
problem is solved, the command resets the status bit.

Suffix:
<m> Selects the input channel (1, 2).
Parameters:
<Overload> ON | OFF
Use OFF to reset the overload status bit.
*RST: OFF
Example: CHANnel2:0OVERIoad?

Queries the overload status of channel 2.

CHANnRel2:0VERIload OFF
Resets the overload status bit.
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CHANnel<m>:SKEW <Skew>
Skew or deskew compensates delay differences between channels caused by the different
length of cables, probes, and other sources. Correct deskew values are important for accurate

triggering.

Suffix:

<m> Selects the input channel (1, 2).
Parameters:

<Skew> Deskew value in s.

CHANnel<m>:THReshold <Threshold>

Threshold value for digitization of analog signals. If the signal value is higher than the threshold,
the signal state is high (1 or true for the boolean logic). Otherwise, the signal state is considered
low (0 or false) if the signal value is below the threshold.

Suffix:
<m> Selects the input channel (1, 2).
Parameters:
<Threshold> Default values are:
TTL 1,4V
ECL -1,3V
CMOS 25V

*RST: 5.00E-01

CHANnel<m>:THReshold:FINDIlevel
Sets the appropriate threshold level automatically.

Suffix:
<m> Selects the input channel (1, 2).
Usage: Setting only

CHANnel<m>:THReshold:HYSTeresis <ThresholdHysteresis>
Defines the size of the hysteresis to avoid the change of signal states due to noise.

Suffix:
<m> Selects the input channel (1, 2).

Parameters:
<ThresholdHysteresis> SMALI | MEDium | LARGe

*RST: SMAL
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CHANnNel<m>:LABel <Label>
Set the label for the input channel.

Suffix:

<m> Selects the input channel (1, 2).

Parameters:

<label> String value “xxxxxxxx” with maximum 8 ASCII characters.

CHANnNel<m>:LABel:STATe <State>
Switches the label of the channel on or off

Suffix:

<m> Selects the input channel (1, 2).
Parameters:

<State> ON | OFF

*RST: OFF



Command Reference

2.2.5 Logic Channel

LOGIic<I>:POSIHION <POSITION ..ot 45
LOGICKISISIZE <SIZE> oo e 45
LOGIC<I>ISTATE <STATE>  .oiiiiiiiiiiiie e 46
LOGic<I>:LABEl <Label> oo 46
LOGic<I>:LABel:State <lLabel> ..o 46
POD:THReshold <Threshold Mode> ..o 46
POD:THReshold:UDLevel<u> <Threshold Level> ......cccccoiiiiiiiiiiiiiiiececeeee e 47
POD:STAtE <STATE>  iiiiiiiiiii it e e 47
PO D D AT A ? e 47
POD:DATAIHEADEI? e 47
POD:DATAIPOINTS ottt 48
POD:DATAXINCIEMENT? oo e 49
POD:DATAIXORIGIN? e 49
POD:DATANYINCIEMENT? oo e 49
POD :DATANY ORIGIN? e et 49
POD:DATANYRESOIULION? oo 49
POD:CURReNt:STATE:MINIMUM? oo 50
POD:CURReNt:STATE:MAXIMUIM? o oo 50

LOGic<I>:POSition <Position>
Set the position of a logic channel.

Suffix:

<I> Selects the logic channel (0...7).
Parameters:

<Position> Position value in divisions.

LOGic<I>:SIZE <Size>
Set the size of the display of the logic channel.

Suffix:

<> Selects the logic channel (0...7).
Parameters:

<Size> SMALI | MEDium | LARGe

*RST: SMAL
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LOGic<I>:STATe <state>
Switches the channel signal on or off.

Suffix:

<> Selects the logic channel (0...7).
Parameters:

<State> ON | OFF

LOGic<I>:LABel <Label>
Set the label for the logic channel.

Suffix:

<> Selects the logic channel (0...7).

Parameters:

<lLabel> String value “xxxxxxxx" with maximum 8 ASCII characters.

LOGic<I>:LABel:State <Label>
Switches the label of the lagic channel on or off.

Suffix:

<|> Selects the logic channel (0...7).
Parameters:

<lLabel> ON | OFF

POD:THReshold <Threshold Mode>

Threshold Mode for Logic Pod. If the signal value is higher than the threshold, the signal state is
high (1 or true for the boolean logic). Otherwise, the signal state is considered low (0 or false) if
the signal value is below the threshold.

Parameters:
<Threshold Mode> TTL | ECL | CMOS | USER1 | USER2

TTL TTL level, setto 1.4V

ECL ECL level, set to -1.3V

CMOS CMOS level, set to 2.5V

USER1 USERT1 level, can be set with POD:THReshold:UDLevel<u>.
USER2 USER2 level, can be set with POD:THReshold:UDLevel<u>.
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POD:THReshold:UDLevel<u> <Threshold Level>
Set the user high level threshold for the pod.

Suffix:

<u> Select the User setting. (USER1, USER2)
Parameters:

<Threshold Level> Threshold level in V.

Range: -2 to 8

POD:State <State>
Switches the Pod on or off.

Parameters:

<State> ON | OFF
*RST: OFF

POD:DATA?

Returns the data of the specified digital channel. To set the export format, use FORMat[:DATA].
To set the range of samples to be returned, use POD:DATA:POINts.

Parameters:
<WaveformData> List of values according to the format settings.
Example: FORM ASC,0
POD:DATA?
1,1,1,1,1,1,0,0,0,0,0,0,...
Usage: Query only

POD:DATA:HEADer?
Returns information on the digital channel waveform.

Position | Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval, usually 1. 1

Table 2.1: Header data
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Return values:

<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only

POD:DATA:POINts

As a setting, the command selects a range of samples that will be returned with POD:DATA?.
As a query, the command returns the number of returned samples for the selected range.

If ACQuire:WRATe is set to MSAMples (maximum sample rate), the memory usually contains
more data samples than the screen can display. In this case, you can decide which data will be
saved: samples stored in the memory or only the displayed samples.

The entire oscilloscope memory can only be read out in STOP mode if the maximum
sampling has been activated in the ACQUIRE menu.

Parameters:
<PointSelection> DEFault | MAXimum | DMAXimum
Sets the range for data queries.

DEFault
Waveform samples displayed on the screen.

MAXimum
Range is the complete memory (only available with maximum sample
rate and STOP mode).

DMAXimum (Display Maximum)
Number of samples in the current waveform record.

*RST: DEFault
Return values:
<Points> Number of data points in the selected range.

Default unit: Samples

See also: CHANnel<m>:DATA:POINts

e
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POD:DATA:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mand is relevant for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Xincrement> Time in's

Usage: Query only
POD:DATA:XORigin?
Returns the time of the first sample of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Xorigin> Timeins

Usage: Query only
POD:DATA:YINCrement?
Returns the voltage value per bit of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Yincrement> Voltage in V

Usage: Query only
POD:DATA:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform. The command is relevant

for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Yorigin> Voltage in V

Usage: Query only

POD:DATA:YRESolution?

Return the vertical bit resolution of the indicated waveform. The command is relevant for data
conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:

<Yresolution> For default waveforms, the resolution is 8 bit.

If high resolution, average or filter are set, the resolution is 16 bit.

Usage: Query only
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POD:CURRent:STATe:MINimum?
POD:CURRent:STATe:MAXimum?

Both commands together return the current status of the digital channel regardless of the trigger
settings and even without any acquisition.

POD:CURR:STAT:MIN returns POD:CURR:STAT:MAX returns Signal
0 0 Low
1 1 High
0 1 Toggle

Table 2.1: POD status

Return values:
<CurrentState> Range: 0] 1

Usage: Query only
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2.2.6 Waveform Data

CHANNEIMS I DATA? ettt e e et e st e et e e st e e stbe s etbeesabe s 51
CHANRNEl<mM>DATAIHEADEI? ..ottt 52
CHANRNEl<mM>:DATAXINCIEMENT? oot 52
CHANNEl<M > DATAXORIGIN? oo 52
CHANNEl<M>DATAIYINCIEMENT?  ooiiiie ettt ettt et et e et e e st e e nnbeesneeenneeans 53
CHANRNEI<M > DATAINYORIGIN? ottt e e e e e e e e etvareaa s 53
CHANNEl<mM>:DATAYRESOIULION?  eiiiiieiiie ettt sttt e staaennve e 53
CHANRNEl<M>:DATAIENVEIOPE? oo 53
CHANRNel<m>:DATAIENVelIOPeHEADEI? ..o 54
CHANRNel<m>:DATAENVelope: XINCrement? ... 54
CHANnNel<m>:DATAENVElope: XORIGIN?  ooeeiiiiiiiie e 54
CHANRNel<m>:DATA:ENVElope:YINCIrEMENT?  ..oeiiiiiiiiiiiiiiieiieeieeeieieeeeeeeeeeeeeeeaeaeeeveeeeeananaeees 55
CHANRNel<m>:DATAENVEIOPE:YORIGIN?  ooriiiiiiiiiiiet e 55
CHANRNel<m>:DATA:ENVelope:YRESOIUTION? oo 55
CHANNEl<mM>:DATAPOINTS <POINTS> ..ottt 56
FORMat[:DATA] <DataFormat>, ACCUIACY>  ...oiiiiiiiiiiee e ettt b7
FORMat:BORDEr <BYtEOIUEI>  ..oiiieiiiiieeiee e 58
CHANnel<m>:DATA?

Returns the data of the channel waveform points. The waveforms data can be used in MATLAB,
for example. For envelope waveforms, use the CHANnel<m>:DATA:ENVelope command.

Suffix:
<m> Selects the input channel (1, 2).

Return values:

<Data> Comma-separated list of vertical values (voltages of recorded waveform
samples.
Example: CHANT1:DATA?

-0.125000,-0.123016,-0.123016,-0.123016, -0.123016,-0.123016, ..

Usage: Query only
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CHANnel<m>:DATA:HEADer?
Returns information on the channel waveform. For envelope waveforms, use the
CHANnNel<m>:DATA:ENVelope:HEADer command.

Position | Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStopin's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval, usually 1. 1

Table 2.1: Header data

Suffix:
<m> Selects the input channel (1, 2).

Return values:

<DataHeader> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only

CHANnNel<m>:DATA:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mand is relevant for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Xincrement> Timeins

Usage: Query only
CHANnRel<m>:DATA:XORigin?
Returns the time of the first sample of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Xorigin> Timeins

Usage: Query only

SCPI Programmers Manual 52



SCPI Commands R&S®HMO1002/1202 series Remote Control

Command Reference

CHANnNel<m>:DATA:YINCrement?
Returns the voltage value per bit of the indicated waveform. The command is relevant for data
conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Yincrement> Voltage in V

Usage: Query only

CHANnel<m>:DATA:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform. The command is relevant
for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Yorigin> Voltage in V

Usage: Query only

CHANnNel<m>:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform. The command is relevant for data
conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.
If high resolution, average or filter are set, the resolution is 16 bit.

Usage: Query only

CHANnNel<m>:DATA:ENVelope?
Returns the data of the envelope. The envelope consists of two waveforms. Use this command
only for envelope waveforms. for all other channel waveforms use CHANnel<m>:DATA.

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Data> Comma-separated list of vertical values (voltages of envelope points).
The list contains two values for each sample interval.

Usage: Query only
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CHANnNel<m>:DATA:ENVelope:HEADer?
Returns information on the envelope waveform. Use this command only for envelope wave-
forms. for all other channel waveforms use CHANnel<m>:DATA:HEADer.

Position | Meaning Example
1 XStartin's -9.477E-008 = - 94,77 ns
2 XStopin's 9.477E-008 = 94,77 ns
3 Number of Samples 1200
a Number of values per sample interyal. 2
For envelope waveforms the value is 20.

Suffix:
<m> Selects the input channel (1, 2).

Return values:

<DataHeader> Comma-separated value list
Example: -9.477E-008,9.477E-008,1200,2
Usage: Query only

CHANnel<m>:DATA:ENVelope:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mand is relevant for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Xincrement> Timeins

Usage: Query only
CHANnel<m>:DATA:ENVelope:XORigin?
Returns the time of the first sample of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Xorigin> Time in's

Usage: Query only
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CHANnNel<m>:DATA:ENVelope:YINCrement?
Returns the voltage value per bit of the indicated waveform. The command is relevant for data
conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Yincrement> Voltage in V

Usage: Query only
CHANnel<m>:DATA:ENVelope:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform. The command is relevant

for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Yorigin> Voltage in V

Usage: Query only
CHANnNel<m>:DATA:ENVelope:YRESolution?
Return the vertical bit resolution of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.

If high resolution, average or filter are set, the resolution is 16 bit.

Usage: Query only
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CHANnel<m>:DATA:POINts <Points>

As a setting, the command selects a range of samples. As a query, it returns the number of
samples for the selected range. To get correct results with settings MAX and DMAX, the acqui-
sition must not run when the command is used. To acquire consistent and valid data, use the
SINGle command before. Do not cancel a running acquisition with STOP because the waveform
data might be incomplete or incorrect.

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<Points> Number of data points in the selected range (samples). The number of
data points is depending on the timebase and channel settings.

Setting Parameters:
<Points> DEFault | MAXimum | DMAXimum
Sets the range for the query.

DEFault
Waveform samples displayed on the screen.

MAXimum
Range is the complete memory (only available with maximum sample
rate and STOP mode).

The entire oscilloscope memory can only be read out in STOP mode if the maximum
sampling has been activated in the ACQUIRE menu.

DMAXimum (Display Maximum)
Number of samples in the current waveform record.

Example: The instrument recorded 10000 samples. 6000 of these samples apply
to the screen. To create the display points, every 6 points are combined
to a MIN-MAX pair, and 1000 of these data pairs are displayed on the
screen. For DEFault, 2000 is returned (1000 data pairs). DMAX returns
6000, and MAX 10000 (the complete memory).

Record mode ,,AUTOMATIC” (ACQUIRE menu) in STOP mode
CHAN1:DATA:POIN MAX

CHANT:DATA:POIN?

Suffix: 240000

Record mode ,,MAX.SA.RATE"” (ACQUIRE menu) in STOP mode
CHANT:DATA:POIN MAX

CHANT:DATA:POIN?

Suffix: 1048560
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FORMat[:DATA] <DataFormat>,<Accuracy>
Defines the format for data export with:
CHANnel<m>:DATA?
CHANnNel<m>:DATA:ENVelope?
REFCurve<m=>:DATA?
CALCulate:QMATH:DATA?

Parameters:
<DataFormat> ASCii | REAL | UINTeger | CSV

ASCii

List of values, for example, 1.23,1.22,1.24,..

<Accuracy> is 0, which means that the instrument selects the number
of digits to be returned. The query returns ASC,0.

REAL
Block data, 32 bit float values in 4 byte blocks.
<Accuracy> is always 32. The query returns REAL,32.

UINTeger

Unsigned integer format, binary values with length 8 or 16 bit (UINT,8
or UINT,16). The data range for UINT,8 is 0 to 255, the data range

for UINT,16 is O to 65.535. For data conversion, you need the re-

sults of ....DATA:XORigin?, ....DATA:XINCrement?, ...:.DATA:Yorigin?,
....DATA:YINCrement? and ...:.DATA:YRESolution? commands.

Csv
Comma separated value list.

*RST: ASC

<Accuracy> 0181632
Length of a data value in bit

*RST: 0
Example: FORM ASC

FORM?
ASC,0
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FORMat:BORDer <ByteOrder>
Defines the byte order for binary data export if FORMat[:DATA] is set to REAL or UINT.

Parameters:
<ByteOrder> MSBFirst | LSBFirst

MSBEFirst
Big endian, most significant byte first, for example:
abcd,acbe,abcf, ...

LSBFirst
Little endian, least significant byte first, for example:

dcba,ebca,fcba, ...

*RST: MSBF

2.2.7 Waveform Data Export to File

EXPort:WAVeform:SOURce <WaveformSOUIrCE> ..o 58
EXPort:WAVeform:NAME <FIleNamME> .o 59
EXPOrt: VWAV OrmMISAVE o 59

EXPort:WAVeform:SOURce <WaveformSource>
Defines the waveform to be exported.

Parameters:
<WaveformSource> CH1|CH2| DO0...7 | QMA | MA1...MA5G | RE1..4

CH1 | CH2: Analog channels
DO...7: Pod, digital channels DO to D7 are exported together
QMA: Quick Mathematics waveform
MA1...MAb: Mathematics waveform
(only with R&S®HMO 1202 series)
RE1..4: Reference waveforms RE1 | RE2 | RE3 | RE4
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EXPort:WAVeform:NAME <FileName>

Defines the path and file name for a waveform data file that will be saved with
EXPort:WAVeform:SAVE. Depending on which USB port the flash drive is connected to, you
either choose “/USB_FRONT" or “/USB_REAR" to specify the correct location. Additionally,
the format type via FORM {ASC, REAL, UINT, CSV} and the number of points to export via
CHAN<n>:DATA:POIN <points> should be defined. Existing files will be overwritten. You can
change the storage location, file name and/or file format manually in the HMO menu. Remote
control uses the recent settings.

Parameters:
<FileName> String parameter
Example: FORM CSV

EXP:WAV:SOUR CH1

EXP:WAV:NAME “/USB_FRONT/CHANNEL1.CSV”
EXP:WAV:SAVE

The waveform data is saved to CHANNEL1.CSV.

EXPort:WAVeform:SAVE

Saves the waveform and starts the export to USB drive.

Usage: Event

2.2.8 Probes

PROBe<m > SETUDR TY PE? o
PROBe<m>:SETup:ATTenuation:UNIT <Unit>
PROBe<m>:SETup:ATTenuation:MANual <ManualAttenuation>  .......cccccoeviiiieiieiiiiiiiieeceeee, 60
PROBe<m>:SETUp:ATTenuation[:AUTO]? e 60

PROBe<m>:SETup:TYPE?
Queries the type of the probe.

Suffix:
<m> Selects the input channel (1, 2).

Return values:

<Type> NONE | ACTive | PASSive
NONE: Not detected
ACTive: Active probe
PASSive: Passive probe
Usage: Query only
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PROBe<m>:SETup:ATTenuation:UNIT <Unit>
Selects the unit that the probe can measure.

Suffix:

<m> Selects the input channel (1, 2).
Parameters:

<Unit> VA

PROBe<m>:SETup:ATTenuation:MANual <ManualAttenuation>
Sets the attenuation or gain of the probe if the probe was not detected by the instrument.

Suffix:
<m> Selects the input channel (1, 2).

Parameters:
<ManualAttenuation> Range: 0.001 to 10000

*RST: 1
PROBe<m>:SETup:ATTenuation[:AUTO]?
Returns the attenuation of an automatically detected probe.

Suffix:
<m> Selects the input channel (1, 2).

Return values:
<ProbeAttenuation> Range: 0.001 to 1000

Usage: Query only
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2.3 Trigger

2.3.7 General A TrgOer SEHHINGS  coiiiiiiii e e 61
R I e [o TS 5o [ 1] SO U TR 64
2.3.3 WIdLh (PUISE) THOGET  ieeeiiieii ettt ettt ettt e e e e ettt e e e e et e e e e e 65
R IRV To [ To YA YA o o = RSP 67
2.3.5 Pattern (LOGIC) TrIGOBI oo 68

2.3.1 General A Trigger Settings

TRIGger:A:IMODE <TriggerMOdes>  ...uuiiiiiic e 61
TRIGger: A:LEVel<n>[[VALUE] <LeVEI> ..ot 61
TRIGQENA:SOURCE <SSOUMCES  .oeiiiiiiiei e 62
TRIGger:EXTern:COUPIINg <EXternCoupling > ...ooiiiiiiiioee e 62
TRIGQENAITYPE <TYDE> oot e e e e e e 62
TRIGGErA:HOLDOFIMODE  .oiiiiiiiiii ettt ettt e et eentaeeenas 62
TRIGGErAHOLDOETIME ittt ettt e nane e 63
TRIGGEROUTIMODE .ottt e e ettt e e et e e e et e e e esareeeen 63
TRIGGENOUTIPOLATTY  teeeeiitieitit etttk ettt ettt ettt et e et e et e et e et e e neeeenneas 63
TRIGGENOUTIPLENGEN ettt ettt et et et e et eeneeeenneas 63

TRIGger:A:MODE <TriggerMode>
Sets the trigger mode. The trigger mode determines the behaviour of the instrument if no trigger
occurs.

Parameters:
<TriggerMode> AUTO | NORMal

AUTO
The instrument triggers repeatedly after a time interval if the trigger
conditions are not fulfilled. If a real trigger occurs, it takes precedence.

NORMal
The instrument acquires a waveform only if a trigger occurs.

*RST: AUTO

TRIGger:A:LEVel<n>[:VALue] <Level>
Sets the trigger treshold voltage for all A trigger types that require a trigger level.

Suffix:

<n> Selects the trigger input. 1, 2 selects the corresponding channel,
5 selects the external trigger input.

Parameters:

<lLevel> Trigger level in V.

Range: Depends on vertical scale
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TRIGger:A:SOURce <Source>
Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1 | CH2 | DO...D7 | EXTernanalog | LINE | PATTern | NONE

CH1 | CH2: Analog channels

DO...D7: Digital channels

EXTernanalog: External TRIG IN connector on the front panel
LINE: AC line for the edge trigger

PATTern: Pattern

NONE: No trigger source selected

*RST: CH1

TRIGger:EXTern:COUPIling <ExternCoupling>
Sets the coupling for the external trigger input. The command is relevant if TRIGger:A:SOURce is
set to EXTernanalog.

Parameters:
<ExternCoupling> AC|DC

*RST: AC

TRIGger:A:TYPE <Type>
Sets the trigger type for the A trigger.

Parameters:
<Type> EDGE | WIDTh | TV | LOGic | BUS

EDGE: Edge trigger
WIDTh: Pulse trigger
TV: Video trigger
LOGic: Logic trigger
BUS: BUS trigger require options

*RST: EDGE
TRIGger:A:HOLDoff:MODE
Sets the trigger hold off mode.

Parameters:
<HoldOff_Mode> TIME | OFF

*RST: OFF
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TRIGger:A:HOLDoff:-TIME
Defines the holdoff time. The next trigger only occurs after the holdoff time has passed.

Parameters:
<HoldOff_Time> Range: 5.00000E-08 to 1.00000E+01
Default unit: s

TRIGger:OUT:MODE
Sets the trigger output mode. Defines the trigger output mode wether and when a trigger out
pulse is generated.

Parameters:

<Output_Mode> OFF | TRIGger | MASK | GENerator
TRIGger: Trigger event
MASK: Mask violation
GENerator: Generator signal
*RST: OFF

TRIGger:OUT:POLarity
Sets the trigger output polarity,

Parameters:
<Polarity> POSitive | NEGative

*RST: POS

TRIGger:OUT:PLENgth
Sets the trigger output pulse length.

Parameters:
<Pulse_Length> Numeric value
Default unit: s

*RST: 1E-6
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2.3.2 Edge Trigger

TRIGQErAIEDGE:SLOPE <SIOPE> oottt 64
TRIGger: A:EDGE:COUPING <COUPING>  ooiiiiiiiiii e 64
TRIGger: A:EDGE:FILTer:LPASS <State> ..o 65
TRIGger: A:EDGE:FILTer:NREJecCt <State> ..o 65

TRIGger:A:EDGE:SLOPe <Slope>
Sets the slope for the edge trigger (A trigger).

Parameters:

<Slope> POSitive | NEGative | EITHer
POSitive: Rising edge (positive voltage change)
NEGative: Falling edge (negative voltage change)
EITHer: Rising as well as the falling edge
*RST: POS

TRIGger:A:EDGE:COUPIling <Coupling>
Sets the coupling for the trigger source.

Parameters:
<Coupling> DC | AC | HF | ALEVel

DC
Direct Current coupling. The trigger signal remains unchanged.

AC
Alternating Current coupling. A 5 Hz high pass filter removes the DC
offset voltage from the trigger signal.

HF

High frequency coupling. A 15 kHz high-pass filter removes lower fre-
quencies from the trigger signal. Use this mode only with very high
frequency signals.

ALEVel (Auto Level)

*RST: DC
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TRIGger:A:EDGE:FILTer:LPASs <State>
Turns an additional 5 kHz low-pass filter in the trigger path on or off. This filter removes higher
frequencies and is available with AC and DC coupling.

Parameters:
<State> ON | OFF

*RST: OFF

TRIGger:A:EDGE:FILTer:NREJect <State>
Turns an additional 100 MHz low-pass filter in the trigger path on or off. This filter removes high-
er frequencies and is available with AC and DC coupling.

Parameters:
<State> ON | OFF

*RST: OFF

2.3.3 Width (Pulse) Trigger

TRIGger: A:WIDTh:POLarity <POIArtY>  ..oiiiiiiiiiiii e 65
TRIGger: A:\WIDTh:RANGe <RaNgeMOode> .. .o 66
TRIGger: AWIDTh:DELTa <DEIA> .o 66
TRIGger: A:\WIDTh:WIDTh <Time1>

TRIGger:A:WIDTh:POLarity <Polarity>
Sets the polarity of the pulse triger function.

Parameters:
<Polarity> POSitive | NEGative

POSitive
Positive going pulse, the width is defined from the rising to the falling
slopes.

NEGative
Negative going pulse, the width is defined from the falling to the rising
slopes.

*RST: POS
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TRIGger:A:WIDTh:RANGe <RangeMode>
Defines how the measured pulse width is compared with the given limit(s).

Parameters:
<RangeMode> WITHin | OUTSide | SHORter | LONGer

WITHin | OUTSide

Triggers on pulses inside or outside a range defined by time + delta.
The time is specified with TRIGger:A:WIDTh:WIDTh, the range around is
defined with TRIGger:A:WIDTh:DELTa.

SHORter | LONGer
Triggers on pulses shorter or longer than a time set with
TRIGger:A:WIDTh:WIDTh.

*RST: LONG

TRIGger:A:WIDTh:DELTa <Delta>
Defines a range around the width value specified using TRIGger:A:WIDTh:WIDTh.

Parameters:
<Delta> Range: £At (,,Variation”)
Value range depends on the defined pulse width

*RST: 3.2E-9

TRIGger:A:WIDTh:WIDTh <Time1>

For the ranges WITHin and OUTSide (defined using TRIGger:A:WIDTh:RANGe), the

<Time1> defines the center of a range which is defined by the limits +<Delta> (set with
TRIGger:A:WIDTh:DELTa). For the ranges SHORter and LONGer, the width defines the maximum
and minimum pulse width, respectively.

Parameters:
<Timel> Center value, maximum value or minimum value depending on the
defined range type.

Range: 1.6E-08 to 3.435974E+01
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2.3.4 Video/TV Trigger

TRIGger: A:TV:STANdard <Standard> ... 67
TRIGer: A:TV:POLArity <POIArY> oo 67
TRIGger: ATVIFIEL <Field> o 67
TRIGer ATVILINE <Line> oo 68

TRIGger:A:TV:STANdard <Standard>
Selects the color television standard.

Parameters:
<Standard> PAL | NTSC | SECam | PALM | 1576 | P720 | P1080 | 11080

*RST: PAL

TRIGger:A:TV:POLarity <Polarity>
Sets the polarity of the sync pulses. The edges of the sync pulses are used for triggering.

Parameters:
<Polarity> POSitive | NEGative

POSitive
If the video modulation is positve, the sync pulses are negative.

NEGative
If the modulation is negative, sync pulses are positive.

*RST: NEG

TRIGger:A:TV:FIELd <Field>
Sets the trigger on the beginning of the video signal fields or on the beginning of video signal
lines.

Parameters:
<Field> EVEN | ODD | ALL | LINE | ALINe

EVEN
Triggers only on even half frames.

OoDD
Triggers only on odd half frames.

ALL
Triggers on all frames.

LINE
Triggers on the beginning of a specified line in any field.
The line number is set with TRIGger:A:TV:LINE.

SCPI Programmers Manual 67



Command Reference

ALINe
Triggers on the beginning of all video signal lines.

*RST: ALL

TRIGger:A:TV:LINE <Line>
Sets an exact line number if TRIGger:A:TV:FIELd is set to LINE.

Parameters:
<Line> Range: 1 to 525, 625, ..., 1080 depending on the TV standard

*RST: 1

2.3.5 Pattern (Logic) Trigger

TRIGger:A:PATTern:SOURCE <SOUICESTIINGS  ..viiiiiiiiiiiiie e 68
TRIGger: A:PATTern:FUNCHION <FUNCHON> ..ot 69
TRIGger:A:PATTern:CONDItion <CONAITION  ...uiiiiiiiiiiiiiiit e 69
TRIGger:A:PATTern:MODE <PatterNMOde>  ....ouvviiiiiiiiiiiiee e 69
TRIGger: A:PATTern:WIDTh[:WIDTh] <Numeric_Value> ........ccccciiiiiiiiiiiiiiiiiee e 70
TRIGger:A:PATTern:WIDTh:DELTa <PatternDelta>  .....ccocoiiiiiiiiiiiec e, 70
TRIGger:A:PATTern:WIDTh:RANGe <PatternRanges> . ...c.cccooiiiiiiiiiiiiciie e 70

TRIGger:A:PATTern:SOURce <SourceString>
Selects the state for each digital channel. The respective channel (CH1, CH2 or logic channels
0...7) has to be activated before state selecting.

Parameters:

<SourceString> String containing O, 1, or X for each channel.
1: High, the signal voltage is higher than the trigger level.
0: Low, the signal voltage is lower than the trigger level.
X: Don't care. the channel does not affect the trigger.

Example: TRIG:A:PATT:SOUR ,, 1X"

CH1 = High, CH2 = Don’t care (POD deactivated)

TRIG:A:PATT:SOUR ,,00101X1X1X"
POD: 0 = High, 1 = Low, ..., 7 = Don’t care (CH1 / CH2 deactivated)



SCPI Commands R&S®HMO1002/1202 series Remote Control

Command Reference

TRIGger:A:PATTern:FUNCtion <Function>
Sets the logical combination of the trigger states of the channels.

Parameters:
<Function> AND | OR
AND
The required states of all channels must appear in the input signal at the
same time.
OR

At least one of the channels must have the required state.

*RST: AND

TRIGger:A:PATTern:CONDition <Condition>
Sets the trigger point depending on the result of the logical combination of the channel
states.

Parameters:
<Condition> .TRUE" | ,FALSE”

*RST: ,TRUE"

TRIGger:A:PATTern:MODE <PatternMode>
Sets the duration function of the pattern trigger.

Parameters:
<PatternMode> OFF | TIMeout | WIDTh

OFF
Pattern trigger without duration.

TIMeout
Defines how long at least the result of the state pattern condition must
be true or false.

WIDTh
Width duration and comparision of the logical combined channels. The
range is defined using TRIGger:A:PATTern:WIDTh:RANGe.

*RST: OFF
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TRIGger:A:PATTern:WIDTh[:WIDTh] <Numeric_Value>

For the ranges WITHin and OUTSide (defined using TRIGger:A:PATTern:WIDTh:RANGe), the
<numeric_value> defines the center of a range which is defined by the limits +<Delta> (set with
TRIGger:A:PATTern:WIDTh:DELTa). For the ranges SHORter and LONGer, the width defines the
maximum and minimum pulse width, respectively.

Parameters:

<Numeric_Value> Center value, maximum value or minimum value depending on the
defined range type.
Range: 1.600E-08 to 3.435974E+01

*RST: 3.9999999E-04

TRIGger:A:PATTern:WIDTh:DELTa <PatternDelta>
Defines a range around the width value specified using TRIGger:A:PATTern:WIDTh[:WIDTh].

Parameters:

<Delta> Range: £At (,Variation”)
Range: 8.00E-09 to maximum value depends on the defined pulse
width

*RST: 1.5000000E-04

TRIGger:A:PATTern:WIDTh:RANGe <PatternRange>
Defines a range around the width value specified using TRIGger:A:PATTern:WIDTh:WIDTh.

Parameters:
<PatternRange> WITHin | OUTSide | SHORter | LONGer

WITHin | OUTSide

Triggers on pulses inside or outside a range defined by time + delta.
The time is specified with TRIGger:A:PATTern:WIDTh[:WIDTh], the range
around is defined with TRIGger:A:PATTern:WIDTh:DELTa.

SHORter | LONGer
Triggers on pulses shorter or longer than a time set with

TRIGger:A:PATTern:WIDTh[:WIDTh]

*RST: LONG

e
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2.4 Display

2.41

2.4.7 BasiC DiSplay SETHINGS  oeeiiiiiiiiiiieeee et 71
24,2 Z0OM oo e 77
2.4.3 Markers (TIMESTAMPS)  ceiiiie e et 78

Basic Display Settings
This chapter describes commands that configure the screen display.

General Display Settings:

DISPIay:MODE <MOGE> oo 71
DISPlay:PALEtte <Palettes> oo 72
DISPlay:VSCReen:ENABIe <ENable> ..o 72
DISPlay:VSCReen:POSItION <POSIION  ..vviiiiiiiiiccie et 72
DISPIaY:DIALOGICLOSE oo e e 73
DISPlay:DIALog:MESSage <MessageText> .....cciiiiiiiiiiiiiiiiiii e 73
DISPlay:DIALog: TRANSparency <TranSParENCY> .......cccciiiiiuiriieeeeeeiiiiiieee e e e e eeiiee e e e e e eiavaee e 73
DISPIAY:LANGUAGE  .oiieiiiiiii ettt ettt e ettt e e et e e e et e e ettt e e e etaeeeeenneeas 73
DISPIay:LANGUAGEIREMOVE ..t 73
DISPIaY:LANGUAGEIADD oottt ettt e e et et e e 74
DISPIay:LANGUAGE:CATAIOT?  eeieiiiiieee ettt et e e et e e e e e e ettt e e e e e e e nnaaaeaaee s 74
XY-Setup:

DISPIay:XY: XSOUICE SSOUICEDS  wiiiiiiiiiiiiiiiie ettt e e e e et e e e e e e e etaara e e 74
DISPIaY: XY Y TSOUICE SSOUMCES  .oiiiiiiiiiiiiiie et e 74
Intensities

DISPlay:INTensity:WAVeform <INteNSIty> ..o 74
DISPlay:INTensity:BACKIght <INTENSITY>  .oiiiiiiiiiiiieeee e 75
DISPlay:INTensity:GRID <INTENSITY>  .oiiiiiiiiiiii i 75
DISPlay:PERSISTENCEISTATE <STATE> oottt 75
DISPlay:PERSISteNCe:TIME <TiMe> (oo 75
DISPlay:PERSistence:INFinite <InfPersistence> ..o 76
DISPlay:PERSistence: TIME:AUTO <AULO> ..o 76
DISPIay:PERSISTENCEICLEAr ..o 76

Waveform, Auxilary Cursors and Grid Settings
DISPIAY:STYLE <SIYIE> ittt ettt e b e be e ebe e beeeae e 76
DISPIaY:GRID:ISTYLE <StYIE> oo 76

DISPlay:MODE <Mode>
Sets the diagram mode.

Parameters:
<Mode> YT | XY

YT
Default time diagram with a time axis in x-direction and the signal
amplitudes displayed in y-direction.



SCPI Commands R&S®HMO1002/1202 series Remote Control
|

Command Reference

XY
XY-diagram combines the voltage levels of two waveforms in one
diagram.

*RST: YT

DISPlay:PALette <Palette>
Sets the color and brightness of the displayed waveform samples depending on their cumulative
occurance.

Parameters:
<Palette> NORMal | INVerse | FCOLor | IFColor

NORMal
Values that occur frequently are brighter than rare values.

INVerse
Rare values are brighter than frequent values, inverse to the NORMal
brightness.

FColor

Rare values are displayed in blue while more frequent values are red
and very frequent values are displayed in yellow or white, with various
colors inbetween.

IFColor
Inverses the FColor setting. Rare values are yellow or white while

frequent values are blue.

*RST: NORM
DISPlay:VSCReen:ENABIe <Enable>
Switches the virtual screen on or off.

Parameters:
<Enable> ON | OFF

*RST: OFF
DISPlay:VSCReen:POSition <Position>
Set the position of the virtual screen window.

Parameters:
<Position> Range: 2 to -10

*RST: 0

e
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DISPlay:DIALog:CLOSe

Closes an open dialog box.

Usage: Event

DISPlay:DIALog:MESSage <MessageText>

Sends a message text to the instrument and displays it in a message box. To close the message
box, use DISPlay:DIALog:CLOSe.

Parameters:

<MessageText> String that contains the message.
Example: DISP:DIAL:MESS ,My message
Usage: Setting only

DISPlay:DIALog:TRANsparency <Transparency>
Sets the transparency of result boxes that overlay the waveforms, for example, boxes with stati-
stical results or digital voltmeter results.

Parameters:
<Transparency> Range: 0 to 100
Default unit: %

DISPlay:LANGuage
Sets the menu language. The *RST command does not reset the language setting.

Parameters:

<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |
TCHinese | JAPanese | KORean

DISPlay:LANGuage:REMove
Removes an installed menu language file from internal memory.

Example: DISP:LANG:REM <language>
DISP:LANG:REM GERM

Usage: Setting only
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DISPlay:LANGuage:ADD
Adds a saved menu language file from USB stick to internal memory.

Parameters:
<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |
TCHinese | JAPanese | KORean
Example: DISP:LANG:ADD <language>,<path>
DISP:LANG:ADD GERM,”“/USB_FRONT/HMO_LNOO.HLU"
Usage: Setting only

DISPlay:LANGuage:CATalog?
Returns all installed menu language files.

Return values:

<Catalog> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |
TCHinese | JAPanese | KORean

Usage: Query only

DISPlay:XY:XSOurce <Source>

Defines the source to be displayed in x direction in an XY-diagram, replacing the usual time base.

Parameters:
<Source> CH1 | CH2

*RST: CH1
DISPlay:XY:Y1Source <Source>
Defines the (first) source to be displayed in y direction in an XY-diagram.

Parameters:
<Source> CH1 | CH2

*RST: CH2
DISPlay:INTensity:WAVeform <Intensity>
Defines the strength of the waveform line in the diagram. *RST does not change the intensity.
Parameters:

<Intensity> Value in percent
Range: 0 to 100
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DISPlay:INTensity:BACKIlight <Intensity>
Defines the intensity of the background lighting of the display. *RST does not change the inten-
sity.

Parameters:
<Intensity> Value in percent
Range: 10 to 100

DISPlay:INTensity:GRID <Intensity>
Defines the intensity of the grid on the screen. *RST does not change the intensity.

Parameters:
<Intensity> Value in percent
Range: 0 to 100

DISPlay:PERSistence:STATe <State>
Defines whether the waveform persists on the screen or whether the screen is refreshed
continuously.

Parameters:
<State> ON | OFF

ON
The waveform persists for the time defined using
DISPlay:PERSistence:TIME.

OFF
The waveform does not persist on the screen. Only the currently
measured values are displayed at any time.

*RST: OFF

DISPlay:PERSistence:TIME <Time>

Persistence time if persistence is active (see DISPlay:PERSistence:STATe). Each new data point in
the diagram area remains on the screen for the duration defined here. To set infinite persistence,
use DISPlay:PERSistence:INFinite.

Parameters:
<Time> Value in s

Range: bE-2 to infinite

*RST: bE-2
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DISPlay:PERSistence:INFinite <InfPersistence>
Sets the persistence time to infinite if DISPlay:PERSistence:STATe is ON. each new data point
remains on the screen infinitely until this setting is changed or the persistence is cleared.

Parameters:
<InfPersistence> ON | OFF

*RST: OFF
DISPlay:PERSistence:TIME:AUTO <Auto>
The optimal persistence time is determined automatically by the instrument.
Parameters:
<Auto> ON | OFF
DISPlay:PERSistence:CLEar
Removes the displayed persistent waveform from the screen.
Usage: Event
DISPlay:STYLe <Style>
Defines how the waveform data is displayed

Parameters:
<Style> VECTors | DOTS

VECTors
Individual data points are connected by a line.

DOTS
Only the data points are displayed.

*RST: VECT

DISPlay:GRID:STYLe <Style>
Defines how the grid is displayed.

Parameters:
<Style> LINes | RETicle | NONE
LINes: Displays the grid as horizontal and vertical lines.
RETicle: Displays crosshairs instead of a grid.
NONE: No grid
*RST: LIN
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2.4.2 Zoom
TIMebase:ZOOM:STATEe <Z00MSTAtE>  ..iiiiiiiiiiiie e 77
TIMebase:ZOOM:SCALe <Z00MSCaIE> ..o 77
TIMebase:ZOOM:TIME <TiME> i 77
TIMebase:ZOOM:POSIHION <POSITION> oo 77

TIMebase:ZOOM:STATe <ZoomState>
Switches the zoom window on or off.

Parameters:
<ZoomState> ON | OFF

*RST: OFF

TIMebase:ZOOM:SCALe <ZoomScale>
Defines the time base in the zoom diagram in seconds per division.

Parameters:
<ZoomScale> Scaling of the zoom time base in s/div depending on time base and
channel settings

TIMebase:ZOOM:TIME <Time>
Defines the offset of the trigger point to the reference point of the zoom diagram.

Parameters:
<Time> Value in's

*RST: 0

TIMebase:ZOOM:POSition <Position>
Defines the position of the zoom reference point (the reference point of the zoom window) in
relation to the reference point of original time base.

Parameters:
<Position> Value in %
Range: 0 to 100, depending on the zoom time base

*RST: 5.00E+01
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2.4.3 Markers (Timestamps)

RIS E=Ta0] oS = U PP UUTRPROPUUPPRSTRRNt 78
LIS T 0] o 1AL =5 O U OO PP PR PUPPORPPR 78
TSTAMPIPREVIOUS ittt e e e e ettt e e e e e et eeaaaaeenas 78
LIS = La ] o H O I T PP UR PR UUUUPPPPTRRN 78
B IS F=Ta 0] oI A O I=Y- Y U PURUPRSRN 78
TSTamp:SET

Sets a new marker (timestamp) at the reference point of the display, unless an existing marker is
already set there. The reference point is set with TIMebase:REFerence.

Usage: Event

TSTamp:NEXT

Moves the next marker (timestamp, to the right) to the reference point of the display or zoom
area.

Usage: Event

TSTamp:PREVious

Moves the previous marker (timestamp, to the left) to the reference point of the display or zoom
area.

Usage: Event

TSTamp:CLEar

Deletes the marker (timestamp) at the reference point. The reference point is set with
TIMebase:REFerence.

Usage: Event

TSTamp:ACLear

Deletes all markers (timestamps).

Usage: Event
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2.5 Measurements

2.5.1

This chapter describes functions that configure or perform cursor and automatic measurements.

Cursor

(01U Yo R g P AN O SRR 79
CURSOIr<mM>ISTATE <STATE> oottt e et e e e e e e e e e e e etabaaaa e s 79
CURSOr<mM=>:FUNCHON STYPE>  1oiiiiiiiiiiiiiiie ettt e e e et a e 80
CURSOr<mM>:SOURCE SSOUIMCES  .iiiiiiiiiiiiiiiiiic ettt 81
CURSOI<M>ISWAVE oot 81
CURSOI<M>ISSCREEN oot 81
CURSOIr<mM>1SNPEAK<N> oo 81
CURSOIr<mM>1SPPeaK N> i 82
CURSor<m=>:TRACKING[:STATE] <STAte> ..ioeiiiiieiie e 82
CURSor<m=>:XTP0osition <XPOSIIONT>  oiiiiiiiiiiiiiiiie e 82
CURSor<m=>:X2P0Sition <XPOSIIONZ2>  oiiiiiiiiiiiiiiiiic et 82
CURSor<m=>:X3P0osition <XPOSItION3>  oiiiiiiiiiiiiiiiiie e 82
CURSor<m>:YTP0oSItion <YPOSITIONT > oiiiiiiiiiii ittt 83
CURSor<m>:Y2P0oSition <YPOSITIONZ>  ouuiiiiiiiee et 83
CURSor<m>:Y3P0oSition <YPOSItIONS>  uiiiiiiiiiii e 83
CURSor<m=>:TRACKING:SCALE[:STATE] <State> ...oiooiiiiiceii e 83
CURSor<m=>:YCOUPIING <COUPIINGS™  1oiiiiiiiiiiec ettt 84
CURSor<m=>:XCOUPHNG <COUPING> oottt 84
CURSOIr<mM>IRESUI? oot 84
CURSOr<m>:XDELLIAIINVEISE?  ..eeeiiiii it 84
CURSOr<mM > XD E LA VA LU ? e 84
CURSOr<m>:YDELA:SLOPE? ..o 85
CURSOr<m=>:YDELLA[:VALUEL? o oo 85
CURsor<m=>:XRATIO:UNIT <UNIT> oot 85
CURSOr<m=>:XRATIO[:VALUBI? oo 85
CURSOor<m=>:YRATIO:UNIT <UNIt> oo 86
CURSOIr<mM > Y RATIO VAL LU ? oo 86
CURSor<m>:AOFF

Switches the cursor off.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Usage: Event

CURSor<m>:STATe <State>
Activates or deactivates the cursor measurement.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Parameters:
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Command Reference

ON | OFF

*RST: OFF

CURSor<m>:FUNCtion <Type>
Defines the cursor measurement type.

Suffix:

<m>

Parameters:
<Type>

1 (the numeric suffix is irrelevant)

HORizontal | VERTical | PAIRed | HRATio | VRATio | PPCount |
NPCount | RECount | FECount | MEAN | RMS | RTIMe | FTIMe |
PEAK | UPEakvalue | LPEakvalue

HORizontal
Sets two horizontal cursor lines and measures the voltages at the two
cursor positions and the delta of the two values.

VERTical

Sets two vertical cursor lines and measures the time from the trigger
point to each cursor, the time between the two cursors and the fre
quency calculated from that time.

PAIRed (V-Marker)

HRATio
Ratio of the x-values (e.g. a duty cycle) between the first and second
cursors and the first and third cursors.

VRATio

Ratio of the y-values (e.g. overshooting) between the first and second
cursors and the first and third cursors.

PPCount (Count positive pulses)

NPCount (Count negative pulses)

RECount (Count rising edges)

FECount (Count falling edges)

MEAN (Mean value)

RMS (Root mean square)

RTIMe (Rise time, t)

FTIMe (Fall time, tj)
The reference level for rise and fall time measurement is set with
REFLevel<m>:RELative:MODE.

PEAK
Absolute difference between the two peak values, Vpp.
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UPEakvalue (Upper peak value, Vp.)
LPEakvalue (Lower peak value, Vp.)

*RST: PAIR

CURSor<m>:SOURce <Source>
Defines the cursor measurement source as one of the active signal, reference or math channel.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Parameters:

<Source> NONE | CH1 | CH2 | QMA | MA1...MAb | RE1...RE4 | XY

CH1 | CH2: Active signal channels CH1 to CH2.
QMA: Active quick math channel.
MA1...MAb5: Mathematics waveform

(only with R&S®°HMO 1202 series).

RE1...RE4: Active reference channels RE1 to RE4.
XY: Active XY-waveform.
*RST: CH1

CURSor<m>:SWAVe

Autoset for cursor lines, sets the cursor lines to typical points of the waveform depending on the
selected measurement type. For example, for voltage measurement, the cursor lines are set to
the upper and lower peaks of the waveform. For time measurement, the cursor lines are set to
the edges of two consecutive positive or two consecutive negative pulses.

Usage: Event

CURSor<m>:SSCReen

Resets the cursors to their initial positions. This is helpful if the cursors have disappeared from
the display or need to be moved for a larger distance.

Usage: Event

CURSor<m>:SNPeak<n>

For FFT analysis only: sets the selected cursor to the next (right) level peak.

Usage: Event
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CURSor<m>:SPPeak<n>
For FFT analysis only: sets the selected cursor to the previous (left) level peak.
Usage: Event

CURSor<m>:TRACking[:STATe] <State>
If set to ON, the V-Marker cursor measurement is enabled.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<State> ON | OFF

*RST: OFF

CURSor<m>:X1Position <Xposition1>
Specifies the position of the first cursor on the time axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Xposition1> Default unit: s

CURSor<m>:X2Position <Xposition2>
Specifies the position of the second cursor on the time axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Xposition2> Default unit: s

CURSor<m>:X3Position <Xposition3>
Specifies the position of the third cursor on the time axis for the Ratio X measurement.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Xposition3> Default unit: s
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CURSor<m>:Y1Position <Yposition1>
Specifies the position of the first horizontal cursor on the y-axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Yposition1> Default unit: V

CURSor<m>:Y2Position <Yposition2>
Specifies the position of the second horizontal cursor on the y-axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Yposition2> Default unit: V

CURSor<m>:Y3Position <Yposition3>
Specifies the position of the third horizontal cursor on the y-axis for Ratio Y measurements.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Yposition3> Default unit: V

CURSor<m>:TRACking:SCALe[:STATe] <State>
Enables the adjustment of cursor lines if the vertical or horizontal scales are changed.

Suffix:
<m> 1 (the numeric suffix is irrelevant)
Parameters:
<State> ON | OFF
ON
Cursor lines keep their relative position to the waveform.
OFF
Cursor lines remain on their position on the display if the scaling is
changed.
*RST: OFF

SCPI Programmers Manual 83



SCPI Commands R&S®HMO1002/1202 series Remote Control

Command Reference

CURSor<m>:YCOupling <Coupling>

CURSor<m>:XCOupling <Coupling>

If enabled, the cursors of a set are coupled so that the distance between the two remains the
same if one cursor is moved.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Coupling> ON | OFF

*RST: OFF
CURSor<m>:RESult?
Returns the cursor positions.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Value> Comma-separated list

Usage: Query only
CURSor<m>:XDELta:INVerse?
Returns the inverse time difference between the two cursors (1/At).

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Deltalnverse> Default unit: 1/s

Usage: Query only
CURSor<m>:XDELta[:VALue]?
Returns the time difference between the two cursors (At).

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Delta> Default unit: s

Usage: Query only
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CURSor<m>:YDELta:SLOPe?
Returns the inverse value of the voltage difference - the reciprocal of the vertical distance of two
horizontal cursor lines: 1/AV.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<DeltyYslope> Inverse value

Usage: Query only

CURSor<m>:YDELta[:VALue]?

Returns the delta of the values in y-direction at the two cursors.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<DeltaY> Delta value in V

Usage: Query only

CURsor<m>:XRATio:UNIT <Unit>
Sets the unit for X Ratio measurements with CURSor<m>:XRATio[:VALue].

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Unit> RATio | PCT | GRD | PI

RATio: Floating value
PCT: Percent
GRD: Degree
PI: Radian

CURSor<m>:XRATio[:VALue]?
Returns the ratio of the x-values (e.g. a duty cycle) between the first and second cursors and the
first and third cursors: (x2-x1)/(x3-x1). Set the unit of the result with CURsor<m>:XRATio:UNIT.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only
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CURSor<m>:YRATio:UNIT <Unit>
Sets the unit for Y Ratio measurements with CURSor<m>:YRATio[:VALue].

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Unit> RATio | PCT

RATio: Floating value
PCT:  Percent

CURSor<m>:YRATio[:VALue]?

Provides three cursors and measures the ratio of the y-values (e.g. overshooting) between the
first and second cursors and the first and third cursors: (y2-y1)/(y3-y1). Set the unit of the result
with CURSor<m>:YRATio:UNIT.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only
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2.5.2 Automatic Measurements

MEASUremMent<mM> AOFF e 87
MEASUremMent<mM>IAON et 87
MEASUrement<m>:ARESU? ..o 87
MEASuUrement<m>[ENABIE] <State> ..o 88
MEASurement<m=>:SOURce <SignalSource>[,<ReferenceSource>] .........cccccccovviiiviiiieenn.. 88
MEASUremMEeNnt<mM>:ICATEGONY?  ooriiiiiiiiict e e e e e et e e e e et breaa s 89
REFLevel<m>:RELative:MODE <RelativeMode> .........ccccoiiiiiiiiiiiiiiiiiiiee e 89
MEASuUrement<m>:MAIN <MEASTYPE>  ..oiiiiiiiiiiiiiiie e 90
MEASurement<m>:RESUIt? [<MEaSTYPE>] .iiiiiiiiiiiiii e 92
MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope> .........cccccoeeviiiiviiiiiinnnnn. 92
MEASurement<m>:AOFF

Stops the quick measurement.

Suffix:

<m> 1..6 (the numeric suffix is irrelevant)
Usage: Event

MEASurement<m>:AON

Starts the quick measurement.

Suffix:
<m> 1..6 (the numeric suffix is irrelevant)
Usage: Event

MEASurement<m>:ARESult?
Returns the results of the quick measurement.

Suffix:
<m> 1.6
Selects the measurement.

Return values:

<QuickMeasData> List of values
Quick measurement results are listed in the following order:
PEAK, UPE, LPE, CYCR, CYCM, PER, FREQ, RTIM , FTIM

Usage: Query only
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MEASurement<m>[:ENABIle] <State>
Activates or deactivates the selected measurement (1-6). Only the results of active measure-
ments are displayed in the result table.

Suffix:
<m> 1.6
Selects the measurement.
Parameters:
<State> ON | OFF

*RST: OFF

MEASurement<m>:SOURce <SignalSource>[,<ReferenceSource>]
Selects one of the active signal, reference or math channels as the source of the selected

measurement.

Suffix:

<m> 1.6

Parameters:

<SignalSource> NONE | CH1...CH2 | QMA | MA1...MAb | RE1...RE4 | POD | DO..7 |

TRIGger | EXTern
*RST: CH1

<ReferenceSource> NONE | CH1...CH2 | QMA | MA1...MA5 | RE1...RE4 | POD | DO..7 |
TRIGger | EXTern

CH1 | CH2: Active signal channels 1 to 2.

QMA: Active quick math channel QMA.

MA1...MA5: Active math channels MAT to MAb
(only with R&S®HMO1202 series).

RE1...RE4: Active reference channels RE1 to RE4.

POD: Active logic POD.

DO...D7: Active digital channels DO to D7.

TRIGger: TRIG is returned, if the measurement type is a trigger
measurement source (TFRequency, TPERiode).

EXTern: Active external signal.

e
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MEASurement<m>:CATegory?
Returns the measurement category.

Suffix:
<m> 1.6

Selects the measurement.

Return values:

<Category> AMPTime | SPECtrum
AMPtime: Yt-measurements
SPECtrum: Spectrum measurements
*RST: AMPT

Usage: Query only

REFLevel<m>:RELative:MODE <RelativeMode>
Sets the lower and upper reference levels for rise and fall time mesurements (cursor and auto-
matic mesurements), defined as percentages of the high signal level.

Suffix:
<m> 1.5
Measurement to which the reference level belongs.
Suffix 1...4 assign the measurement places 1 to 4 (auto measure).
Suffix 5 assigns the cursor mesurement.
Parameters:
<RelativeMode> TEN | TWENty
TEN: 10/90%
TWENty: 20/80%
*RST:  TEN
Example: REFL2:REL:MODE TWENty

MEAS2:MAIN RTIM

Sets the reference level for measurement place 2 and measures the rise
time between these levels:

Lower reference level = 20% of high signal level

Upper reference level = 80% of high signal level
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MEASurement<m>:MAIN <MeasType>
Defines the measurement type to be performed on the selected source. To query the results, use
MEASurement<m=>:RESult.

Suffix:

<m>

Parameters:
<MeasType>

1.6
Selects the measurement type.

FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue | PPCount |
NPCount | RECount | FECount | HIGH | LOW | AMPLitude | CRESt |
MEAN | RMS | RTIMe | FTIMe | PDCYcle | NDCYcle | PPWidth |
NPWidth | CYCMean | CYCRms | STDDev | TFRequency | TPERiode |
DELay | PHASe | BWIDth | POVershoot | NOVershoot |

FREQuency

Frequency of the signal. The result is based on the length of the left-
most signal period within the displayed section of the waveform of the
selected channel.

PERiod
Length of the left-most signal period within the displayed section of the
waveform of the selected channel.

PEAK
Peak-to-peak value within the displayed section of the waveform of the
selected channel.

UPEakvalue
Maximum value within the displayed section of the waveform of the
selected channel.

LPEakvalue
Minimum value within the displayed section of the waveform of the
selected channel.

PPCount (Counts positive pulses)
NPCount (Counts negative pulses)

RECount
Counts the number of rising edges.

FECount
Counts the number of falling edges.

HIGH
Mean value of the high level of a square wave.
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LOW
Mean value of the low level of a square wave.

AMPLitude
Amplitude of a square wave.

CRESt
The crest factor (peak-to-average ratio) is calculated from the maximum
value divided by the RMS value of the waveform (Crest).

MEAN
Mean value of complete displayed waveform of the selected channel.

RMS
RMS (Root Mean Square) value of the voltage of the complete
displayed waveform of the selected channel.

RTIMe | FTIMe

Rise or falling time of the left-most rising edge within the displayed
section of the waveform of the selected channel. The reference level for
this mesurement is set with REFLevel<m>:RELative:MODE.

PDCycle | NDCycle

Measure the positive or negative duty cycle.
PPWidth | NPWidth

Measure the width of positive or negative pulses.

CYCMean
Mean value of the left-most signal period of the waveform of the
selected channel.

CYCRms
RMS (Root Mean Square) value of the voltage of the left-most signal
period of the waveform of the selected channel.

STDDev
Measures the standard deviation of the waveform.

TFRequency
Measures the frequency of the trigger signal based on the length of its
period.

TPERiode
Measures the length of the trigger signal periods (hardware counter).

Delay

Time difference between two edges of the same or different wave
forms. The waveforms are selected with MEASurement<m=>:SOURce,
and the edges with MEASurement<m>:DELay:SLOPe.
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Phase
Phase difference between two waveforms [(time difference/period) x 360].

BWIDth
Duration of one burst, measured from the first edge to the last.

POVershoot
Measures the positive overshoot of the waveform.

NOVershoot
Measures the negative overshoot (undershoot) of the waveform.

The waveforms are selected with MEASurement<m>:SOURCce.

*RST: NONE (measurement is off)

MEASurement<m>:RESult? [<MeasType>]
Returns the result of the specified measurement type.

Suffix:
<m> 1.6
Selects the measurement type.

Return values:
<Value> Measurement result

Query Parameters:

<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue | PPCount |
NPCount | RECount | FECount | HIGH | LOW | AMPLitude | CRES |
MEAN | RMS | RTIMe | FTIMe | PDCYcle | NDCYcle | PPWidth |
NPWidth | CYCMean | CYCRms | STDDev | TFRequency | TPERiode |
DELay | PHASe | BWIDth | POVershoot | NOVershoot |

Specifies the measurement type (see MEASurement<m=>:MAIN).
Usage: Query only
MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope>

Sets the edges to be used for delay measurement. The associated waveforms are defined with
MEASurement<m>:SOURCce.

Parameters:
<SignalSlope> POSitive | NEGative

Slope of source 1 (first waveform)
<ReferenceSlope> POSitive | NEGative

Slope of source 2 (second waveform)

*RST: POS
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2.6 Quickmath, Math Formularies and Reference Waveforms

2.6.1

BT I O T o g a'a =1 o TR 93
2.6.2 Mathematics (only with R&RSPHMOT202 SErIES)  .iivviieiiiieiieee e 97
2.6.3 Reference WavefOrMS oo e 105
Quickmath

This chapter describes commands that configure or perform basic math functions using Quick-
math.

CALCulate:QMATNISTATE <STATE>  ooiiiiiiiiie e 93
CALCulate:QMATNISOURCE <IM> oo 93
CALCulate:OMATh:OPERALION <OPEIratiON=  ...uvueiiiiiiieieiiiiieeeieieieieiseeseeeeeseeessseessesssssnssreseesnnnnannes 94
CALCUIATEIQMATNISCALE oottt et e e e e e st e e e e e e e stabaaaae s 94
CALCUIate:QMATNIPOSIHION oottt e e e e e e e e e eaaaarea s 94
CALCUIATE AN AT N DA A ? et e e e et 94
CALCulate:QMATIDATAIHEADEI? oot 95
CALCulate:QMATh:DATAIXINCIEMENT? oot 95
CALCUlate:QMATH:DATAIXORIGIN? ettt ettt ettt et e nnae e seneeaneee e 95
CALCulate:OMATH:DATAYINCIEMENT? oottt eaeassnansasnsnessnsnnnees 95
CALCulate:QMATHDATAIYORIGIN? oottt e e et e e e e e eteaaeeeee s 96
CALCulate:QMATh:DATAIYRESOIUTION? it 96

CALCulate:QMATh:STATe <State>

Defines whether the Quickmath waveform is active or not. Only if a channel is active it is visible
on the screen and can be selected as a source for analysis and display functions. Quickmath is
only available in YT and Zoom mode.

Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:QMATh:SOURce <m>
Defines the source of the Quickmath waveform.

Parameters:
<m> 1,2
Selects the source.
<Source> CH1| CH2
Example: CALC.QMAT:SOUR1 CH2

*RST: 1
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CALCulate:QMATh:OPERation <Operation>
Defines the operation of the Quickmath waveform.

Parameters:
<Qperation> ADD | SUB | MUL | DIV
Example: CALC:QMAT:OPER ADD

CALC:QMAT:OPER SUB
CALC:QMAT:OPER MUL
CALC:QMAT:OPER DIV

*RST: ADD
CALCulate:QMATh:SCALe
Sets the vertical scale for the Quickmath waveform.
Parameters:
<Scale> Range: -1.0E-24 to 5.0E+25
Scale value, given in Volts per division.
*RST: 1
CALCulate:QMATh:POSition

Sets the vertical position of the Quickmath waveform in the window.

Parameters:
<Position> Position value, given in divisions.

*RST: 0
CALCulate:QMATh:DATA?
Returns the data of the quick math waveform. The waveform data can be used in MATHLAB, for

example. To set the export format, use FORMat[:DATA].

Return values:
<Data> List of values according to the format settings.

Usage: Query only
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CALCulate:QMATh:DATA:HEADer?
Returns information on the quick math waveform.

Position | Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStopin's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval, usually 1. 1

Table 2.1: Header data

Return values:

<DataHeader> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only

CALCulate:QMATh:DATA:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mand is relevant for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Xincrement> Timeins

Usage: Query only
CALCulate:QMATh:DATA:XORigin?
Returns the time of the first sample of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Xorigin> Timeins

Usage: Query only
CALCulate:QMATh:DATA:YINCrement?
Returns the voltage value per bit of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Yincrement> Voltage in V

Usage: Query only
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CALCulate:QMATh:DATA:YORIigin?
Returns the voltage value for binary value 0 of the indicated waveform. The command is relevant
for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Yorigin> Voltage in V

Usage: Query only

CALCulate:QMATh:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform. The commmand is relevant for data
conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.

If high resolution, average or filter are set, the resolution is 16 bit.

Usage: Query only
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2.6.2 Mathematics (only with R&S®HMO1202 series)

CALCulate:MATH<M>:STATE <STATE>  .oiiiiiiiii ittt e et e e 97
CALCulate:MATH<M>:SCALE <SCAIE>  .eviiiiiiii e 97
CALCulate:MATH<mM>:POSItion <POSItION> ... 98
CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplEXpr>  .....ooooiiiiiiiiiiiieeeeieee 98
CALCUIATE M ATH M > D AT A ? ettt e e e et e e e e e e etaaaeaae s 99
CALCulate:MATH<M>:DATAIHEADEI? oottt 99
CALCulate:MATH<mM>:LABeEl <Label> ..o, 100
CALCulate:MATH<mM>:LABEL:STATE <StAte>  1ooiiiiiiiiiie ettt 100
CALCulate:MATH<mM>:DATAIENVEIOPE?  ..oeeeiiiiiee e 100
CALCulate:MATH<m>:DATA:ENVelope:HEADEI?  .....ooiie e 101
CALCulate:MATH<m>:DATA:ENVelope: XINCrement? ... 101
CALCulate:MATH<mM>:DATA:ENVelope: XORIGIN?  oiiiiiiiieiieiie e 101
CALCulate:MATH<mM>:DATA:ENVelope:YINCrement? ......oooiciiiiieiiiiiiiiieeee e 102
CALCulate:MATH<m>:DATA:ENVelope:YORIGIN? ..o, 102
CALCulate:MATH<m>:DATA:ENVelope:YRESOIUtION? ..ot 102
CALCulate:MATH<mM>:DATAXINCIEMENT? ..o 103
CALCulate:MATH<mM>:DATAXORIGIN?  1oiiiiiiiieeet et 103
CALCulate:MATH<mM>:DATAYINCIremMENt?  ..oooiiiiiiieeeeeee e 103
CALCulate:MATH<M>:DATAYORIGIN? 1ottt 104
CALCulate:MATH<mM>:DATAYRESOIUTION? oottt 104

CALCulate:MATH<m>:STATe <State>
Defines whether the selected mathematical channel is active or not. Only if a channel is active it
is visible on the screen and can be selected as a source for analysis and display functions.

Suffix:
<m> 1.5
Selects the math waveform.
Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:MATH<m>:SCALe <Scale>
Sets the vertical scale for the specified math waveform.

Suffix:
<m> 1.5
Selects the math waveform.
Parameters:
<Scale> Range: -1.0E-24 to 5.0E+25

Scale value, given in Volts per division.

*RST: 1
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CALCulate:MATH<m>:POSition <Position>
Sets the vertical position of the specified math waveform in the window.

Suffix:
<m> 1..5
Selects the math waveform.
Parameters:
<Position> Position value, given in divisions.

*RST: 0

CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplExpr>
Defines the equation to be calculated for the selected math channel as a regular expression.

Suffix:
<m> 1..5

Selects the math waveform.
Parameters:

<RemComplExpr> String with regular expression

Example: Multiplication CALC:MATH1:EXPR:DEF “MUL(CH1,CH2)"

Integral CALC:MATH2:EXPR:DEF “INT(MA1)"
IR low pass CALC:MATH3:EXPR:DEF “IIRL(MAZ2,1E6)"
The mathematical expression is a string parameter, consisting of a key-
word which represents the math function, followed by the respective
sources. These may be separated by comma and written in brackets.
A query of the math function always returns the string, which is listed
under string expression.

Function ExpressionString Comment

Addition “ADD(CH1,CH2)" Alternative “CH1+CH2"

Subtraction “SUB(CH1,CH2)" Alternative “CH1-CH2"

Multiplication “MUL(CH1,CH2)” Alternative “CH1*CH2"

Division “DIV(CH1,CH2)" Alternative “CH1/CH2"

Max. amplitude “MAX(CH1,CH2)"

Min. amplitude “MIN(CH1,CH2)”

Square “SQR(CH1)”

Square root “SQRT(CH1)”

Absolute value “"ABS(CH1)”

Positive wave “POS(CH1)”

Negative wave “NEG(CH1)"

Reciprocal 1/x “REC(CHT)"

Inverse “INV(CH1)"

Common logarithm “"LOG(CHT™)"

Natural logarithm “LN(CH1)”

Derivative “DERI(CH1)"
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Function ExpressionString Comment

Integral “INT(CH1)”
CH1 - Source

IIR low pass “lIRL(CH1,1EB)" 1e6 — Constant, limit fre-
quency of the low pass
CH1 - Source

IIR high pass “lIRH(CH1,1EB)" 1e6 — Constant, limit fre-
quency of the high pass
FFT function of the source

FFT "FFTMAG(CH1)"
waveform

Table 2.4: Math expression

CALCulate:MATH<m>:DATA?
Returns the data of the math waveform. To set the export format, use FORMat[:DATA].

Suffix:
<m> 1..5

Selects the math waveform.

Return values:
<Data> List of values depending on defined data format.

Usage: Query only

CALCulate:MATH<m>:DATA:HEADer?
Returns information on the math waveform.

Position Meaning Example

1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Table 2.5: Header data
Suffix:
<m> 1..5

Selects the math waveform.

Return values:

<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only
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CALCulate:MATH<m>:LABel <Label>
Sets the label for the math waveform.

Suffix:
<m> 1..b

Selects the math waveform.
Parameters:
<lLabel> String value

“xxxxxxxx" (maximum 8 characters)
Example: .Power”

CH1=Voltage
CH2=Current
CH1*CH2=POWER

CALCulate:MATH<m>:LABel:STATe <State>
Switches the label of the math channel on or off.

Suffix:
<m> 1.5
Selects the math waveform.
Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:MATH<m>:DATA:ENVelope?
Returns the math data of the envelope.

Suffix:
<m> 1.5

Selects the math waveform.

Return values:
<Data> List of values

Usage: Query only
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CALCulate:MATH<m>:DATA:ENVelope:HEADer?
Returns information of the math data envelope.

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Header> String data

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:XINCrement?

Returns the time difference between two adjacent samples of the indicated waveform of the
envelope. The commands are relevant for data conversion, if binary data format is defined
(FORM UINT, 8 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Xincrement> <Numeric Value>

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:XORigin?

Returns the time of the first sample of the indicated waveform of the envelope. The commands
are relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:

<m> 1.5

Selects the math waveform.

Return values:
<Xorigin> <Numeric_Value>

Usage: Query only

e
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CALCulate:MATH<m>:DATA:ENVelope:YINCrement?
Returns the voltage value per bit of the indicated waveform of the envelope. The commands are
relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Yincrement> <Numeric_Value>

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform of the envelope. The com-
mands are relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Yorigin> <Numeric_Value>

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:YRESolution?

Returns the vertical bit resolution of the indicated waveform of the envelope. The commands are
relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:

<m> 1.5

Selects the math waveform.

Return values:
<Yresolution> <Numeric_Value>

Usage: Query only
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CALCulate:MATH<m>:DATA:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mands are relevant for data conversion if binary data format is defined (FORM UINT, 8| 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Xincrement> Time in's

Usage: Query only

CALCulate:MATH<m>:DATA:XORigin?
Returns the time of the first sample of the indicated waveform. The commands are relevant for
data conversion if binary data format is defined (FORM UINT, 8| 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Xorigin> Timeins

Usage: Query only

CALCulate:MATH<m>:DATA:YINCrement?

Returns the voltage value per bit of the indicated waveform. The commands are relevant for data
conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:

<m> 1..5

Selects the math waveform.

Return values:
<Yincrement> Voltage in V

Usage: Query only

e
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CALCulate:MATH<m>:DATA:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform. The commands are rele-
vant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.5

Selects the math waveform.

Return values:
<Yorigin> Voltage in V

Usage: Query only

CALCulate:MATH<m>:DATA:YRESolution?
Returns the vertical bit resolution of the indicated waveform. The commands are relevant for
data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.5

Selects the math waveform.

Return values:
<Yresolution> For default waveforms, the resolution is 16 bit.

Usage: Query only
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2.6.3 Reference Waveforms

REFCUINVESIMS ISTATE oot 105
REFCUrve<m>:SOURCE <SOUICES oottt 105
REFCurve<m>:SOURCE:CATAIOG?  ..iiiiiieieiii ettt 106
REFCUNVE<M>IUPDALE ..o oo 106
REFCurve<m>:SAVE <FileNamME> ... oo 106
REFCurve<m>:LOAD <FIleNAME> ..ot 106
REFCUNVE<mM>LOADISTATE oot e 107
REFCurve<m>:HORIizontal:SCALE <SCale> ..o 107
REFCurve<m>:HORizontal:POSition <POSItION>  ......coiiiiiiiiiiieee e 107
REFCurve<m>:VERTICal:SCALE <SCale>  ..oooiiiiiiee e 107
REFCurve<m>:VERTical:POSition <POSItION>  ..ociiiiiiii e 108
REFCUNE M S I DATA? et 108
REFCUrVE<mM>:DATAIHEADEI? oo e 108
REFCurve<m>:DATAXINCIEMENT? oot 109
REFCurve<m>:DATAXORIGIN? ..ot 109
REFCuUrve<m>:DATA:YINCIEMENT? oottt e 109
REFCUrVe<m > DATAINYORIGIN? ittt ettt e 110
REFCurve<m>:DATA:YRESOIULION? o oo 110
REFCurve<m>:STATe

Displays or hides the selected reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<State> ON | OFF

*RST: OFF

REFCurve<m>:SOURce <Source>
Defines the source of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Source> CH1|CH2 | POD | QMA | MAT...MAb5 | RE1...RE4

CH1 | CH2: Signal channels 1 to 2.
POD: Logic POD.
QMA: Quick math channel.
MA1...MAb: Math channels 1 to b

(only with R&S®HMO1202 series).
RE1...RE4: Reference channels 1 to 4.

*RST: CH1
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REFCurve<m>:SOURce:CATalog?
Returns the source waveform - channel, math or reference waveform.

Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.

Return values:
<Catalog> CH1 | CH2 | POD | QMA | MA1...MA5G | RE1...RE4

Usage: Query only

REFCurve<m>:UPDate
Updates the selected reference by the waveform defined with REFCurve<m>:SOURce.

Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.
Usage: Event

REFCurve<m>:SAVE <FileName>
Stores the reference waveform the specified file.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Setting Parameters:
<FileName> String with path and file name

Usage: Setting only

REFCurve<m>:LOAD <FileName>

Loads the waveform data from the indicated reference file to the reference storage. To load the
instrument settings, use REFCurve<m>:LOAD:STATe.

Suffix:

<m> 1.4

Selects the reference waveform, the internal reference storage.

Setting Parameters:
<FileName> String with path and file name

Usage: Setting only
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REFCurve<m>:LOAD:STATe

Loads the instrument settings in addition to the reference waveform data. The waveform data
must be loaded before the settings, see REFCurve<m>:LOAD. The settings are only available
if the file was stored to the internal storage /INT/REFERENCE and never written to an external
storage (USB stick).

Suffix:
<m> 1.4

Selects the reference waveform.
Usage: Event

REFCurve<m>:HORizontal:SCALe <Scale>
Changes the horizontal scale (timebase) of the reference waveform independent of the channel
waveform settings.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Scale> Default unit: s/div

REFCurve<m>:HORizontal:POSition <Position>
Changes the horizontal position of the reference waveform independent of the channel wave-
form settings.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Position> Default unit: s

REFCurve<m>:VERTical:SCALe <Scale>
Changes the vertical scale of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Scale> Default unit: V/div

SCPI Programmers Manual 107



SCPI Commands R&S®HMO1002/1202 series Remote Control

Command Reference

REFCurve<m>:VERTical:POSition <Position>
Changes the vertical position of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Position> Default unit: div

REFCurve<m>:DATA?
Returns the data of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Data> Comma-separated value list

Usage: Query only

REFCurve<m>:DATA:HEADer?
Returns information on the reference waveform.

Position Meaning Example
1 XStart in s -9.477E-008 = - 94,77 ns
2 XStop in s 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval, usually 1. 1

Table 2.4: Header data

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only
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REFCurve<m>:DATA:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mands are relevant for data conversion if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Xincrement> Time in's

Usage: Query only

REFCurve<m>:DATA:XORigin?
Returns the time of the first sample of the indicated waveform. The commands are relevant for
data conversion if binary data format is defined (FORM UINT, 8| 16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Xorigin> Timeins

Usage: Query only

REFCurve<m>:DATA:YINCrement?

Returns the voltage value per bit of the indicated waveform. The commands are relevant for data
conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:

<m> 1.4

Selects the reference waveform, the internal reference storage.

Return values:
<Yincrement> Voltage in V

Usage: Query only

e
SCPI Programmers Manual 109



Command Reference

REFCurve<m>:DATA:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform. The commands are rele-
vant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.

Return values:
<Yorigin> Voltage in V

Usage: Query only

REFCurve<m>:DATA:YRESolution?
Returns the vertical bit resolution of the indicated waveform. The commands are relevant for
data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit. Its resolution is

depending on the source waveform. The maximum is 16 bit.

Usage: Query only
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2.7 FFT
CALCulate:MATH<m>:ARIThmetics <ArthmetiCS> .......cccciiiiiiiiiii e 111
CALCulate:MATH<m>:FFT:AVERage:COUNL ..o 112
CALCulate:MATH<mM>:FFT:MAGNItUude:SCALE ..o 112
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJuSted?  ........evveieiiiiieiiiiiiiiiiiiiiiiiiiens 112
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]: AUTO <SpanRBWCoupling> .............. 113
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBWRatio> ..................... 113
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <ResolutionBW> ................. 113
CALCulate:MATH<m>:FFT:CFRequency <CenterFreqs> .....ccooviiiiiiiiiiiiieeececcee e 113
CALCulate:MATH<M>FFTIFULLSPAN oo 113
CALCulate:MATH<mM>:FFT:SPAN <FreqSpan=> . ..o 14
CALCulate:MATH<mM>:FFT:STARt <StartFreq> ..o 14
CALCulate:MATH<mM>:FFT:STOP <StOPFIE>  .orriiiiiiiiiieiiiiiiieieieeeee e 114
CALCulate:MATH<mM>:FFT:WINDow:TYPE <WINdOWTYPE> ....viviiiiiiiiiiiiiiieeeiieiiiiee e 114
CALCulate:MATH<m>:FFT:TIME:RANGe <Window_Width> ........ccccoiiiiiiiiiiiii 115
CALCulate:MATH<m>:FFT:TIME:POSition <Window_Position> .......cccccciiiiiiiiiiiieceeecc 115
CALCulate:MATH<m>:FFT:SRATe? <Sample_Rate> ......ccccoiiiiiiiiiiiiieeeceeeee 115
CALCulate:MATH<m>:FFT:TIME:POSition <Window_Width> ... 116
CALCulate:MATH<m>:FFT:TIME:Range <Window_Position> ........cccociiiiiiiiiiiee e 116

CALCulate:MATH<m>:ARIThmetics <Arithmetics>
Defines the mode for FFT calculation and display.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Arithmetics> OFF | ENVelope | AVERage

OFF

The FFT is performed without any additional weighting or postproces
sing of the acquired data. The new input data is acquired and displayed,
and thus overwrites the previously saved and displayed data.

ENVelope

In addition to the normal spectrum, the maximal oscillations are saved
separately and updated for each new spectrum. The maximum values
are displayed together with the newly acquired values and form an
envelope. This envelope indicates the range of all FFT trace values that
occurred.

AVERage

The average of several spectrums is calculated. The number of spec-
trums used for the averaging is defined using the command. This mode
is useful for noise rejection.

*RST: OFF
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CALCulate:MATH<m>:FFT:AVERage:COUNt
Defines the number of spectrums used for averaging if CALCulate:MATH<m>:ARIThmetics is set

to AVERage.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<AverageCount> Integer value

Range: 2 to 512

*RST: 2
CALCulate:MATH<m>:FFT:MAGNitude:SCALe
Defines the scaling of the y-axis.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Parameters:
<Magnitude Scale> LINear | DBM | DBV

LINear: Linear scaling; displays the RMS value of the voltage.
DBM: Logarithmic scaling; related to T mW

DBV: Logarithmic scaling; related to 1 Veff

*RST: DBM

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJusted?
Returns the effective resolution bandwidth.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<AdjResBW> Range: -100E+24 to 100E+24
Default unit: Hz

*RST: 1.525E+3

Usage: Query only
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CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:AUTO <SpanRBWCoupling>
Couples the frequency span to the RBW.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Parameters:

<SpanRBWCoupling> ON | OFF

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBWRatio>
Defines the ratio resolution bandwidth (Hz) / span (Hz).

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<SpanRBWRatio> Range: 2048 to 131072

*RST: 4096

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <ResolutionBW>
Defines the resolution bandwidth.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<ResolutionBW> Default unit: Hz

CALCulate:MATH<m>:FFT:CFRequency <CenterFreq>
Defines the position of the displayed frequency domain, which is (Center - Span/2) to (Center +
Span/2). The width of the domain is defined using the CALCulate:MATH<m>:FFT:SPAN com-

mand.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<CenterFreq> Default unit: Hz

CALCulate:MATH<m>:FFT:FULLspan
Performs FFT calculation for the full frequency span.

Suffix:
<m> 1 (the numeric suffix is irrelevant)
Usage: Event
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CALCulate:MATH<m>:FFT:SPAN <FreqSpan>

The span is specified in Hertz and defines the width of the displayed frequency range, which is
(Center - Span/2) to (Center + Span/2). The position of the span is defined using the CALCulate:
MATH<m>:FFT:CFRequency command.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<FreqSpan> Default unit: Hz

CALCulate:MATH<m>:FFT:STARt <StartFreq>
Defines the start frequency of the displayed frequency domain (instead of defining a center
frequency and span).

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<StartFreq> Default unit: Hz

CALCulate:MATH<m>:FFT:STOP <StopFreq>
Defines the stop frequency of the displayed frequency domain (instead of defining a center
frequency and span).

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<StopFreq> Default unit: Hz

CALCulate:MATH<m>:FFT:WINDow:TYPE <WindowType>
Window functions are multiplied with the input values and thus can improve the FFT display.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Parameters:

<WindowType> RECTangular | HAMMing | HANNing | BLACkmanharris

RECTangular

The rectangular window multiplies all points by one. The result is a high
frequency accuracy with thin spectral lines, but also with increased noi-
se. Use this function preferably with pulse response tests where start
and end values are zero.
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HAMMing

The Hamming window is bell shaped. Its value is not zero at the bor-
ders of the measuring interval. Thus, the noise level inside the spectrum
is higher than Hanning or Blackman, but smaller than the rectangular
window. The width of the spectral lines is thinner than the other bell-
shaped functions. Use this window to measure amplitudes of a periodi-
cal signal precisely.

HANNing

The Hanning window is bell shaped. Unlike the Hamming windowy, its
value is zero at the borders of the measuring interval. Thus, the noise
level within the spectrum is reduced and the width of the spectral lines
enlarges. Use this window to measure amplitudes of a periodical signal
precisely.

BLACkmanharris

The Blackman window is bell shaped and has the steepest fall in its
wave shape of all other available functions. Its value is zero at both bor-
ders of the measuring interval. In the Blackman window the amplitudes
can be measured very precisely. However, determining the frequency is
more difficult. Use this window to measure amplitudes of a periodical
signal precisely.

*RST: HANN

CALCulate:MATH<m>:FFT:TIME:RANGe <Window_Width>
Defines the width of the time base extract from the Y(t)-window for which the FFT is calculated.

Parameters:
<Window_Width> Range: depends on the time base
Default unit: s

CALCulate:MATH<m>:FFT:TIME:POSition <Window_Position>
Defines the position of the time base extract in the Y(t)-window for which the FFT is calculated.
Parameters:

<Window_Position> Range: depends on the time base and the width of the FFT time base
Default unit: s

CALCulate:MATH<m>:FFT:SRATe? <Sample_Rate>
Returns the sample rate of data used in an FFT analysis.

Return values:
<Sample_Rate> Default unit: Sa/s

Usage: Query only

e
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CALCulate:MATH<m>:FFT:TIME:POSition <Window_Width>
Defines the position of the time base extract in the Y(t)-window for which the FFT is calculated.

Parameters:
<Window_Width> Range: depends on the time base and the width of the FFT time base
Default unit: s

CALCulate:MATH<m>:FFT:TIME:Range <Window_Position>
Defines the width of the time base extract from the Y(t)-window for which the FFT is calculated.

Parameters:
<Window_Position> Range: depends on the time base
Default unit: s
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2.8 Masks
MASKISTATE <STAE>  ooiiiiiiiiiiii e e e e 117
MASKITEST <TBSE> oot 117
MASKLOAD <FIlENAME> ..o e 118
MASK:SAVE <FIlENAME> oo 118
MASKISOURGCE SSOUICES oot 118
M ASK I CH C OPY ittt e e e e et e e e e e 118
MASK:YPOSIHION <YPOSIIONS  1oiiiiiiiiiiiiiiiieee e e e 118
MASKIYSCALE <YSCAIE> oottt 119
MASKYWIDth <Yaddition> ..o 119
MASKXWIDth <Xaddition> ..o 119
MASKICOUNT? e 119
MASKIVCOUNT? et 119
Y AN 1 G B AN 1 A SR 120
MASKIDATAIHEADEI? oo e 120
MASK:DATAXINCIEMENT? ittt e e e e et 120
MASKDATAXORIGIN? et 120
MASK:DATAIYINCIEMENT? et 121
MASKDATAIYORIGIN? ettt ettt e et e e e e et e eaeeeaaeeenaeea 121
MASKDATANYRESOIUTION oo 121
MASK:ACTION:YOUT:ENABIE <YOUT>  .ooiiiiiiiiiieiee e 121
MASK:ACTion:SOUNd:EVENt:MODE <Event_Mode> .......ccccoveiiiiiicice e 121
MASK:ACTion:STOP:EVENt:MODE <Event_Mode> .....ccccoiiiieieeeeeeee e 121
MASK:ACTion:PULSe:EVENt:MODE <Event_Mode> . .....oooiiiiiiieeceeee e 121
MASK:ACTion:SCRSave:EVENt:MODE <Event_Mode> ..o 121
MASK:ACTion:PRINt:EVENt:MODE <Event MOde> ..o 121
MASK:ACTion:WFMSave:EVENt:MODE <Event_Mode> ........cccccciiiiiiiiii 121
MASK:ACTioN:STOP:EVENTCOUNL  .oeiiiiiee e 122
MASK:ACTion:SCRSaVE:DESTINGION  .iieiiiiiiiiiiii e 122
MASK:ACTion:WFMSave:DESTINAtION  ..oiciiiiiie e 122
MASKIRESEECOUNIEE oo e e et 122

MASK:STATe <State>
Turns the mask test mode on or off. When turning off, any temporarily stored new masks are
deleted.

Parameters:
<State> ON | OFF

*RST: OFF

MASK:TEST <Test>
Starts, finishes or interrupts a mask test.

Parameters:
<Test> RUN | STOP | PAUSE

*RST: STOP
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MASK:LOAD <FileName>
Loads a stored mask from the specified file.

Setting Parameters:
<FileName> String parameter (path and file name)

Usage: Setting only
MASK:SAVE <FileName>
Saves the current mask in the specified file.

Setting Parameters:
<FileName> String parameter (path and file name)

Usage: Setting only
MASK:SOURce <Source>
Defines the channel to be compared with the mask.

Parameters:
<Source> CH1 | CH2

*RST: CH1
MASK:CHCopy
Creates a mask from the envelope waveform of the test source set with MASK:SOURce.
Usage: Event
MASK:YPOSition <Yposition>
Moves the mask vertically within the display.
Parameters:
<Yposition> Mask offset from the vertical center
Range: -200 to 200

Default unit: div

*RST: 0
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MASK:YSCALe <Yscale>
Changes the vertical scaling to stretch or compress the mask in y-direction.

Parameters:

<Yscale> A value over 100% stretches the amplitudes; a value less than 100%
compresses the amplitudes.
Range: 10 to 1000
Default unit: %

*RST: 100

MASK:YWIDth <Yaddition>
Changes the width of the mask in vertical direction.

Parameters:

<Yaddition> The value is added to the y-values of the upper mask limit and sub
tracted from the y-values of the lower mask limit.
Range: 0 to 5.12
Default unit: div

*RST: 0

MASK:XWIDth <Xaddition>
Changes the width of the mask in horizontal direction.

Parameters:

<Xaddition> The value is added to the positive x-values and subtracted from the
negative x-values of the mask limits in relation to the mask center.
Range: 0 to 10
Default unit: div

*RST: 0
MASK:COUNt?
Returns the number of tested acquisitions.

Return values:

<TotalCount> Total number of tested acquisitions
Usage: Query only
MASK:VCOunt?

Returns the number of acquistions that hit the mask.

Return values:
<ViolationCount> Acquisition count

Usage: Query only

SCPI Programmers Manual 119



SCPI Commands R&S®HMO1002/1202 series Remote Control

Command Reference

MASK:DATA?

Returns the data of the mask waveform.

Return values:
<Data> List of values

Usage: Query only

MASK:DATA:HEADer?

Returns information on the mask waveform.

Return values:

<Data_Header> Comma-separated value list
Position | Meaning Example

1 XStartin's 0.000E+00
XStop in's 5.990E+02

3 Number of Samples 600
Number of values per sample interval. 2

4 .
For envelope waveforms the value is 2.

Table 2.7: Header data

Example: 0.000E+00,5.990E+02,600,2

Usage: Query only

MASK:DATA:XINCrement?

Return the time difference between two adjacent samples of the mask waveform.

Return values:
<Xincrement> Timeins

Usage: Query only
MASK:DATA:XORigin?
Return the time of the first sample of the indicated mask waveform.

Return values:
<Xorigin> Timeins

Usage: Query only
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MASK:DATA:YINCrement?
Return the voltage value per bit of the indicated mask waveform.

Return values:
<Yincrement> Voltage in V

Usage: Query only

MASK:DATA:YORigin?
Return the voltage value for binary value 0 of the indicated mask waveform.

Return values:
<Yorigin> Voltage in V

Usage: Query only

MASK:DATA:YRESolution
Return the vertical bit resolution of the indicated waveform.

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.

Usage: Query only

MASK:ACTion:YOUT:ENABIe <Yout>
Enable or disable of pulses at the AUX-OUTput if mask is distorted.

Parameters:
<Yout> ON | OFF

*RST: OFF

MASK:ACTion:SOUNd:EVENt:MODE <Event_Mode>
MASK:ACTion:STOP:EVENt:MODE <Event_Mode>
MASK:ACTion:PULSe:EVENt:MODE <Event_Mode>
MASK:ACTion:SCRSave:EVENt:MODE <Event_Mode>
MASK:ACTion:PRINt:EVENt:MODE <Event_Mode>
MASK:ACTion:WFMSave:EVENt:MODE <Event_Mode>
Defines when and how often the action will be executed.

e SOUNd: Generates a beep sound.

e STOP: Stops the waveform acquisition.

e PULSe: Emits an impulse.

e PRINt: Prints a screenshot to a printer connected to the USB connector on the front
or rear panel.

e SCRSave: Saves a screenshot according to printer output settings.

e WFMSave: Saves the waveform data according to the screenshot output settings.
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Parameters:
<Event_Mode> OFF | EACH

OFF: No action is executed.
EACH: The selected action is executed on each violation of the mask.

*RST: OFF
MASK:ACTion:STOP:EVENt:COUNt
Sets the number of mask violations after which the action is executed.
Parameters:

<Event_Count> Integer value, number of mask violations

MASK:ACTion:SCRSave:DESTination
Defines the storage location whether the violated mask screenshot is saved. For output settings,
see chapter ,Data and File Management”.

MASK:ACTion:WFMSave:DESTination
Defines whether the violated mask trace (waveform) is printed. For output settings, see chapter
,Data and File Management”.

MASK:RESet:COUNter
Sets the counters of passed and failed acquisitions to Zero.

Usage: Event

Function Generator

GENerator:FUNCHON <FUNCHIONS  oiiiiiiie et 122
GENerator:-VOLTage <AMPIITUAE> ..o 123
GENerator:-VOLTage:OFFSet <OffSEt> oo 123
GENerator:FREQUENCY <FreqUENCY> oo 123
GENerator:FUNCtion:RAMP:POLarity <Polarity> .couuiiiiieiieeie e 123
GENerator:FUNCHION:PULSEIDCYCIE oo 123
GENerator:QUTPULLENABIE] oo 124

GENerator:FUNCtion <Function>
Selects the generator function.

Parameters:
<Function> DC | SINusoid | SQUare | PULSe | TRlangle | RAMP

*RST: SIN
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GENerator:VOLTage <Amplitude>
Defines the amplitude value (peak-peak value) of the selected generator function.

Parameters:

<Amplitude> Numeric value
Range: 6.0000E-02 to 6.00000E+00
Default unit: Vpp

*RST: 5.0000E-01

GENerator:VOLTage:OFFSet <Offset>
Sets the DC offset of the selected generator function.

Parameters:

<Offset> Numeric value
Range: -3.00000E+00 to 3.00000E+00
Default unit: V

*RST: 0.00E+00

GENerator:FREQuency <Frequency>
Defines the frequency value of the selected generator function.

Parameters:
<Frequency> Numeric value depending on the selected generator function
Range: 1.000E-01 to 5.000000000E+04 (sine / square)
1.000E-01 to 1.000000000E+04 (triangle / ramp / pulse)
Default unit: Hz

*RST: 1.00000000E+03
GENerator:FUNCtion:RAMP:POLarity <Polarity>
Sets the polarity of the generator function ramp.

Parameters:
<Polarity> POSitive | NEGative

*RST: NEG

GENerator:FUNCtion:PULSe:DCYCle
Defines the duty cycle value of the generator function pulse.

Parameters:

<DutyCycle> Numeric value
Range: 1.000E+01 to 9.000E+01
Default unit: %

*RST: 2.500E+01
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GENerator:OUTPut[:ENABIe]
Activates or deactivates the function generator output.

Parameters:
<OutputEnable> ON | OFF

*RST: OFF
Pattern Generator
PGENErator:FUNCLION  .oeeiiiiic e 124
PGENErator:PATTEINISTATE ettt e e e et e e e e e e staraaaa s 125
PGENErator:PATTEINISTIME oottt e e e et e e naeeas 125
PGENerator:PATTErN:PERIOA ..ot 126
PGENerator:PATTern:FREQUENCY  ..oooiiiieeeee e 126
PGENerator:PATTEINITIME e 126
PGENerator:PATTErn:BURSTISTATE .o 126
PGENerator:PATTErN:BURSTINCYCIE ..o 126
PGENerator:PATTern:TRIGErMODE  ....oo oo 127
PGENerator:PATTern:TRIGGEr:SINGIE  ...uvveiiiiiiiiiee e 127
PGENerator:PATTern:TRIGQer:EXTern:SLOPE . ..ocuvviiiii i 127
PGENerator:PATTern:ARBItrary:DATALSET] oo 127
PGENerator:PATTern:ARBitrary:DATAIAPPENA  ...ooiiiiiiiiieeee e 128
PGENerator:PATTern:ARBitrary:DATA:APPend:BOR ...t 128
PGENerator:PATTern:ARBitrary:DATA:APPend:BAND  ...oviiiiieeceee e 128
PGENerator:PATTern:ARBitrary: DATA:APPeNd:INDEX  ....cocouviiiiiieeieece e 128
PGENerator:PATTern:ARBitrary:DATAILENGTN .ovviiiiiiiiii e 128
PGENerator:PATTern:COUNer:FREQUENCY  ...ooiiiiiiiiieeie e 129
PGENerator:PATTern:COUNLEr:DIRECHION  ..uiiiiiiiiiiiiiie et 129
PGENerator:PATTern:SQUarewave:POLAITY  ..ooceiiiiiiieeiiieee e 129
PGENerator:PATTern:SQUarewave:DCYCIE ..o 129
PGENErator:iMANUALESTATECSS  .ooeee e 130

PGENerator:FUNCtion
Selects the pattern generator function.

Parameters:

<Function> SQUarewave | COUNter | ARBitrary | SPI| 12C | UART | CAN | LIN |
MANual
SQUarewave

Square wave function (e.g. for manual probe compensation):

COUNter
Definition of a 4 bit wide counter pattern.

ARBitrary
Definition of a 4 bit wide and 2048 samples deep pattern.
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SPI
SPI BUS signals for measurements without measurement object.
Data rate 100kBit/s, 250kBit/s or 1 MBit/s.

1c
12C BUS signals for measurements without measurement object.
Data rate 100kBit/s, 400kBit/s, 1 MBit/s or 3.4 MBit/s.

UART
UART BUS signals for measurements without measurement object.
Data rate 9600 Bit/s, 115.2kBit/s and 1 MBit/s.

CAN
CAN BUS signals for measurements without measurement object up to
50 MBit/s.

LIN
LIN BUS signals for measurements without measurement object up to
50 MBit/s.
MANual
Manual pattern mode.
PGENerator:PATTern:STATe

Activates or deactivates the pattern.

Parameters:
<State> ON | OFF

*RST: OFF

PGENerator:PATTern:STIMe
Defines the sample time of the pattern generator function.

Parameters:

<SampleTime> Numeric value
Range: 2.000E-08 to 4.200E+01
Default unit: S

*RST: 2.000E-08
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PGENerator:PATTern:PERiod
Defines the period of the pattern generator function.

Parameters:
<PatternPeriod> Numeric value (Period = Pattern length * Bit time)
Range: MIN 1Sample * 20ns = 20ns
MAX 2048 Samples * 42s = 10416s (approx. 2.89h)
Default unit: s

*RST: 2.000E-06

PGENerator:PATTern:FREQuency
Defines the frequency (period) value of the pattern generator function.

Parameters:
<PatternFrequency> Numeric value

PGENerator:PATTern:ITIMe
Defines the idle time of the pattern generator function. The idle time can be only defined with
activated BURST function.

Parameters:
<ldleTime> Numeric value
Range: 2.000E-08 to 4.200000000000E+01
*RST: 2.5000000000E-01
PGENerator:PATTern:BURSt:STATe

Turns the BURST function on or off.

Parameters:
<BurstState> ON | OFF

*RST: OFF
PGENerator:PATTern:BURSt:NCYCle
Defines the BURST pattern cycles. The cycles can be only defined with activated BURST func-
tion.
Parameters:
<PatternCycles> Numeric value

Range: 1 to 4096

*RST: 1
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PGENerator:PATTern:TRIGger:MODE
Defines the arbitrary trigger mode of the pattern generator function.

Parameters:
<TriggerMode> CONTinuous | SINGle | EXTern

CONTinuous
The CONT function (continuous trigger) issues the pattern continuously.

SINGle
If the SING setting is activated, the pattern is issued manually.

EXTern
For the EXT (external trigger) setting the pattern is issued by an edge at
the external input of the oscilloscope (TRIG.EXT.).

*RST: CONT

PGENerator:PATTern:TRIGger:SINGle
Manual output of a pattern (single trigger).

Usage: Event

PGENerator:PATTern:TRIGger:EXTern:SLOPe
Defines the slope of the external arbitrary pattern trigger.

Parameters:
<Slope> POSitive | NEGative | EITHer

POSitive
Rising edge (rise).

NEGative
Falling edge (fall).

EITHer
Rising as well as the falling edge (both).

*RST: POSitive

PGENerator:PATTern:ARBitrary:DATA[:SET]
Defines the arbitrary pattern.

Parameters:
<ArbitraryData> List of values
Example: PGEN:PATT:ARB:DATA 0,1,1,1,2,0,3,1,4,0

e
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PGENerator:PATTern:ARBitrary:DATA:APPend
Defines the arbitrary pattern.

Parameters:
<AppendData> List of Values
Example: PGEN:PATT:ARB:DATA:APP 4
From index = n the oscilloscope appends a 4 in HEX to the pattern.
Usage: Setting only

PGENerator:PATTern:ARBitrary:DATA:APPend:BOR

Parameters:

<AppendData> List of values
From index = n data will be integrated in existing pattern via OR
combination.

PGENerator:PATTern:ARBitrary:DATA:APPend:BAND

Parameters:

<AppendData> List of values
From index = n data will be integrated in existing pattern via AND
combination.

PGENerator:PATTern:ARBitrary:DATA:APPend:INDex
Defines the index of the arbitrary pattern.

Parameters:
<AppendIndex> Numeric value
Example: PGEN:PATT:ARB:DATA:APP:IND 5

PGEN:PATT:ARB:DATA:APP 4
From index = n a pattern length of 6 will be defined with last high bit 4.

PGENerator:PATTern:ARBitrary:DATA:LENGth
Defines the arbitrary pattern length.

Parameters:

<PatternLength> Numeric value

Range: 1 to 2048

*RST: 1
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PGENerator:PATTern:COUNter:FREQuency

Defines the frequency value of the pattern generator counter function. The user frequency
always refers to the switching of the pattern condition. This results in square waveforms for
individual pins.

Pin Frequency
Parameters:
S0 f12 <Period> Numeric value
S1_[f4 Range: 2.380952425301E-02 to
S2 /8 2.500000000000E+07
S3 /16

*RST: 1.000000000000E+05
PGENerator:PATTern:COUNter:DIRection
Sets the pattern generator counter direction.

Parameters:
<CountDirection> UPWard | DOWNward

*RST: UPW
PGENerator:PATTern:SQUarewave:POLarity
Defines the polarity of the pattern generator square wave function.

Parameters:
<Polarity> NORMal | INVerted

*RST: NORM

PGENerator:PATTern:SQUarewave:DCYCle

Parameters:

<DutyCycle> Numeric value
Range: 1.00E+00 to 9.900E+01
Default unit: %
*RST: 5.000E+01

Example: PGEN:PATT:SQU:DCYC 20

Sets the duty cycle of the square wave function to 20%.

e
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PGENerator:MANual:STATe<s>

Suffix:
<S> 0...3
Selects the pins SO to S3 manually.
Parameters:
<State> ON | OFF
ON: Pin state is set to high (H).
OFF: Pin state is set to low (L).
*RST: OFF
Example: PGEN:MAN:STAT2 ON

Pin state of S2 is set to high (H).

211 Digital Voltmeter

DV M > T PE o 130
DVM<MSISOURCE oot e 131
DVMIENABIE oo 131
DVM<m>:RESUREACTUAI? oo e 131
DVM <> RESU A CTUAI S TATUS? oot 132
DVM <> RESUILRESET oo 132
DVM<m>RESUILACTUAIT? oo 133
DVIMIPOSITION oot 133

DVM<m>:TYPE
Selects the measurement type of the digital voltmeter function.

Suffix:
<m> 1.2
Selects the channel resp. the secondary measurement type.
Parameters:
<MeasurementType>  MEAN | DCRMs | STDD | UPEakvalue | LPEakvalue | PEAK |
CRESt | OFF
MEAN: DC
DCRMs: RMS

STDDeviation: Standard deviation

UPEakvalue: Peak +

LPEakvalue: Peak -

PEAK: Peak peak value (Maximum-Minimum)
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CRESt: Crest factor (|X|max/Xawms)
OFF: Measurement display deactivated
Example: DVM1:TYPE PEAK

Selects the DVM type PEAK for channel 1 (CH1).

DVM<m>:SOURce
Selects the source for the digital voltmeter function.

Suffix:
<m> 1.2
Selects the channel resp. the secondary measurement type.
Parameters:
<Source> CH1 | CH2
DVM1 = primary measurement value CH1
DVM2 = secondary measurement value CH1
DVMS = primary measurement value CH2
DVM4 = secondary measurement value CH2
Example: DVM2:SOUR CH2
DVM:ENABIe

Activates or deactivates the digital voltmeter function.

Parameters:
<VoltmeterEnable> ON | OFF

*RST: OFF

DVM<m>:RESult[:ACTual]?
Returns the current value of the indicated measurement.

Suffix:
<m> 1.2
Selects the channel resp. the secondary measurement type.

Return values:
<CurrentValue> Numeric value
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Example: DVM2:SOUR CH2
DVM2:TYPE DCRM
DVM2:RES?

Response: 7.089E-01

An RMS measurement is performed on measurement place 2,
on channel 2. The result is 708,9 mV.

Usage: Query only

DVM<m>:RESult[:ACTual]:STATus?
Returns the result value and the status of the result. The status is the decimal representation of a
4-bit register value:

e Bit0 = 1:resultis valid

e Bit 1 = 1:no result available
e Bit2 = 1: clipping occurs

e Bit3 = 1: no period found

Suffix:
<m> 1.2
Selects the channel resp. the secondary measurement type.

Return values:
<ResultAndStatus> <Value>,Status

Example: DVM:SOUR CH1
DVM:TYPE MEAN
DVM:RES:STAT?

Response: 4.968E-01,5
The result value of the mean measurement on channel 1is 496.1 mV.
The result status is 5 (decimal) = 0101 (binary). That means, the result is
valid (bit 0 = 1), and the signal is clipped by the limits of the ADC range
(bit3=1).

Usage: Query only

DVM<m>:RESult:RESet
Resets the digital voltmeter function.

Suffix:
<m> 1.2

Selects the channel resp. the secondary measurement type.
Usage: Event

e
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DVM<m>:RESult[:ACTual]?

Suffix:
<m> 1.2
Selects the channel resp. the secondary measurement type.
Response:
<CurrentValue> Numeric value
Example: DVM1:RES?
Received the voltmeter value of CH1.
Usage: Query only

DVM:POSition
Selects the display position of the digital voltmeter values.

Parameters:

<Position> TLEFt | TRIGht | BLEFt | BRIGht
TLEFt: Display position top left.
TRIGht: Display position top right.
BLEFt: Display position bottom left.
BRIGht: Display position bottom right.
*RST: TLEF

212 Counter

TCOUNTErENAB <ENADIE> oo 133
TCOuNnter:RESUlt[:ACTUall:FREQUENCY?  .ooiiiiiiie et 134
TCOuUNter:RESUR[:ACTUAIPERIOA? oo e 134

TCOunter:ENAB <Enable>
Enables or disables the trigger counter measurement.

Parameters:
<Enable> ON | OFF

*RST: OFF
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Command Reference

TCOunter:RESult[:ACTual]:FREQuency?
Returns the frequency of the trigger source.

Return values:
<FrequencyValue> Default unit: Hz

Usage: Query only

TCOunter:RESult[:ACTual]:PERiod?
Returns the period of the trigger source.

Return values:
<PeriodValue> Default unit: s

Usage: Query only

Component Tester

COMPonenttest:STATe <State>  ..ooocvveieiiiiiiiiieeeeececiieee e,
COMPonenttest:FREQuency <Frequency> ........cccecuveeeeennn.

COMPonenttest:STATe <State>
Switches the compoenent tester mode on or off.

Parameters:
<State> ON | OFF

*RST: OFF

COMPonenttest:FREQuency <Frequency>

Sets the frequency of the component tester source.

Parameters:

<Frequency> F50 | F200
F50: 50Hz
F200: 200Hz



Command Reference

2.14 External input

QLT R a RSN =] USSR 135
EXTINIPOSITION oo 135
EXTEINICOUPIING ottt ettt ettt ettt ettt e ekt e et e e et e e eteeennbeeaneeennnean 135
EXTEINISIZE oo 136
EXTErn:THRESNOIA oo 136
[ Q=T 2 L o = ST PP PP RO P OPPPPPN 136
[ QL= R T AN AN U 137
EXTEIrNIDATAIPOINTS oottt e e e e e e e e et 137
EXTern:DATAHEADEI? e 138
EXTern:DATAIXINCIEMENT? ..ot 138
=T A DN AN (@ ] 1T PR UPSUSTI 138
EXTern:DATAYINCIEMENT? oo e 138
EXTerN:DATAIY ORIGIN? oottt e e e e e e e e bbbt e e e e e s e etareaaaeaas 139
EXTern:DATAIYRESOIUTION? ..o 139
EXTern[:STATe]

Activates or deactivates the external input functionality.

Parameters:

<State> ON | OFF
*RST: OFF

EXTern:POSition

Sets the vertical position of the external input signal and its horizontal axis in the window.

Parameters:
<Position> Position value, given in divisions.
Range: -4 to 4
Default unit: DIV
EXTern:COUPIling

Selects the connection of the external input signal.

Parameters:
<Coupling> DC | AC

*RST: DC
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Command Reference

EXTern:SIZE
Defines the display size of the external input signal.

Parameters:
<Size> SMALI | MEDium | LARGe

*RST: SMAL

EXTern:THReshold

Defines the threshold level. If the signal value is higher than the threshold, the signal state is
high (1 or true for the boolean logic). Otherwise, the signal state is considered low (0 or false), if
the signal value is below the threshold.

Parameters:

<Threshold> Range: -5.49 to 5.49
Default unit: V
*RST: 4.90E-01

EXTern:TYPE

Selects the method to reduce the data stream of the ADC to a stream of waveform points with
lower sample rate.

Parameters:
<DecimationMode> SAMPIe | PDETect | HRESolution

SAMPle
Input data is acquired with a sample rate which is aligned to the time
base (horizontal scale) and the record length.

PDETect
The minimum and the maximum of n samples in a sample interval are
recorded as waveform points (Peak Detect).

HRESolution
The average of n sample points is recorded as waveform point
(High Resolution).

*RST: SAMP
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Command Reference

EXTern:DATA?
Returns the data of the external input signal waveform. To set the export format, use
FORMat[:DATA]. To set the range of samples to be returned, use EXTern:DATA:POINts.

Return values:
<Data> List of values according to the format settings - the voltages of
recorded waveform samples.

Usage: Query only

EXTern:DATA:POINts

As a setting, the command selects a range of samples. As a query, it returns the number of
samples for the selected range. To get correct results with settings MAX and DMAX, the acqui-
sition must not run when the command is used. To acquire consistent and valid data, use the
SINGle command before. Do not cancel a running acquisition with STOP because the waveform
data might be incomplete or incorrect.

Return values:
<Points> Number of data points in the selected range (samples).

Setting Parameters:
<Points> DEFault | MAXimum | DMAXimum
Sets the range for the query.

DEFault
Waveform samples displayed on the screen.

MAXimum
Range is the complete memory (only available with maximum sample
rate and STOP mode).

The entire oscilloscope memory can only be read out in STOP mode if the maximum
sampling has been activated in the ACQUIRE menu.

DMAXimum (Display Maximum)
Number of samples in the current waveform record.

Example: EXT:DATA:POIN MAX
EXT:DATA:POIN?
Suffix: 20000

e
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Command Reference

EXTern:DATA:HEADer?
Returns information on the external input signal waveform.

Position | Meaning Example
1 XStartin's -9.477E-008 = - 94,77 ns
2 XStopin's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 20000
4 Number of values per sample interval, usually 1. 1

Table 2.1: Header data

Return values:

<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,20000, 1
Usage: Query only

EXTern:DATA:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mand is relevant for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Xincrement> Timeins

Usage: Query only
EXTern:DATA:XORigin?
Returns the time of the first sample of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Xorigin> Timeins

Usage: Query only
EXTern:DATA:YINCrement?
Returns the voltage value per bit of the indicated waveform. The command is relevant for data

conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Yincrement> Voltage in V

Usage: Query only
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2.151

Command Reference

EXTern:DATA:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform. The command is relevant
for data conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Yorigin> Voltage in V

Usage: Query only

EXTern:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform. The command is relevant for data
conversion, if binary data format is defined (FORM UINT,8|16|32).

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.

If high resolution, average or filter are set, the resolution is 16 bit.

Usage: Query only

Protocol Analysis

2050 GENEIAL oo 139
2.15.2 Parallel / Parallel ClOCKEd BUS  ...ooeiiiiieee e, 142
2. 00,8 SPI BUS i e et 145
2. 00,4 SSPI BUS i 163
2155 12C BUS  woveoveeceececece e 155
2. 0D B A R T e e 166
2. 0D, 7 CAN e 172
2. 0D 8 LN o e 184
General

BUS<D>ISTATE <SIAtE> oottt 139
BUS <> TYPE <TYDE> oo 140
BUS<b>FORMAt <FOIMMAts>  oieiiiiiiiiiiee e 140
BUS<b>:DSIZe <DISplaySIiZe> ..o 140
BUS<b>:DSIGNals <BItSSIgNalS> .iiiiiiiiiiiiiiie e 141
BUS<b>:POSIHION <POSITION™  ..iiiiiiiiiiiiiiice e 141
BUS<bh>:LABEl <Label> oo 141
BUS<b>:LABELSTATE <STAte> oottt 141

BUS<b>:STATe <State>
Switches the protocol display on or off.

Suffix:
<b> 1,2
Selects the bus.



Command Reference

Parameters:
<State> ON | OFF

*RST: OFF

BUS<b>:TYPE <Type>
Defines the bus or interface type for analysis. For most types, a special option to the instrument

is required.
Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Type> PARallel | CPARallel | 12C | SPI'| SSPI | UART | CAN | LIN

*RST: PAR

BUS<b>:FORMat <Format>
Sets the decoding format for the display on the screen.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Format> ASCii | HEXadecimal | BINary | DECimal

*RST: HEX

BUS<b>:DSIZe <DisplaySize>
Sets the height of the decoded bus signal on the sreen.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<DisplaySize> SMALI | MEDium | LARGe

*RST: MED



Command Reference

BUS<b>:DSIGnals <BitsSignals>
Displays the individual bit lines above the decoded bus line.

Suffix:
<b>

Parameters:
<BitsSignals>

1,2
Selects the bus.

ON | OFF

*RST: ON

BUS<b>:POSition <Position>
Sets the vertical position of the decoded bus signal in divisions on the sreen.

Suffix:

<b>

Parameters:
<Position>

1,2
Selects the bus.

Range: -4.0000E+00 to 4.0000E+00
Default unit: div

*RST: 1.0000E+00

BUS<b>:LABel <Label>
Sets the label for the Bus.

Suffix:
<b>

Parameters:
<Label>

"

1,2
Selects the bus.

String value
XXXXXXXX" (maximum 8 characters)

BUS<b>:LABel:STATe <State>
Swichtes the label of the bus on or off.

Suffix:

<b>

Parameters:
<State>

1,2
Selects the bus.

ON | OFF

*RST: ON



Command Reference

2.15.2 Parallel / Parallel Clocked Bus

BUS<b>:PARallel:DATA<mM>:SOURCE <SOUICE> ...iiiiiiiiiiiiiiiiie et 142
BUS<b>:PARallel:WIDTh <BUSWIAtN> ..o 142
BUS<b>:CPARallel:DATA<M>:SOURGCE  ..ooiieiiiiie e 143
BUS<b>:CPARallel:CLOCK:SOURGCE ..o 143
BUS<b>:CPARallel:CLOCK:SLOPE ..o 143
BUS<b>:CPARAIIBIECS:SOURCE  ...oeeieeeeeeeee e 144
BUS<b>:CPARAIIBECS:POLATITY  .eeeeieieee e 144
BUS<b>:CPARAIEEWIDTR .o 144

BUS<b>:PARallel:DATA<m>:SOURce <Source>
Defines the digital channel that is assigned to the selected bit. Use the command for each bit of

the bus.
Suffix:
<b> 1,2

Selects the bus.
<m> Selects the bit line
Parameters:
<Source> DO .... D7

*RST: DO
Example: BUS:PAR:WIDT 4

BUS:PAR:DATA0:SOUR D2
BUS:PAR:DATA1:SOUR D3
BUS:PAR:DATA2:SOUR D4
BUS:PAR:DATA3:SOUR Db

BUS<b>:PARallel:WIDTh <BusWidth>
Sets the number of lines to be analyzed.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<BusWidth> Range: 1to 6

Default unit: Bit

*RST: 6
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Command Reference

BUS<b>:CPARallel:DATA<m>:SOURce
Defines the digital channel that is assigned to the selected bit. Use the command for each bit of

the bus.
Suffix:
<b> 1,2

Selects the bus.
<m> Selects the bit line
Parameters:
<Source> DO .... D7

*RST: DO
Example: BUS:CPAR:WIDT 4

BUS:CPAR:DATA0:SOUR D2
BUS:CPAR:DATA1:SOUR D3
BUS:CPAR:DATA2:SOUR D4
BUS:CPAR:DATA3:SOUR D5

BUS<b>:CPARallel:CLOCk:SOURce
Selects the digital channel that is used as clock line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<ClockSource> D0...D7

*RST: D7

BUS<b>:CPARallel:CLOCk:SLOPe
Selects if the data is sampled on the rising or falling slope of the clock, or on both edges
(EITHer). The clock slope marks the begin of a new bit.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<ClockSlope> POSitive | NEGative | EITHer
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BUS<b>:CPARallel:CS:SOURce
Selects the digital channel that is used as chip select line.

Suffix:
<b> 1,2

Selects the bus.
Parameters:

<ChipSelectSource> DO...D7

*RST: D6

BUS<b>:CPARallel:CS:POLarity
Selects wether the chip select signal is high active (high = 1) or low active (low = 1).

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive: High active
NEGative: Low active

BUS<b>:CPARallel:WIDTh
Sets the number of lines to be analyzed.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<BusWidth> Range: 1to 6

Default unit: Bit

*RST: 6



Command Reference

2.15.3 SPI Bus

SPI - Configuration

BUS<b>:SPI:CS:SOURCE <SOUICE> it 145
BUS<b>:SPI:CS:POLarity <POIarity> . i 146
BUS<b>:SPI:CLOCK:SOURCE <SOUICE>  .oiiiiiiiiiiii e 146
BUS<b>:SPI:CLOCK:POLarity <Polarity> .....oooooiiiiiiii 146
BUS<b>:SPI:DATA:SOURCE <SOUICES  .iviiiiiiiiiiiiiiiiee ettt 147
BUS<b>:SPI:DATA:POLarity <POIarity> ..o 147
BUS<b>:SPI:BORDEr <BitOrders> ...ooiiiiiiiiiiii i 147
BUS<b>:SPI:SSIZe <SymMDOISIZE> oo 148
Trigger

TRIGQErA:SPEEMODE <MOAE> .o 148
TRIGger:A:SPI:PATTern <DataPattern= ... 148
TRIGger:A:SPI:PLENgth <PatternLength> ..o 149
TRIGger:A:SPI:POFFset <PatternBitOffSet> ... 149
Decode

BUS<D>1SPEFCOUNT? oo 149
BUS<b>:SPEFRAME<N> ISTATUS? oottt e et e e e et a e 149
BUS<b>:SPEFRAME<N>STARL? e 150
BUS<b>:SPI:FRAMe<n>:STOP <StopTIME>  ouoiiiiiiie e 150
BUS<bh>:SPEFRAME<N> I DATA? e 150
BUS<b>:SPIEFRAMe<n>WCOUNT? o e 151
BUS<b>:SPI:IFRAMe<n>:WORD<O>STARL? oo 151
BUS<b>:SPI:IFRAMe<n>:WORD<0O>STOP? ...ttt 151
BUS<b>:SPI:FRAMe<n>WORD<0>MISO? ... 152
BUS<b>:SPI:FRAMe<n>:WORD<0>MOSI? .. 152

BUS<b>:SPI:CS:SOURce <Source>
Selects the input channel of the chip select line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2| DO .... D7 | EXTern

*RST: EXT
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Remote Control

Command Reference

BUS<b>:SPI:CS:POLarity <Polarity>
Selects whether the chip select signal is high active (high = 1) or low active (low = 1).

Suffix:
<b>

Parameters:
<Polarity>

1,2
Selects the bus.

POSitive | NEGative

POSitive: High active
NEGative: Low active
*RST: POS

BUS<b>:SPI:CLOCk:SOURce <Source>
Selects the input channel of the clock line.

Suffix:
<b>

Parameters:
<Source>

1,2
Selects the bus.

CH1|CH2| DO .... D7

*RST: CH1

BUS<b>:SPI:CLOCk:POLarity <Polarity>
Selects if data is stored with the rising or falling slope of the clock. The slope marks the begin of

a new bit.

Suffix:
<b>

Parameters:
<Polarity>

1,2
Selects the bus.

POSitive | NEGative

POSitive: Rising slope
NEGative: Falling slope
*RST: NEG
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BUS<b>:SPI:DATA:SOURce <Source>
Selects the input channel of the data line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2| DO .... D7

*RST: CH1

BUS<b>:SPI:DATA:POLarity <Polarity>
Selects whether transmitted data is high active (high = 1) or low active (low = 1).

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive: High active
NEGative: Low active
*RST: POS

BUS<b>:SPI:BORDer <BitOrder>
Defines if the data of the messages starts with MSB (most significant bit) or LSB (least signifi-

cant bit).
Suffix:
<b> 1,2
Selects the bus.
Parameters:
<BitOrder> MSBFirst | LSBFirst

*RST: MSBFirst
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Command Reference

BUS<b>:SPI:SSIZe <SymbolSize>
Sets the word length, the number of bits in a message.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<SymbolSize> Range: 4 to 32

Default unit: Bit

*RST: 8

TRIGger:A:SPI:MODE <Mode>
Specifies the trigger mode for SPI/SSPI protocols.

Parameters:
<Mode> BSTart | BEND | NTHBit | PATTern

BSTart
Burst start, sets the trigger event to the start of the frame. The frame
starts when the chip select signal CS changes to the active state.

BEND
Burst end, sets the trigger event to the end of the message.

NTHBit
Sets the trigger event to the specified bit number. To define the bit
number, use TRIGger:A:SPI:POFFset.

PATTern

Sets the trigger event to a serial pattern. To define the pattern, use
TRIGger:A:SPI:PATTern. For a complete configuration of the pattern
mode, you also have to set TRIGger:A:SPI:PLENgth and
TRIGger:A:SPI:POFFset.

*RST: BST

TRIGger:A:SPI:PATTern <DataPattern>
Defines the bit pattern as trigger condition.

Parameters:
<DataPattern> Binary pattern with max. 32 bit. Characters 0, 1, and X are allowed.
Example: TRIGger:A:SPI:PATTern “0011XXXX0110"

Sets a 12bit pattern.
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Command Reference

TRIGger:A:SPI:PLENgth <PatternLength>
Defines how many bits build up the serial pattern.

Parameters:
<PatternLength> Range: 1 to 32

*RST: 4
TRIGger:A:SPI:POFFset <PatternBitOffset>
Sets the number of bits before the first bit of the pattern.
Parameters:
<PatternBitOffset> Number of ignored bits

Range: 0 to 4095

*RST: 0
BUS<b>:SPI:FCOunt?
Returns the number of frames.
Suffix:

<b> 1,2
Selects the bus.

Return values:
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:SPI:FRAMe<n>:STATus?
Returns the status of frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Status> OK | INCFirst | INCLast | INSufficient
OK: frame is o.k.
INCFirst: first frame is incomplete
INCLast: last frame is incomplete

INSufficient: frame is insufficient

Usage: Query only
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Command Reference

BUS<b>:SPI:FRAMe<n>:STARt?
Returns the start time of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<StartTime> Range: depends on sample rate and time base
Unit: s
Usage: Query only

BUS<b>:SPI:FRAMe<n>:STOP <StopTime>
Returns the stop time of a frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<StopTime> Range: depends on sample rate and time base
Unit: s
Usage: Query only

BUS<b>:SPl:FRAMe<n>:DATA?
Returns the comma separeted frame data.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Data> List of decimal values of data bytes
Example: BUS:SPI:FRAM3:DATA?
Usage: Query only
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Command Reference

BUS<b>:SPI:FRAMe<n>:WCOunt?
Returns the number of words of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<WordCount> Number of words (numeric value).

Usage: Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>STARt?
Returns the start time of a word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:

<StartTime> Numeric Value
Range: depends on sample rate and time base
Unit: s

Usage: Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>STOP?
Returns the stop time of a word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:

<StopTime> Numeric Value
Range: depends on sample rate and time base.
Unit: s

Usage: Query only
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BUS<b>:SPI:FRAMe<n>:WORD<o0>MISO?
Returns the decimal value of a data word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:
<Data> Decimal value of a data word

Usage: Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>MOSI?
Returns the decimal value of a data word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:
<Data> Decimal value of a data word.

Usage: Query only



Command Reference

2.15.4 SSPI Bus

BUS<b>:SSPI:CLOCK:SOURCE <SOUMCE>  ..iiiiiiiiieiiiiiee et ettt e 153
BUS<b>:SSPI:CLOCK:POLarity <POlarity> ....coiiiiiiiiiiiei e 153
BUS<b>:SSPIIDATA:SOURCE <SOUICE>  .oiiiiiiiiiiieee e 153
BUS<b>:SSPIIDATA:POLarity <POlarity> ..o 154
BUS<b>:SSPI:BITime <BUrstldIeTIME>  ..uoiiiiiiiiiii e 154
BUS<b>:SSPI:BORDEr <BitOrders> ...ooiiieiii e 154
BUS<b>:SSPI:SSIZe <SymbOISIZE>  .eoiiiieieee e 155

BUS<b>:SSPI:CLOCk:SOURce <Source>
Selects the input channel of the clock line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2| DO .... D7

*RST: CH1

BUS<b>:SSPI:CLOCk:POLarity <Polarity>
Selects if data is stored with the rising or falling slope of the clock. The slope marks the begin of

a new bit.

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive: Rising slope
NEGative: Falling slope

BUS<b>:SSPI:DATA:SOURce <Source>
Selects the input channel of the data line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2| DO .... D7

*RST: CH1
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I
Command Reference

BUS<b>:SSPI:DATA:POLarity <Polarity>
Selects whether transmitted data is high active (high = 1) or low active (low = 0).

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive: High active
NEGative: Low active
*RST: POS

BUS<b>:SSPI:BITime <BurstldleTime>

Within the idle time the data and clock lines are low. A new frame begins when the idle time has
expired and the clock line has been inactive during that time. If the time interval between the
data words is shorter than the idle time, the words are part of the same frame.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<BurstldleTime> Range: 16E-9 to 1E-3

Default unit: s

*RST: 100E-6

BUS<b>:SSPI:BORDer <BitOrder>
Defines if the data of the messages starts with MSB (most significant bit) or LSB (least signifi-

cant bit).
Suffix:
<b> 1,2
Selects the bus.
Parameters:
<BitOrder> MSBFirst | LSBFirst

*RST: MSBF

e
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Command Reference

BUS<b>:SSPI:SSIZe <SymbolSize>
Sets the word length, the number of bits in a message.

Suffix:
<b> 1,2

Selects the bus.
Parameters:
<SymbolSize> Range: 4 to 32

Default unit: Bit

*RST: 8
I2C Bus
I2C - Configuration
BUS<b>:12C:CLOCK:SOURCE <SOUICE>  oiiieiiiiiiiee e 156
BUS<b>:12C:DATA:SOURCE <SOUICES  iiiiiiiiiieiee e 156
BUS<D>U2CAMODE ..o 156
Trigger
TRIGer:AlI2C:MODE <MOAE> oo 157
TRIGQENAIZ2C:ACCESS SACCESSS  oiiiiiiiiieiiiiie e ettt ettt et e e st et e et e e et e e e etaee e e eebee s 157
TRIGger: A:I2C:AMODE <AAIMOAE>  ..oiiiiiiii e 158
TRIGger:A:I2C:ADDRess <AdAreSSSINNG ™  ooiiiiiiiiiiiiee ittt e et ee s 158
TRIGENAIZCPATTEIN oottt e e et e e e e e e aabaaaaa s 158
TRIGger:A:I2C:PLENgth <PatternLengths> ..o 158
TRIGger:A:12C:POFFset <PatternByteOffSet> ..o 158
Decode
BUS<D>12C FCOUNT? e 159
BUS<b>:12C:FRAME<N>STATUS? oot 159
BUS<b>:12C:FRAME<N>:STARL? oo 159
BUS<b>:12C:FRAME<N>:STOP? ..o e 160
BUS<b>:12C:FRAME<N>:ACCESS? ..o 160
BUS<b>:12C:FRAME<N>AMODE? .ot 161
BUS<b>12C:FRAME<N>IAACCESS? .ot 161
BUS<b>:12C:FRAME<N>ADDRESS? .ottt 161
BUS<b>:12C:FRAME<N>:ADEVICE? oo 162
BUS<b>:12C:FRAME<N>IASTAI? oo 162
BUS<b>:12C:FRAME<N>:ADBSIAIT?  ..ooieiieeee e 162
BUS<b>:12C:FRAMe<n>:ACOMPIBLE? . oo 163
BUS<b>:12C:FRAMe<N>BCOUNT? .ot 163
BUS<b>12C FRAME<N> I DATA? e 163
BUS<b>:12C:FRAMe<n>BYTE<O>VALUE? . oo 164
BUS<b>:12C:FRAMe<n>:BYTE<O>STARL? . o 164
BUS<b>:12C:FRAMe<n>:BYTE<O>ACKSIAI? .o 164
BUS<b>:12C:FRAMe<N>:BYTE<OSACCESS?  iiiiiiiiiiiieee ettt 165
BUS<b>:12C:FRAMe<n>:BYTE<O>COMPIEIE?  ..oiiiviiiiieee e 165



Command Reference

BUS<b>:12C:CLOCk:SOURce <Source>
Sets the input channel to which the clock line is connected.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2| DO .... D7

*RST: CH1

BUS<b>:12C:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2| DO .... D7

*RST: CH1

BUS<b>:12C:AMODe
Defines if the R/W bit of a 7-bit address is considered separately or as part of the address. The
setting defines which address lengths are available with TRIGger:A:12C: AMODe .

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<BusConfig> ARWRite | AONLy
ARWRite: Address + R/W bit
AONLy: Address only
*RST: AONL
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TRIGger:A:12C:MODE <Mode>
Specifies the trigger mode for 12C.

Parameters:
<Mode> STARt | RESTart | STOP | MACKnowledge | PATTern
STARt
Start of the message. The start condition is a falling slope on SDA while
SCL is high.
RESTart

Restarted message. The restart is a repeated start condition.

STOP
End of the message. The stop condition is a rising slope on SDA while
SCL is high.

MACKnowledge
Missing acknowledge. If the transfer failed, at the moment of the
acknowledge bit the SCL and the SDA lines are both on high level.

PATTern
Triggers on a set of trigger conditions: read or write access of the ma
ster, to an address, or/and to a bit pattern in the message.

For a complete configuration of the pattern mode, you have to set:
TRIGger:A:12C:ACCess (read/write access), and
TRIGger:A:12C:AMODe and TRIGger:A:I12C:ADDRess (address), and/or
TRIGger:A:12C.POFFset and TRIGger:A:12C:PLENgth and
TRIGger:A:12C.PATTern (pattern)

*RST: STAR
TRIGger:A:12C:ACCess <Access>
Toggles the trigger condition between Read and Write access of the master.

Parameters:
<Access> READ | WRITe

*RST: READ
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TRIGger:A:12C:AMODe <AdrMode>
Sets the lenght of the slave address.

Parameters:

<AdrMode> NORMal | EXTended
NORMal: 7 bit address
EXTended: 10 bit address
*RST: NORM

TRIGger:A:12C:ADDRess <AddressString>
Sets the address of the slave device. The address can have 7 bits or 10 bits.

Parameters:
<AddressString> Binary pattern with max. 10 bit. Characters 0, 1, and X are allowed.
Example: TRI:A:I2C:ADDR “10X1"

TRIGger:A:12C:PATTern
Defines the bit pattern as trigger condition.

Parameters:
<DataPattern> Binary pattern with max. 24 bit. Characters 0, 1, and X are allowed.

TRIGger:A:12C:PLENgth <PatternLength>
Defines how many bytes are considered in the trigger condition. To set the pattern for these
bytes, use TRIGger:A:12C:PATTern.

Parameters:

<PatternLength> Number of bytes
Range: 1t0 3
*RST: 1

TRIGger:A:12C:POFFset <PatternByteOffset>
Sets the number of bytes before the first byte of interest, relating to the end of the address
bytes.

Parameters:
<PatternByteOffset> Number of ignored bytes
Range: 0 to 4095

*RST: 0
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BUS<b>:12C:FCOunt?

Remote Control

Command Reference

Returns the number of frames.

Suffix:
<b>

Return values:
<FrameCount>

Usage:

1,2
Selects the bus.

Total number of decoded frames.

Query only

BUS<b>:12C:FRAMe<n>:STATus?
Returns the status of frames.

Suffix:
<b>

<n>

Return values:
<State>

Usage:

1,2
Selects the bus.

Selects the frame.

INComplete | OK | UNEXpstop | INSufficient | ADDifferent

INComplete: frame is incomplete

OK: frame is 0.k.
UNEXpstop: frame stop is unexpected
INSufficient: ~ frame is insufficient
ADDifferent:  frame is different

Query only

BUS<b>:12C:FRAMe<n>:STARt?
Returns the start time of a frame.

Suffix:
<b>

<n>

Return values:

<StartTime>

Usage:

1,2
Selects the bus.

Selects the frame.
Range: depends on sample rate and time base
Unit: s

Query only

e
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BUS<b>:12C:FRAMe<n>:STOP?
Returns the stop time of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<EndTime> Range: depends on sample rate and time base
Unit: s
Usage: Query only

BUS<b>:12C:FRAMe<n>:ACCess?
Returns the read/write access.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Access> INComplete | READ | WRITE | EITHer | UNDF

INComplete: frame is incomplete

READ: read frame

WRITE: write frame

ElTHer: either write or read frame

UNDF: frame is undefined
Usage: Query only
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BUS<b>:12C:FRAMe<n>:AMODe?

Returns the adress mode.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<AddressMode> BIT7 | BIT10
BIT7: 7 Bit address
BIT10: 10 Bit address
Usage: Query only

BUS<b>:12C:FRAMe<n>:AACCess?
Returns the address acknowledge of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Acknowledge> INComplete | ACK | NACK | EITHer

INComplete: Acknowledge is incomplete

ACK: Acknowledge

NACK: not Acknowledge

EITHer: ACK or NACK
Usage: Query only

BUS<b>:12C:FRAMe<n>:ADDRess?
Returns the read/write address as a decimal value (including RW bit).

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<AddressValue> Range: 0 to 2047

Usage: Query only

e
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Command Reference

BUS<b>:12C:FRAMe<n>:ADEVice?
Returns the read/write address as a decimal value (excluding RW bit).

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<SlaveAddress> Range: 0 to 1023

Usage: Query only

BUS<b>:12C:FRAMe<n>:ASTart?
Returns the start time of a address of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<StartTime> Range: depends on sample rate and time base
Unit: s
Usage: Query only

BUS<b>:12C:FRAMe<n>:ADBStart?
Returns the start time of a address acknowledge of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<AckStartTime> Range: depends on sample rate and time base
Unit s
Usage: Query only
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BUS<b>:12C:FRAMe<n>:ACOMplete?
Returns the info whether an address was received complete.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<AddressComplete>  ON | OFF

Usage: Query only

BUS<b>:12C:FRAMe<n>:BCOunt?
Returns the number of data bytes of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ByteCountinFrame>  Number of words (bytes)

Example: BUS1:12C:FRAM2:BCO?

Usage: Query only

BUS<b>:12C:FRAMe<n>:DATA?
Returns the number of data bytes of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<DataWordsInFrame>  List of decimal values of data bytes of a frame.
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Command Reference

BUS<b>:12C:FRAMe<n>:BYTE<o>VALue?
Returns the value of a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<ByteValue> Decimal value
Range: 0 to 255

Usage: Query only

BUS<b>:12C:FRAMe<n>:BYTE<o>STARt?
Returns the start time of data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<StartTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:12C:FRAMe<n>:BYTE<o>ACKStart?
Returns the start time of the acknowledge bit of a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<AckStartTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

e
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BUS<b>:12C:FRAMe<n>:BYTE<0o>ACCess?
Returns the acknowledge bit of a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Acknowledge> INComplete | ACK | NACK | EITHer

INComplete: Acknowledge is incomplete

ACK: Acknowledge

NACK: Not Acknowledge

ElTHer: ACK or NACK
Usage: Query only

BUS<b>:12C:FRAMe<n>:BYTE<o>COMPlete?
Returns the information whethera data byte of a frame is received complete.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:

<ByteComplete> ON | OFF
ON: Data byte was received completely.
Usage: Query only

e
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2.15.6 UART

UART - Configuration
BUS<b>:UART.DATA:SOURce <Source>
BUS<b>:UART:DATA:POLarity <Polarity>
BUS<b>:UART:SSIZe <SymbolSize>
BUS<b>:UART:PARity <Parity>
BUS<b>:UART:SBIT <StopBitNumber>
BUS<b>:UART:BAUDrate <Baudrate>
BUS<b>:UART:BITime <BurstldleTime>

Trigger

TRIGger:A:UART:MODE <Mode>
TRIGger:A:UART:PATTern <DataPattern>
TRIGger:A:UART:PLENgth <PatternLength>
TRIGger:A:UART:POFFset <PatternByteOffset>

Decode
BUS<b>:UART:FCOunt?
BUS<b>:UART:FRAMe<n>:WCOunt?
BUS<b>:UART:FRAMe<n>:WORD<o0>:VALue?
BUS<b>:UART:FRAMe<n>:WORD<o0>:STARt?
BUS<b>:UART:FRAMe<n>:WORD<0>:STOP?
BUS<b>:UART:FRAMe<n>:WORD<o0>:STATe?

Command Reference

BUS<b>:UART:DATA:SOURce <Source>
Selects the input channel of the UART signal.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2| DO .... D7

*RST: CH1

BUS<b>:UART:DATA:POLarity <Polarity>

Defines if the transmitted data on the bus is high (high = 1) or low (low = 1) active.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Polarity> POSitive | NEGative
POSitive:
NEGative:
*RST: POS

High active
Low active



Command Reference

BUS<b>:UART:SSIZe <SymbolSize>
Sets the number of data bits in a message.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<SymbolSize> Range: 5to 9

Default unit: Bit

*RST: 8

BUS<b>:UART:PARity <Parity>
Defines the optional parity bit that is used for error detection.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Parity> ODD | EVEN | NONE

*RST: NONE

BUS<b>:UART:SBIT <StopBitNumber>
Sets the stop bits.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<StopBitNumber> B1|B1_5|B2

1, 1.5 or 2 stop bits are possible.

*RST: B1
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BUS<b>:UART:BAUDrate <Baudrate>
Sets the user defined number of transmitted bits per second.

Suffix:

<b>

Parameters:
<Baudrate>

1,2
Selects the bus.

Range: 6.0E+01 to 1.56E+07
Default unit: Bit

*RST: 1.156200E+05

BUS<b>:UART:BITime <BurstldleTime>
Sets the minimal time between two data frames (packets), that is, between the last stop bit and
the start bit of the next frame.

Suffix:

<b>

Parameters:
<BurstldleTime>

1,2
Selects the bus.

Range: 9.54880E-05 to 2.6843137E-01
Default unit: s

*RST: 1.1458333E-03

TRIGger:A:UART:MODE <Mode>
Specifies the trigger mode for UART/RS-232 interfaces.

Parameters:
<Mode>

BSTart | SBIT | NTHSymbol | SYMBol | PATTern | PERRor | FERRor |
BREak

BSTart
Burst start. Sets the trigger to the begin of a data frame. The frame start
is the first start bit after the idle time.

SBIT
The start bit is the first low bit after a stop bit.

NTHSymbol
Sets the trigger to the n-th symbol of a burst.

SYMBol
Triggers if a pattern occurs in a symbol at any position in a burst.
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PATTern

Triggers on a serial pattern at a defined position in the burst. To define
the pattern, use TRIGger:A:UART:PLENgth and
TRIGger:A:UART:PATTern. To define the position, use
TRIGger:A:UART:POFFset.

PERRor
Parity Error: Triggers if a bit error occured in transmission.

FERRor
Triggers on frame error.

BREak
Triggers if a start bit is not followed by a stop bit within a defined time.
During the break the stop bits are at low state.

*RST: SBIT
TRIGger:A:UART:PATTern <DataPattern>
Defines the bit pattern as trigger condition.

Parameters:
<DataPattern> Binary pattern with max. 32 bit. Characters 0, 1, and X are allowed.

*RST: 1 (=,,00000001")

TRIGger:A:UART:PLENgth <PatternLength>
Defines how many symbols build up the serial pattern.

Parameters:

<PatternLength> Number of symbols
Range: 1to 3
*RST: 1

TRIGger:A:UART:POFFset <PatternByteOffset>
Sets the number of symbols before the first symbol of the pattern.

Parameters:
<PatternByteOffset> Number of ignored symbols
Range: 0 to 4095
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BUS<b>:UART:FCOunt?
Returns the number of frames.

Suffix:
<b> 1,2
Selects the bus.

Return values:
<FrameCount> Total number of decoded frames.

BUS<b>:UART:FRAMe<n>:WCOunt?
Returns the number of words of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<WordCount> Number of words (symbols, characters)

Usage: Query only

BUS<b>:UART:FRAMe<n>:WORD<o0>:VALue?
Returns the value of TX.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:
<Value> Decimal value
Range: 0 to 511

Usage: Query only
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BUS<b>:UART:FRAMe<n>:WORD<o0>:STARt?
Returns the start time of a word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:
<StartTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:UART:FRAMe<n>:WORD<o0>:STOP?
Returns the stop time of a word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:
<StopTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:UART:FRAMe<n>:WORD<0>:STATe?
Returns the status of frames.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

e
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Return values:

<FrameStatus> OK| FRSTart | FRENd | FRMError | STERror | SPERror | PRERror |
INSufficient
OK: Frame is o0.k.
FRSTart: Frame start
FRENd: Frame end
FRMError: Frame error
STERror: Startbit error
SPERror: Stopbit error
PRERror: Parity error

INSufficient: Frame is insufficient

*RST: OK

Usage: Query only

2.15.7 CAN
CAN - Configuration
BUS<b>:CAN:DATA:SOURCE SSOUMCES>  iiiiiiiiiiieiiiiieiie ettt siae et sve e stve s staeeseve s niaeesnbe e 173
BUS<b>:CANTYPE <SignalType> oo 173
BUS<b>:CAN:SAMPIlepoint <SamplePoint> ... ..o 174
BUS<b>:CAN:BITRate <BItRAtE>  ....ccuiiiciiiiiii e 174
Trigger
TRIGGer A:CAN:TYPE <TriggerTYPE>  iiiiiiiieiiiiiiiie et 174
TRIGger: A:CAN:FTYPe <FrameTypes> oo 175
TRIGger: A:CAN:ITYPe <IdentifierTyPe> ..o 175
TRIGger:A:CAN:ICONdition <ldentifierCondition>  .......ccoiiiiiiiiiii e 175
TRIGger:A:CAN:IDENTtifier <Identifiers ..o 175
TRIGger:A:CAN:DCONdition <DataCondition> . ...cc..ooiiiiiiiiiie e 176
TRIGGErAICAN:DATA <DEIA>  woiiiiieii ittt e abbae e 176
TRIGger:A:CAN:DLENgth <Datalengths> ... 176
TRIGger:A:CAN:ACKerror <AcknowledgeErrors ..., 176
TRIGger:A:CAN:CRCerror <CRCEITOIS>  .uuiiiiiiiiiiiee e 177
TRIGger:A:CAN:FROMerror <FOrmMEITOr=> ..o 177
TRIGger:A:CAN:BITSterror <BitStuffingError> ..o 177
Decode
BUS<D>ICANIFCOUNT? oottt ettt ettt e e st e et e et e s etaeesnbeentaeennbeea 177
BUS<b>:CAN:FRAME<NSISTATUS?  1iitiiiiieeiiii et e sttt ettt ste ettt e stae et e s ntaeestbe s stneenabe e 178
BUS<b>:CAN:FRAME<N>ISTARL? oottt 178
BUS<b>:CAN:FRAME<N>ISTOP?  1oiiiiiiiieicit ettt 178
BUS<b>:CAN:FRAME<N>TYPE? ittt 179



Command Reference

BUS<b>:CAN:FRAME<N> IDATA? o e 179
BUS<b>:CAN:FRAME<N>:ACKSIAtE?  ..iiiieiiiiicee e 179
BUS<b>:CAN:FRAME<N>ICSSIAtB? ittt 180
BUS<b>:CAN:FRAME<N>:DLCSIAtE?  .ovtiiiiiiiiiiiie e 180
BUS<b>:CAN:FRAME<N>IIDSTATE? ... 180
BUS<b>:CAN:FRAME<N>:ACKVAIUE? .. oo 181
BUS<b>:CAN:FRAME<N>:CSValUB?  ..ooiieeiii e 181
BUS<b>:CAN:FRAME<N>:DLCVAIUE? ..o 181
BUS<b>:CAN:FRAME<N>IIDTYPE? oo 182
BUS<b>:CAN:FRAME<N>:IDVAIUE?  ..ooiiieieee e 182
BUS<b>:CAN:FRAME<N>:BSEPOSIION?  ..oiiiiieiicecieee e 182
BUS<b>:CAN:FRAME<N>BCOUNT? . 183
BUS<b>:CAN:FRAME<N>:BYTE<O>:STATE?  .oooiiiiiie e 183
BUS<b>:CAN:FRAME<N>BYTE<O>VALUE? e 183

BUS<b>:CAN:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Parameters:
<b> 1,2

Selects the bus.
<Source> CH1|CH2| DO .... D7

*RST: CH1

BUS<b>:CAN:TYPE <SignalType>
Sets the signal type of the CAN.

Parameters:
<b> 1,2

Selects the bus.
<SignalType> CANH | CANL

CANH: CAN High
CANL: CAN Low

*RST: CANH



SCPI Commands R&S®HMO1002/1202 series Remote Control

Command Reference

BUS<b>:CAN:SAMPIlepoint <SamplePoint>
Sets the sample point for the CAN Decoder within the bit period.

Parameters:
<b> 1,2
Selects the bus.
<SamplePoint> Range: 25 to 90
Unit: %
*RST: 50

BUS<b>:CAN:BITRate <BitRate>
Sets the user defined bit rate for the CAN Decoder.

Parameters:
<b> 1,2
Selects the bus.
<BitRate> Range: 1.00E+02 to 1.0081E+06

Unit: Bit/s
*RST: 5.0000E+04

TRIGger:A:CAN:TYPE <TriggerType>
Specifies the trigger type for CAN.

Parameters:

<TriggerType> STOFrame | EOFrame | ID | IDDT | FTYPe | ERRCondition
STOFrame: Sets the trigger to the start of a frame.
EOFrame: Sets the trigger to the end of a frame.
ID: Sets the trigger to the ID of a frame.
IDDT: Sets the trigger to the ID and data of a frame.
FTYPe: Sets the trigger to the frame type.

ERRCondition: Sets the trigger to the error condition of a frame.

*RST: STOF
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TRIGger:A:CAN:FTYPe <FrameType>
Specifies the frame type for CAN.

Parameters:

<FrameType> DATA | REMote | ERRor | OVERIoad | ANY
DATA: Sets the frame type to data.
REMote: Sets the frame type to remote.
ERRor: Sets the frame type to error.
OVERIoad: Sets the frame type to overload.
ANY: Sets the frame type to any.
*RST: ERR

TRIGger:A:CAN:ITYPe <ldentifierType>
Specifies the identifier type for CAN. If the trigger type ID is set, only B11 or B29 are allowed.

Parameters:
<IdentifierType> B11]|B29

B11:  Sets the identifier type 11Bit.
B29:  Sets the identifier type 29Bit.

*RST: B11

TRIGger:A:CAN:ICONdition <ldentifierCondition>
Specifies the condition for the identifier.

Parameters:
<ldentifierCondition>  EQUual | NEQual | GTHan | LTHan

EQUual: Sets the condition for identifier to equal.
NEQual: Sets the condition for identifier to not equal.
GTHan: Sets the condition for identifier to greater than.
LTHan: Sets the condition for identifier to less than.
*RST: EQU

TRIGger:A:CAN:IDENtifier <ldentifier>
Specifies the identifier, depending of TRIGger:A:CAN:ITYPe <IdentifierType> setting only string
with 11 or 29 characters is possible.

Parameters:
<Identifier> String containing binary pattern with max. 29 bit.
Characters 0, 1 and X are allowed.
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TRIGger:A:CAN:DCONdition <DataCondition>
Specifies the condition for the data.

Parameters:

<DataCondition> EQUual | NEQual | GTHan | LTHan
EQUual: Sets the condition for identifier to equal.
NEQual: Sets the condition for identifier to not equal.
GTHan: Sets the condition for identifier to greater than.
LTHan: Sets the condition for identifier to less than.
*RST: EQU

TRIGger:A:CAN:DATA <Data>
Specifies the data for CAN trigger. Depending of TRIGger:A:CAN:DLENgth <DatalLength> set-
ting the number of characters is fixed, all bytes need to be complete.

Parameters:
<Data> String containing binary pattern with max. 64 bit.

Characters 0, 1 and X are allowed. Make sure to enter complete bytes.
Example: TRIG:A:CAN:DATA ,,10010110"

TRIGger:A:CAN:DLENgth <DatalLength>
Specifies the data length for the CAN trigger.

Parameters:

<DatalLength> Range: 0 to 8
Unit: Byte
*RST: 1

TRIGger:A:CAN:ACKerror <AcknowledgeError>

Specifies the trigger on acknowledge error when trigger type is set to error, using
TRIGger:A:CAN:TYPE <TriggerType>. An acknowledgement error occurs when the transmitter
does not receive an acknowledgment - a dominant bit during the Ack Slot.

Parameters:
<AcknowledgeError>  ON | OFF

*RST: OFF
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TRIGger:A:CAN:CRCerror <CRCerror>
Specifies the trigger on checksum error when trigger type is set to error, using
TRIGger:A:CAN:TYPE <TriggerType>.

Parameters:
<CRCerror> ON | OFF

*RST: OFF
TRIGger:A:CAN:FROMerror <FormError>
Specifies the trigger on form error when trigger type is set to error, using TRIGger:A:CAN:TYPE

<TriggerType>. A form error occurs when a fixed-form bit field contains one or more illegal bits.

Parameters:
<FormError> ON | OFF

*RST: OFF
TRIGger:A:CAN:BITSterror <BitStuffingError>
Specifies the trigger on stuff bit error when trigger type is set to error, using

TRIGger:A:CAN:TYPE <TriggerType>.

Parameters:
<BitStuffingError> ON | OFF

*RST: ON
BUS<b>:CAN:FCOunt?
Returns the number of frames.
Suffix:
<b> 1,2

Selects the bus.

Return values:
<FrameCount> Total number of decoded frames.

Usage: Query only
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BUS<b>:CAN:FRAMe<n>:STATus?
Returns the status of frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<State> OK | BTST | CRC | FORM | NACK | INSufficient
OK: Frame is valid.
BTST: Bit stuff error occured.
CRC: Cyclic redundancy check failed.
FORM: Wrong CRC, ACK delimiter or end of frame occured.
NACK: Acknowledge is missing.
INSufficient: Frame is incomplete.

BUS<b>:CAN:FRAME<n>:STARt?
Returns the start time of a frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<StartTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:CAN:FRAME<n>:STOP?
Returns the stop time of a frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<StopTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

e
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BUS<b>:CAN:FRAME<n>:TYPE?
Returns the frame type.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<FrameType> DATA | REMote | ERR | OVLD
DATA: Frame type is data.
REMote: Frame type is remote.
ERR: Frame type is error.
OVLD: Frame type is overload.
Usage: Query only

BUS<b>:CAN:FRAME<n>:DATA?
Returns a comma separated list of decimal values.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<FrameData> Comma separated list of decimal values of data bytes of a frame:

BUS<b>:CAN:FRAME<n>:ACKState?
Returns the status of the acknowledge field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<AcknowledgeState> OK | UNDF

OK: Acknowledge state is 0.k.
UNDF: Acknowledge state is undefined.

Usage: Query only
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BUS<b>:CAN:FRAME<n>:CSState?
Returns the status of the checksum field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ChecksumState> OK | UNDF

OK: Acknowledge state is 0.k.
UNDF: Acknowledge state is undefined.

Usage: Query only

BUS<b>:CAN:FRAME<n>:DLCState?
Returns the status of the data length code of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<DatalengthCodeState> OK | UNDF

OK: Data length code state is o.k.
UNDF: Data length code state is undefined.

Usage: Query only

BUS<b>:CAN:FRAME<n>:IDSTate?
Returns the status of the identifier field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<IdentifierState> OK | UNDF

OK: Identifier state is 0.k.
UNDF: Identifier state is undefined.

Usage: Query only
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BUS<b>:CAN:FRAME<n>:ACKValue?
Returns the value of the acknowledge bit of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<AcknowledgeValue> Decimal value

Usage: Query only

BUS<b>:CAN:FRAME<n>:CSValue?
Returns the value of the checksum of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ChecksumValue> Decimal value

Usage: Query only

BUS<b>:CAN:FRAME<n>:DLCValue?
Returns the value of the data length code field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<DatalengthCodeValue> Non-negative integer

Usage: Query only
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BUS<b>:CAN:FRAME<n>:IDTYpe?
Returns the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN extended

frames.
Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.

Return values:
<IdentifierType> B11|B29

B11: Identifier type is 11 bit
B29: Identifier type is 29 bit

Usage: Query only

BUS<b>:CAN:FRAME<n>:IDValue?
Returns the value of the identifier of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ldentifierValue> Decimal value

Usage: Query only

BUS<b>:CAN:FRAME<n>:BSEPosition?
Returns the position time of the bit stuffing error in the specified frame (if available).

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<BitStuffingErrorPosition> Default unit: s
*RST: 0
Usage: Query only

e
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BUS<b>:CAN:FRAME<n>:BCOunt?
Returns the number of data bytes of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ByteCount> Number of words (bytes)

Usage: Query only

BUS<b>:CAN:FRAME<n>:BYTE<0>:STATe?
Returns the state of the a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<ByteStatus> OK'| UNDF

OK: Data byte state is o.k.
UNDF: Data byte state is undefined.

Usage: Query only

BUS<b>:CAN:FRAME<n>:BYTE<o>:VALue?
Returns the value of the data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<ByteValue> Decimal value

Usage: Query only
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2.15.8 LIN

LIN - Configuration

BUS<b>:LIN:DATA:SOURCE <SOUICES>  iiiiiiiiiiiii ittt 184
BUS<b>:LIN:POLarity <POlarity> ..o 185
BUS<b>:LIN:STANdard <Standards>  ......ocooiiiiiiiiie e 185
BUS<b>:LIN:BITRAte <BItRAE>  ..ieiiiiiiiiiie ittt 185
Trigger

TRIGGErALIN:TYPE <TriggerTyDE> ittt 186
TRIGger:A:LIN:ICONdition <ldentifierCondition> ........ccoiiiiiiiiiii e 186
TRIGger:A:LIN:IDENtifier <Identifiers ... 186
TRIGger:A:LIN:DCONdition <DataCondition>  ..eoiiiiiiiiiiieiie e 186
TRIGErAILIN:DATA <DATIAS  eriiiiiieiiiiiiiiie ettt e e e e et e e e e e e e tnbaeeeee s 187
TRIGger:A:LIN:DLENgth <Datalength> ... 187
TRIGger:A:LIN:CHKSerror <CheckSUMEITOr=>  ...iiiiiiiiiiiiiiiiice e 187
TRIGger:A:LIN:IPERerror <ldentifierParityError> ... 187
TRIGger:A:LIN:SYERror <SynchronisationError> ..o 187
Decode

BUS <D ILINIFCOUNT? oottt sttt ettt ettt ete e e et e e etaeennbeeanneennneen 188
BUS<b>:LIN:FRAME<N>BCOUNT? 1ottt ettt stae e e e ntaeennne e 188
BUS<b>:LIN:FRAMESNSISTATUS?  oiiiiiiiiie it ete sttt ettt ste et stae et stve et e e staeesnbeentneennbe e 188
BUS<b>:LIN:FRAME<N>ISTARL? oottt ettt etve e 189
BUS<b>:LIN:FRAME<N>ISTOP? oottt ettt 189
BUS<b>:LIN:FRAME<N>:VERSION?  ..oiiiiiiiie et 189
BUS<b>:LIN:FRAME<N>DATA? .ot 190
BUS<b>:LIN:FRAME<n>:IDSTate <ldentifierState> ..........ccccocveiiiiiiiiiiecee e 190
BUS<b>:LIN:FRAME<N>IIDVAIUE?  1oiiiiiieeiiii ettt ettt ntaeennne e 190
BUS<b>:LIN:FRAME<N>IIDPVAIUE?  .oiiiiiiiiiiiciee ettt 191
BUS<b>:LIN:FRAME<N>ISYSTAE?  .oiiiiiiiiii ittt 191
BUS<b>:LIN:FRAME<N>ICSSTAtE?  .eiiiiiiiiiiiiiii ettt 191
BUS<b>:LIN:FRAME<N>:CSVAlUB?  ..oiiiiiiiiiiiiii e 192
BUS<b>:LIN:FRAME<N>BCOUNT? .ot 192
BUS<b>:LIN:FRAME<N>:BYTE<O>:STATE? oo 192
BUS<b>:LIN:FRAME<N>:BYTE<O>VALUE? oo 193

BUS<b>:LIN:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2| DO .... D7

*RST: CH1
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BUS<b>:LIN:POLarity <Polarity>
Sets the polarity of the LIN.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Polarity> POSitive | NEGative

*RST: POS

BUS<b>:LIN:STANdard <Standard>

Selects the version of the LIN standard that is used in the DUT. The setting mainly defines the
checksum version used during decoding. The most common version is LIN 2.x. For mixed net-
works, or if the standard is unknown, set the LIN standard to AUTO.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Standard> V1X | V2X | J2602 | AUTO

V1X: LIN Standard V1.x

V2X: LIN Standard V2.x

J2602: LIN Standard J206 (sets also BitRate to 10.417 KBit/s)
AUTO: Any standard

*RST: V1X

BUS<b>:LIN:BITRate <BitRate>
Sets the user defined bit rate for the CAN Decoder.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<BitRate> Range: 1.00E+02 to 1.0081E+06

Unit: Bit/s

*RST: 9.6E+03

e
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TRIGger:A:LIN:TYPE <TriggerType>
Specifies the trigger type for LIN.

Parameters:
<TriggerType> SYNC | WKFRame | ID | IDDT | ERRCondition
SYNC: Sets the trigger to the synchronisation.
WKFRame: Sets the trigger to the wake up frame.
ID: Sets the trigger to the ID of a frame.
IDDT: Sets the trigger to the ID and data of a frame.

ERRCondition: Sets the trigger to the error condition of a frame.
*RST: SYNC

TRIGger:A:LIN:ICONdition <ldentifierCondition>

Specifies the condition for the identifier.

Parameters:
<ldentifierCondition>  EQUual | NEQual | GTHan | LTHan

EQUual: Sets the condition for identifier to equal.
NEQual: Sets the condition for identifier to not equal.
GTHan: Sets the condition for identifier to greater than.
LTHan: Sets the condition for identifier to less than.
*RST: EQU

TRIGger:A:LIN:IDENtifier <ldentifier>
Specifies the identifier, only 6 character are allowed.

Parameters:

<Identifier> String containing binary pattern. Characters 0, 1, and X are allowed.
Enter the 6 bit identifier without parity bits, not the protected identifier.

Example: TRIG:A:LIN:IDEN ,,100001"

TRIGger:A:LIN:DCONdition <DataCondition>
Specifies the condition for the data.

Parameters:

<DataCondition> EQUual | NEQual | GTHan | LTHan
EQUual: Sets the condition for identifier to equal.
NEQual: Sets the condition for identifier to not equal.
GTHan: Sets the condition for identifier to greater than.
LTHan: Sets the condition for identifier to less than.
*RST: EQU

SCPI Programmers Manual 186



SCPI Commands R&S®HMO1002/1202 series Remote Control

Command Reference

TRIGger:A:LIN:DATA <Data>
Specifies the data for LIN trigger. Depending of TRIGger:A:LIN:DLENgth <DataLength> setting
the number of characters is fixed, all bytes need to be complete.

Parameters:

<Data> String containing binary pattern with max. 64 bit.
Characters 0, 1 and X are allowed.

Example: TRIG:A:LIN:DATA ,,10100101"

TRIGger:A:LIN:DLENgth <DataLength>
Defines the length of the data pattern - the number of bytes in the pattern.

Parameters:
<Datalength> Range: 1to 8

*RST: 1

TRIGger:A:LIN:CHKSerror <ChecksumError>

Triggers on a checksum error when trigger type is set to error condition, using
TRIGger:A:LIN:TYPE <TriggerType>. The checksum verifies the correct data transmission. It is
the last byte of the frame response.

Parameters:
<ChecksuméError> ON | OFF

*RST: ON

TRIGger:A:LIN:IPERerror <ldentifierParityError>

Triggers on a parity error when trigger type is set to error condition, using TRIGger: A:LIN:TYPE
<TriggerType>. Parity bits are the bits 6 and 7 of the identifier. They verify the correct transmissi-
on of the identifier.

Parameters:
<ldentifierParityError> ON | OFF

*RST: OFF
TRIGger:A:LIN:SYERror <SynchronisationError>
Specifies the trigger on synchronisation error when trigger type is set to error, using

TRIGger:A:LIN:TYPE <TriggerType>.

Parameters:
<SynchronisationError> ON | OFF

*RST: OFF
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BUS<b>:LIN:FCOunt?
Returns the number of received frames of the active LIN bus.

Suffix:
<b> 1,2

Selects the bus.

Return values:
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:LIN:FRAMe<n>:BCOunt?
Returns the number of data bytes in the specified frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ByteCount> Number of words (bytes)

Usage: Query only

BUS<b>:LIN:FRAME<n>:STATus?
Returns the status of frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<State> OK | CHKS | WAKeup | SYER | INS | ERR | UNDF | IPER
OK: Frame is valid.
CHKS: Checksum error occured.
WAKeup: Wake up occured.
SYER: Synchronisation
INSufficient: Identifier is insufficient.
ERRor: Error
UNDF: Undefined
Usage: Query only
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BUS<b>:LIN:FRAME<n>:STARt?
Returns the start time of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<StartTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:LIN:FRAME<n>:STOP?
Returns the stop time of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<StopTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:LIN:FRAME<n>:VERSion?
Returns the version of LIN.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<FrameVersion> VIX | V2X | J2602 | UNK

V1X: LIN version is 1.x
V2X:  LIN version is 2.x
J2602: LIN version is J2602
UNK: LIN version is unknown

Usage: Query only
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BUS<b>:LIN:FRAME<n>:DATA?
Returns a comma separated list of decimal values of the data bytes.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<FrameData> Comma separated list of decimal values of data bytes of a frame.

Usage: Query only

BUS<b>:LIN:FRAME<n>:IDSTate <ldentifierState>
Returns the status of the identifier field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<ldentifierState> OK'| PRERror | UNDF | INSufficient
OK: Identifier state is o.k.
PRERror: Parity error at the identifier.
UNDF: Address is undefined.
INSufficient: Identifier is insufficient.
Usage: Query only

BUS<b>:LIN:FRAME<n>:IDValue?
Returns the value of the identifier of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ldentifierValue> Decimal value

Usage: Query only
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BUS<b>:LIN:FRAME<n>:IDPValue?

Returns the value of the parity of the identifier of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<ldentifierParityValue>

Usage:

Decimal value

Query only

BUS<b>:LIN:FRAME<n>:SYSTate?
Returns the status of synchronization field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<SyncFieldState>

Usage:

OK | ERR | UNDF

OK: Sync field state is o.k.
ERR: Syncerror.

UNDF: Sync field state is undefined.

Query only

BUS<b>:LIN:FRAME<n>:CSSTate?
Returns the state of the checksum of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<ChecksumState> OK| ERR | UNDF
OK: Checksum field state is 0.k.
ERR: Checksum error.
UNDF: Checksum state is undefined.
Usage: Query only
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BUS<b>:LIN:FRAME<n>:CSValue?
Returns the value of the checksum of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ChecksumValue> Decimal value

Usage: Query only

BUS<b>:LIN:FRAME<n>:BCOunt?
Returns the number of bytes of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ByteCount> Number of words (bytes)

Usage: Query only

BUS<b>:LIN:FRAME<n>:BYTE<o0>:STATe?
Returns the status of a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<ByteStatus> OK | INS | UART

OK: Byte status is 0.k.
INS: Byte status is insufficient.

UART: Error within the byte.

Usage: Query only
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BUS<b>:LIN:FRAME<n>:BYTE<o>:VALue?
Returns the value of the byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<ByteValue> Decimal value

Usage: Query only

Data and File Management
This chapter describes commands that store or restore data and measurement results.

Output Control

H O O PY D AT A ? oo 193
HCOPYIFORMAL .ot 194
HO O PY S ZE K ? e 194
HO O PY S ZE Y 2 e 194
HCOPY:DESTINAtioN <MEAIUM>  ..iiiiiiiiiiice et 194
MMEMory:NAME <FIleNAME> ... 194
HCOPY[IMMEIATE] e 195
HCOPY:LANGUAGE <FOIMMAt>  .ooiiiiiiiiiiiee e 195
HCOPY:PAGE:SIZE <SIZ8> oo 195
HCOPy:PAGE:ORlentation <Orentation=>  ......cocooiiiiiiiieiiii et 195
HCOPyY:COLOR:SCHeme <ColorSCheme> ..o 195
SYSTem:COMMunicate:PRINter:SELect <PrinterName> ......cccccccoiiiiiiiiiiiiieeeieeee e 196
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt? ... 196
SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?  ...oeiiiiiiiiiiiiiiiiiiiiieieveievevevevevevevevevenenes 196
SYSTem:COMMunicate:PRINTEICSET e 196
HCOPy:DATA?

Returns the actual display content (screenshot) in binary format.

Example: - Stopping the waveform acquisition and send HCOP:DATA?
- Reading the screenshot data bytes until the whole capture is received
- Removing the specific header and saving the data stream

#47609PNG

#4 = 4 letters following

7609 = number of bytes to be transmitted
PNG = PNG file format
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In order to get a valid PNG which can be opened by any standard
image viewer, the header information must be stripped down and
removed until the file starts with ,PNG”.

Usage: Query only

HCOPy:FORMat
Defines the data format of the screenshot.

Parameters:
<Format> BMP | PNG

BMP: Windows Bitmap Format
PNG: Portable Network Graphic

HCOPy:SIZE:X?
Returns the horizontal expansion of the screenshots.

Usage: Query only

HCOPy:SIZE:Y?
Returns the vertical expansion of the screenshots.

Usage: Query only

HCOPy:DESTination <Medium>
Defines whether the screenshot is saved or printed.

Parameters:
<Medium> ~MMEM" | ,SYST:COMM:PRIN"

~MMEM"
Saves the screenshot to a file. Specify the file name and location with
MMEMory:NAME.

+SYST:COMM:PRIN"

Prints on the printer specified with SYSTem:COMMunicate:PRINter:SEL
ect. The printer must be specified before the HCOPy:DESTination is
sent.

*RST: ,MMEM"

MMEMory:NAME <FileName>
Defines the file name to store an image of the display with HCOPy[:IMMediate].

Parameters:
<FileName> String parameter
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HCOPy[:IMMediate]

Prints an image of the display to the printer or saves an image to a file or the clipboard, depen-
ding on the HCOPy:DESTination setting.

The printer is defined by SYSTem:COMMunicate:PRINter:SELect.

The file name for storage is defined by MMEMory:NAME.

Usage: Event

HCOPy:LANGuage <Format>
Defines the format of the printed or saved screenshot.

Parameters:

<Format> GDI | BMP | PNG | GIF
GDI: For output on printer
BMP | PNG | GIF: File formats for saved screenshots
*RST: PNG

HCOPy:PAGE:SIZE <Size>
Defines the page size to be used.

Parameters:
<Size> A4 | Ab | B5| B6 | EXECutive

HCOPy:PAGE:ORIlentation <Orientation>
Defines the page orientation.

Parameters:
<Orientation> LANDscape | PORTrait

HCOPy:COLOR:SCHeme <ColorScheme>
Defines the color mode for saved and printed screenshots.

Parameters:
<ColorScheme> COLor | GRAYscale | INVerted

INVerted
Inverts the colors of the output, i.e. a dark waveform is printed on a

white background.

*RST: COLor
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SYSTem:COMMunicate:PRINter:SELect <PrinterName>
Selects a configured printer.

Parameters:

<PrinterName> String parameter
Enter the string as it is returned with
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt or
SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT].

SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt?
Queries the name of the first printer in the list of printers. The names of other installed
printers can be queried with the SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT] command.

Return values:

<PrinterName> String parameter
Enter the string as it is returned with
SYSTem: COMMunicate:PRINter: ENUMerate: FIRSt? or
SYSTem: COMMunicate:PRINter: ENUMerate[: NEXT]?:
If no printer is configured an empty string is returned.

Usage: Query only

SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?

Queries the name of the next printer installed.

The SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt command should be sent previously to
return to the beginning of the printer list and query the name of the first printer.

Return values:

<PrinterName> String parameter
After all available printer names have been returned, an empty string
enclosed by quotation marks (,,) is returned for the next query. Further
queries are answered by a query error.

Usage: Query only

SYSTem:COMMunicate:PRINter:CSET
Sets the printer language that is supported by the printer.

Parameters:

<CommandSet> PCL5 | PCLXI | PS
PCLXI: PCL XL
PS: Postscript
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2.16.2 MMEMory Commands
The Mass MEMomory subsystem provides commands to access the storage media and to save
and reload instrument settings.

The oscilloscope has two storage devices indicated as drives:
e /INT: internal storage with default directories for each data type
e /USB_FRONT: USB connector on the front panel

Common computer and network drives like C:, D:, \\server\share are not available.

Name conventions

The names of files and directories have to meet the following rules:
e Only the 8.3 format with ASCII characters is supported.

e No special characters are allowed.

e Use/ (slash) instead of \ (backslash).

MMEMOTIY:DRIVES? oottt e e ee et e e et e e es 197
MMEMOry:MSIS [<MassStoragelS>] e 198
MIMEMOIY:DCATAIOT? ittt ettt ettt e ke e et e e asb e e et e e enbeeanaeeaneeeaneeenneeen 198
MMEMory:DCATalog:LENGth? <PathName> ........ccccooiiiiiiieeeee e 198
MMEMory:MDIRectory <DireCtoryName> ... 199
MMEMory:CDIRectory [<DirectoryName>] ..o 199
MMEMory:RDIRectory <DireCtoryNamMe> ......ooiiiiiiiiiiiiiiiie e 199
MMEMory:CATalog? <PathName>[,<Format>] .......ccccciiiiiiiiiiiii e 199
MMEMory:CATalog:LENGth? <PathName> ... 200
MMEMory:COPY <FileSource>,<FileDestination>  ........ccoiiiiiiiiiiiiie e 200
MMEMory:MOVE <FileSource>,<FileDestination>  ........ccccciiiiii 201
MMEMOory:DELete <FillESOUICE> ..ooiiiiiieiieeee e 201
MMEMory:DATA <FileName>,<Datas> ..o 201
MMEMory:STORe:STATe <StateNumber>,<FileName>[,<msus>] ........cccccviiiiiiiiieiiiiiinnee.n. 202
MMEMory:LOAD:STATe <StateNumber>,<FileName>[,<msus>] .......ccccccviiiiiiiiiiiiiiiiiieeen. 202
MMEMory:DRIVes?

Returns the storage devices available on the oscilloscope.

Return values:
<Drive> List of strings

/INT: Internal storage
/USB_FRONT: USB connector on the front panel

Usage: Query only
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MMEMory:MSIS [<MassStoragelS>]
Changes the storage device (drive).

Parameters:
<MassStoragelS> One of the available drives: /INT or /USB_FRONT
Example: MMEM:MSIS ,/USB_FRONT"

Sets USB stick connected to the front panel as storage device.

MMEMory:DCATalog?
Returns the subdirectories of the specified directory. The result corresponds to the number of
strings returned by the MMEMory:DCATalog:LENgth? command.

Query Parameters:
<PathName> String parameter
Specifies the directory.

Return values:
<FileEntry> String parameter
List of subdirectories separated by colons.

Example: MMEM:DCAT? “/USB_FRONT"
received “SCREENSHOTS", "DATA”

Usage: Query only

MMEMory:DCATalog:LENGth? <PathName>

Returns the number of directories in specified directory. The result corresponds to the number of
strings returned by the MMEMory:DCATalog? command.

Query Parameters:

<PathName> String parameter

Specifies the directory.

Return values:

<FileEntryCount> Number of directories.

Example: MMEM:DCAT:LENG? “/USB_FRONT"
received 2

Usage: Query only
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MMEMory:MDIRectory <DirectoryName>
Creates a new directory with the specified name.

Setting Parameters:
<DirectoryName> String parameter
Complete path including the storage device.

Example: Create directory DATA on the front USB flash device, with absolute
path:
MMEM:MDIR “/USB_FRONT/DATA"

Usage: Setting only

MMEMory:CDIRectory [<DirectoryName>]

Changes the default directory for file access.

Setting Parameters:

<DirectoryName> String parameter to specify the directory.
If the string also contains the storage device, the command
MMEM:MSIS is executed implicitely.

Example: MMEM:CDIR “/USB_FRONT/DATA"

MMEMory:RDIRectory <DirectoryName>

Deletes the specified directory. All subdirectories and all files in the specified directory and in the

subdirectories will be deleted. You cannot delete the current directory or a superior directory.

Setting Parameters:

<DirectoryName> String parameter
Example: MMEM:RDIR “/INT/TEST"”
Usage: Setting only

MMEMory:CATalog? <PathName>[,<Format>]

Returns the a list of files contained in the specified directory. The result corresponds to the
number of files returned

by the MMEMory:CATalog:LENgth? command.

Query Parameters:
<PathName> String parameter
Specifies the directory.

<Format> ALL | WTIMe
ALL: Extended result including file, date, time and attributes
WTIMe: Extended result including file, date, time
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Return values:

<UsedMemory> Total amount of storage currently used in the directory, in bytes.
<FreeMemory> Total amount of storage available in the directory, in bytes.
<FileEntry> String parameter
All files of the directory are listed with their file name, format and size in
bytes.
Example: MMEM:CAT? ,/INT/HELP/ENGLISH/* HTM'

Returns all english help files

Usage: Query only

MMEMory:CATalog:LENGth? <PathName>
Returns the number of files in the specified directory. The result corresponds to the number of
files returned by the MMEMory:CATalog? command.

Query Parameters:
<PathName> String parameter
Directoty to be queried

Return values:
<Count> Number of files.

Usage: Query only

MMEMory:COPY <FileSource>,<FileDestination>
Copies data between the instrument and a USB stick.

Setting Parameters:
<FileSource> String parameter
Name and path of the file to be copied.

<FileDestination> String parameter
Name and path of the new file. If the file already exists, it is overwritten

without notice.

Example: MMEM:COPY “/INT/SETTINGS/SETO01.SET",
“/USB_FRONT/SETTINGS/TESTSET1.SET”

Usage: Setting only
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MMEMory:MOVE <FileSource>,<FileDestination>
Moves an existing file to a new location.

Setting Parameters:
<FileSource> String parameter
Path and name of the file to be moved.

<FileDestination> String parameter
Path and name of the new file.

Example: MMEM:MOVE “/INT/SETTINGS/SET001.SET",
“"/USB_FRONT/SETTINGS”

Usage: Setting only

MMEMory:DELete <FileSource>
Removes a file from the specified directory.

Setting Parameters:
<FileSource> String parameter
Name and directory of the file to be removed.

Usage: Setting only

MMEMory:DATA <FileName>,<Data>
Stores data to the storage location specified using MMEMory:CDIRectory.

Parameters:

<Data> 488.2 block data
The block begins with character ,#'. The next digit is the length of the
length information, followed by this given number of digits providing
the number of bytes in the binary data attached.

Parameters for setting and query:
<FileName> String parameter
The name of the file the data is stored to.

Example: MMEM:DATA ,abc.txt’ #216This is the file
#2: the length infomation has two digits
16: the binary data has 16 bytes.
MMEM:DATA? ,abc.txt”
received: This is the file
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MMEMory:STORe:STATe <StateNumber>,<FileName>[,<msus>]
Saves the current device settings to the specified file.

Setting Parameters:
<StateNumber> State O (low) or 1 (high)1

<FileName> String parameter
Path and file name

<msus> Storage device (drive), see also MMEMory:MSIS

Usage: Setting only

MMEMory:LOAD:STATe <StateNumber>,<FileName>[,<msus>]
Loads the device settings from the specified file.

Setting Parameters:
<StateNumber> State 0 (low) or 1 (high)

<FileName> String parameter
Path and file name

<msus> Storage device (drive), see also MMEMory:MSIS

Usage: Setting only
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217 General Instrument Setup

(07N o] =) 1o 1 KSR OO PSRRI 203
CALIDIAtIONISTATE? ettt 203
DISPlay:LANGUAGE <LANQUAGES  ..iiiiiiiiieiiiii ettt 204
SY S TeM N AN E o e 204
SYSTem:DATE <Year>,<Month>,<Day> ..o 204
SYSTem:TIME <Hour>,<Minute>,<SECONA>  ...i.iiiiiiiiiiiiiii e 204
R S 1= Ta T 2 = USRI 205
SYSTEMISET <SBIUDS et 205
S S e E R RO N E X T 2 e e 205
SY STEMIERROIALL? et 205
SY ST PRESE .o 205
SYSTem:COMMUNIcate:PRINEICSET oo 206
SYSTeM:BEEPEI:IMMEAIATE]  oeevee e 206
SYSTEeM:BEEPEITRIGISTATE oo e 206
SYSTem:BEEPErCONTIOLSTATE vt 206
SYSTem:BEEPErERROISTATE ..o 206
SYSTem:EDUCAtiON:PRESET .o 206
CALibration

Calibration starts the self-alignment process. It can take several minutes. Calibration? returns
information on the state of the self-alignment. Return values # 0 indicate an error.
Same as *CAL?.

Return values:
<SelfAlignment> Numeric status indicator

CALibration:STATe?
Returns the overall state of the self-alignment.

Return values:
<SelfAlignmentState> NOALignment | RUN | ERRor | OK | ABORt

NOALignment: No self-aligment was performed.

RUN: Self-aligment is running.
ERRor: Error occured.
OK: Self-aligment has been performed successfully.
ABORt: Self-aligment has been cancelled.
Usage: Query only
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DISPlay:LANGuage <Language>
Sets the language in which the softkey labels, help and other screen information can be
displayed. Supported languages are listed in the ,Specifications” data sheet.

Parameters:

<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |
TCHinese
*RST: Reset does not change the language

SYSTem:NAME

Defines an instrument name.

Parameters:

<Name> String with max. 20 characters

SYSTem:DATE <Year>,<Month>,<Day>
Specifies the internal date for the instrument.

Parameters:

<Year> Default unit: a

<Month> Range: 1to 12

<Day> Range: 1 to 31
Default unit: d

Usage: SCPI confirmed

SYSTem:TIME <Hour>,<Minute>,<Second>
Specifies the internal time for the instrument.

Parameters:

<Hour> Range: 0 to 23
Default unit: h

<Minute> Range: 0 to 59
Default unit: min

<Second> Range: 0 to 59
Default unit: s

Usage: SCPI confirmed
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SYSTem:TREE?
Returns a list of implemented remote commands.
Usage: Query only
SYSTem:SET <Setup>

Defines or queries the device settings that can be saved and load manually with
SAVE/RECALL --> Device Settings.

Parameters:
<Setup> 488.2 block data
Usage: SCPI confirmed

SYSTem:ERRor:[NEXT]?

Queries the error/event queue for the oldest item and removes it from the queue. The response
consists of an error number and a short description of the error. Positive error numbers are
instrument-dependent. Negative error numbers are reserved by the SCPI standard.

Return values:
<Error> Error/event_number,“Error/event_description>[;Devicedependent info]”
If the queue is empty, the response is 0,”No error”

Usage: Query only
SCPI confirmed

SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.

The response is a comma separated list of error number and a short description of the error in
FIFO order. Positive error numbers are instrument-dependent. Negative error numbers are
reserved by the SCPI standard.

Return values:

<Error> List of:
Error/event_number, “Error/event_description>[;Devicedependent info]”
If the queue is empty, the response is 0,”No error”

Usage: Query only
SCPI confirmed
SYST:PRESet

Resets the instrument to the default state, has the same effect as *RST.

Usage: Event
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SYSTem:COMMunicate:PRINter:CSET
Sets the printer language that is supported by the printer.

Parameters:
<CommandSet> PCL5 | PCLXI | PS

PCLXI: PCL XL

PS: Postscript
SYSTem:BEEPer[:IMMediate]
Generates an immediate beep.
Usage: Event
SYSTem:BEEPer:TRIG:STATe
Enables or disables the beep if a trigger occurs.
Parameters:

<TriggerBeep> ON | OFF

SYSTem:BEEPer:CONTrol:STATe
Enables or diables a sound for general control events, e.g. reaching the rotary encoder end or
changing the measuring mode in the ,,Auto Measure” menu.

Parameters:

<ControlBeep> ON | OFF
SYSTem:BEEPer:ERRor:STATe

Enables or disables the beep if an error occurs.
Parameters:

<ErrorBeep> ON | OFF
SYSTem:EDUCation:PRESet

Deletes the password of the education mode.

Usage: Event
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2.18 Status Reporting

2.18.1

STATus:OPERation Register

The commands of the STATus:OPERation subsystem control the status reporting structures of
the STATus:OPERation register:

See also:

e chapter 1.6.1, ,Structure of a SCPI Status Register”

e  STATus:OPERation Register”

The following commands are available:

STATUS:OPERAtIONICONDITION?  eeeiieieeee et 207
STATUS:OPERatiON:ENABIE <ENADIE>  ...oiiiiiieiiiiieiiiiie e aeeeveaeeeanees 207
STATus:OPERation:NTRansition <NegativeTransition>  .....cviiiiiieeiiiiee e 207
STATus:OPERation:PTRansition <PositiveTranSItioN>  .........ueeeeiiiiiiiiiiiiiiiieierererererereeeeerereeeeenn. 207
STATUS:OPERAION[EVENT 2 e 208

STATus:OPERation:CONDition?
Returns the of the CONDition part of the operational status register.

Return values:

<Condition> Condition bits in decimal representation. ALIGnment (bit 0) ,
SELFtest (bit 1),
AUToset (bit 2), WTRigger (bit 3).
Range: 1 to 65535

Usage: Query only

STATus:OPERation:ENABIle <Enable>

Parameters:
<Enable> Range: 1 to 65535

STATus:OPERation:NTRansition <NegativeTransition>
Parameters:

<NegativeTransition>  Range: 1 to 656535
STATus:OPERation:PTRansition <PositiveTransition>

Parameters:
<PositiveTransition> Range: 1 to 65535
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STATus:OPERation[:EVEN{t]?

Return values:
<Event> Range: 1 to 65535

Usage: Query only

2.18.2 STATus:QUEStionable Registers

The commands of the STATus:QUEStionable subsystem control the status reporting structures of
the STATus:QUEStionable registers:

0 | CHAMnel1 0 | TEMP WARM
1 | CHAMnElZ 1 | TEMF ERFar
2 2
3 3
4 4
5 ]
6 £
T 7
B8 3
o g
10 10
11 11
12 12
STATus:QUEStionable 13 13
14 14
0 15 15
1
2 . . . .
3 | coverload ;]STAT.GUEB.CDU §STAT.QUES.TEW
4 | TEMPerature
5
G
T
8 | NOALigndata
o | LI
1 éSTAT:QUEE:LIH
STAT:QUES:MASK
13 MASK MASKA MEAS1
14 MEASZ
15

P
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@mﬂmm#mm_uc\;

]
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2
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5

A

7

]

]
10
1
12
13
14
15

Fig. 2.1: Structure of the STATus:QUEStionable register

See also:
e chapter 1.6.1, , Structure of a SCPI Status Register”
e  STATus:QUEStionable Register”
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The following commands are available:

STATUSIPRESET oo 209
STATUS:QUEStIONable:CONDITION?  .oiiiiiiii it 209
STATus:QUEStionable:COVerload:CONDITION? ..o 209
STATUS:QUEStionable: LIMIit:CONDITION?  ...uuuiiiiiiieiiietiieieieieieeeieeeteaeesessessessesesesesesssssaseeareeeeeaaae 209
STATUS:QUEStionable:MASK:CONDITION?  ..uuiiieiiieiieeieieieeeieeeeeeeeeeeeeeeeaeeeaeeeaeaseeseassnsnseseseennnnes 209
STATus:QUEStionable:ENABIE <ENaDIE>  ....oeiieiii e 209
STATus:QUEStionable:COVerload:ENABIe <ENable>  .......veeiiiiiiiiiiiiiiiiiiiiiveevvveeveaes 209
STATus:QUEStionable:LIMit:ENABle <Enable> ... 209
STATus:QUEStionable:MASK:ENABIe <Enable> ... 209
STATUS: QUESHIONADIE i EVENT]? oo 210
STATus:QUEStionable:COVerload:EVENT]? e 210
STATus:QUEStionable:LIMIt[:EVENT]? oo 210
STATus:QUEStionable:MASKLEVENL]? e 210
STATus:QUEStionable:NTRansition <NegativeTransition>  ......ccccccoeiiiiiiiiiiiiec e 210
STATus:QUEStionable:COVerload:NTRansition <NegativeTransition>  ..........cccocvviiiiiieiiiinnnnn, 210
STATus:QUEStionable:LIMit:NTRansition <NegativeTransition>  .......ccccciieiiiiiiiiiiieeee e 210
STATus:QUEStionable:MASK:NTRansition <NegativeTransition>  .......ccccccciiiiiiiiiiieiieeen, 210
STATus:QUEStionable:PTRansition <PositiveTranSitionN>  .........uuuviiiiiiiiiiiiiiiiiiiieeiveiiveeiveieieeennnns 211
STATus:QUEStionable:COVerload:PTRansition <PositiveTransition>  ........cccccccvvvvvveiineeriieinnnns 211
STATus:QUEStionable:LIMit:PTRansition <PositiveTransition>  ........ccccccvvvvvvvvrieriiiiieeieiereieinnnnns 211
STATus:QUEStionable:MASK:PTRansition <PositiveTransition>  ........ccccccvvvvvvvevereieieiieererereennenns 211

STATus:PRESet
Resets all STATUS:QUESTIONALBLE registers.

Usage: Event

STATus:QUEStionable:CONDition?

STATus:QUEStionable:COVerload:CONDition?
STATus:QUEStionable:LIMit:CONDition?

STATus:QUEStionable:MASK:CONDition?

Returns the contents of the CONDition part of the status register to check for questionable in-
strument or measurement states. Reading the CONDition registers does not delete the contents.

Return values:
<Condition> Condition bits in decimal representation
Range: 1 to 65535

Usage: Query only

STATus:QUEStionable:ENABIle <Enable>

STATus:QUEStionable:COVerload:ENABIe <Enable>
STATus:QUEStionable:LIMit:ENABIe <Enable>
STATus:QUEStionable:MASK:ENABIle <Enable>

Sets the enable mask that allows true conditions in the EVENt part to be reported in the sum-
mary bit. If a bit is set to 1 in the enable part and its associated event bit transitions to true, a
positive transition occurs in the summary bit and is reported to the next higher level.

e
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Parameters:

<Enable> Bit mask in decimal representation
Range: 1 to 65535

Example: STATus:QUEStionable:MASK:ENABIe 24

Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:ENABIe register
part: 24 =8 + 16 =23 + 24

STATus:QUEStionable[:EVENt]?

STATus:QUEStionable:COVerload[:EVENt]?

STATus:QUEStionable:LIMit[:EVEN{t]?

STATus:QUEStionable:MASK[:EVENt]?

Returns the contents of the EVENTt part of the status register to check whether an event has
occurred since the last reading. Reading an EVENTt register deletes its contents.

Return values:
<Event> Event bits in decimal representation
Range: 1 to 65535

Usage: Query only

STATus:QUEStionable:NTRansition <NegativeTransition>
STATus:QUEStionable:COVerload:NTRansition <NegativeTransition>
STATus:QUEStionable:LIMit:NTRansition <NegativeTransition>
STATus:QUEStionable:MASK:NTRansition <NegativeTransition>

Sets the negative transition filter. If a bit is set, a 1 to 0 transition in the corresponding bit of the
condition register causes a 1 to be written in the corresponding bit of the event register.

Parameters:
<NegativeTransition>  Bit mask in decimal representation
Range: 1 to 65535

Example: STATus:QUEStionable:MASK:NTRansition 24
Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:NTRansition
register part: 24 =8 + 16 = 23 + 24
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STATus:QUEStionable:PTRansition <PositiveTransition>
STATus:QUEStionable:COVerload:PTRansition <PositiveTransition>
STATus:QUEStionable:LIMit:PTRansition <PositiveTransition>
STATus:QUEStionable:MASK:PTRansition <PositiveTransition>

Sets the positive transition filter. If a bit is set, a 0 to 1 transition in the corresponding bit of the
condition register causes a 1 to be written in the corresponding bit of the event register.

Parameters:
<PositiveTransition> Bit mask in decimal representation
Range:1 to 656535
Example: STATus:QUEStionable:MASK:PTRansition 24

Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:PTRansition
register part: 24 =8 + 16 =23 + 24
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3 SCPI Commands

in alphabetic order

ACQUIre:AVERAGEICOMPIEIE? ittt ettt ettt et e et et et e naeeeeeas 35
ACQuire:AVERage:COUNt <AVErageCoOUNT>  ...oiiiiiiiii i 35
ACQuire:FILTer:FREQency <FilterFrequency> ... 37
ACQuire:HRESoIUtion <HIGhRES> .o 39
ACQuire:INTerpolate <INterpolatioN> ......iiiiiiiiiii e 35
ACQuUIire:MODE <ACqUISIIONMOUE>  ..uiiiiiiiiiiiiiie e 34
ACQuire:PEAKdetect <PeakDeteCt>  ......oiiiiiiiiiii e 39
ACQUITEIPOINTSIARATE? e 38
ACQUIre:POINTS[IVALUBL? oo 36
ACQUITEISRATE? oo 38
ACQUIre:STATE <AQUISITION STATE>  oiiiiiiiiiii i e e ae e e e 38
ACQUIre:TYPE <AQUISITION TYPE> oottt 38
ACQuire:WRATe <WaveformBRates> ... 35
AUTOSCAIE e et 34
BUS<b>:CAN:BITRate <BItRAte> ..o 174
BUS<b>:CAN:DATA:SOURCE <SOUICES>  .oviiiiieiee e 173
BUS<D>ICANIFCOUNT? oo e 177
BUS<b>:CAN:FRAME<N>:ACKStAtE?  ..iiiceiiiiicec e 179
BUS<b>:CAN:FRAME<N>:ACKVAIUE? ..o 181
BUS<b>:CAN:FRAME<N>:BCOUNT? .t 183
BUS<b>:CAN:FRAME<N>:BSEPOSITION?  ...iiiiiiiiiiee e 182
BUS<b>:CAN:FRAME<N>:BYTE<O>:STATE? oo 183
BUS<b>:CAN:FRAME<N>:BYTE<O>VALUE?  .ooiiiiiiiieiee e 183
BUS<b>:CAN:FRAME<N>ICSStAtE?  ..ooiiiieeiei e 180
BUS<b>:CAN:FRAME<N>:CSVAlUB?  ..oiiieeiieeee e 181
BUS<b>:CAN:FRAME<N> DATA? o e 179
BUS<b>:CAN:FRAME<N>:DLCSTAtE?  .ovviiiiiiiiiiiee e 180
BUS<b>:CAN:FRAME<N>:DLCVAIUE?  ..oreiiieiiii e 181
BUS<b>:CAN:FRAME<N>IDSTAtE? ..o 180
BUS<b>:CAN:FRAME<N>IIDTYDE? oo 182
BUS<b>:CAN:FRAME<N>:IDVAIUE?  ..ooiiieieiieee e 182
BUS<b>:CAN:FRAME<N>STARL? oo 178
BUS<b>:CAN:FRAME<N>STATUS?  .oeiiieieeiee et 178
BUS<b>:CAN:FRAME<N>:STOP? L e 178
BUS<b>:CAN:FRAME<N> TYPE? e 179
BUS<b>:CAN:SAMPIlepoint <SamplePoint> ... ... 174
BUS<b>:CAN:TYPE <SignalTyPes>  oeiiiiiiii et 173
BUS<b>:CPARallel:CLOCK:SLOPE ..o 143
BUS<b>:CPARallel:CLOCK:SOURCE  ...eiieieieee e 143
BUS<b>:CPARAIIBECS:POLAIITY  .veieiieieeeeeeee e 144
BUS<b>:CPARAIIEECS:SOURCE  ...oeeioeeeeeeeee e 144
BUS<b>:CPARallel:DATA<M>:SOURCE  ..oiiiiiiiiii e 143
BUS<b>:CPARAIEEWIDTR ..o 144
BUS<b>:DSIGNals <BitSSIgNalss>  ....ooiiiiiiiiiice e 141
BUS<b>:DSIZE <DISPIaYSIZE>  wooveeiieee e 140
BUS<b>:FORMATL <FOIMAts> ittt 140
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BUS<D>I2CAMODE ..o 156
BUS<b>:12C:CLOCK:SOURCE <SOUIMCES  .vviiiiieeiec e 156
BUS<b>:12C:DATA:SOURCE <SOUICES  wiriiiiiiiiiiiiiii et 156
BUS<bh>II2CFCOUNT? oot 159
BUS<b>12C:FRAME<N>IAACCESS? .ot 161
BUS<b>12C:FRAME<N> IACCESS? oo 160
BUS<b>:12C:FRAMeE<N>ACOMPIEIE?  ..ooveeeiiiiceee e 163
BUS<b>:12C:FRAME<N>ADBSIAI? ittt ettt 162
BUS<b>:12C:FRAME<N>:ADDRESS?  ..ooi i 161
BUS<b>:12C:FRAME<N>:ADEVICE? oo 162
BUS<b>:12C:FRAMe<N>AMODE? . 161
BUS<b>12C:FRAME<N>IASTAIM? oo 162
BUS<b>:12C:FRAMe<nN>BCOUNT? oo 163
BUS<b>:12C:FRAMe<nN>BYTE<OSACCESS? oottt 165
BUS<b>:12C:FRAMe<n>:BYTE<OSACKSTArt? .....ocooiiiioeiee e 164
BUS<b>:12C:FRAMe<n>:BYTE<O>COMPIEIE?  ..oiiviiiiiceee e 165
BUS<b>:12C:FRAMe<n>:BYTE<O>STARL? . e 164
BUS<b>:12C:FRAMe<n>:BYTE<O>VALUE? ..o 164
BUS<b>112C FRAME<N> I DATA? e 163
BUS<b>:12C: FRAME<N>:STARL? oo 159
BUS<b>12C:FRAME<N> ISTATUS? oottt e s 159
BUS<b>:12C:FRAME<N>:STOP? oo 160
BUS<b>:LABEl <Label> oo 141
BUS<b>:LABEISTATE <STAtE>  .oviiiiiiiiie e 141
BUS<b>:LIN:BITRate <BItRAtE> ......cooiiiiiieie e 185
BUS<b>:LIN:DATA:SOURCE <SOUIMCES  .uviiiiiiiiiiiiiii et 184
BUS <D LINIFCOUNT? oo 188
BUS<b>:LIN:FRAMe<n>BCOUNT? .o i 188
BUS<b>:LIN:FRAME<N>BCOUNT? oot 192
BUS<b>:LIN:FRAME<N>:BYTE<O>:STATE? . oiioiiiiiee e 192
BUS<b>:LIN:FRAME<N>:BYTE<O>:VALUE? . eeeiiiiieee e 193
BUS<b>:LIN:FRAME<N>ICSSTAtE?  ...ooiiiieiei e 191
BUS<b>:LIN:FRAME<N>ICSValUB? . 192
BUS<b>:LIN:FRAME<N> DATA? oo e 190
BUS<b>:LIN:FRAME<N>:IDPVAIUE?  ..ooiiiieoe e 191
BUS<b>:LIN:FRAME<n>:IDSTate <ldentifierState> ......ccccooviiiiiiiiiiee e 190
BUS<b>:LIN:FRAME<N>:IDVAIUE?  .oeeoiiieeeeeee e 190
BUS<b>:LIN:FRAME<N>:STARL? oo 189
BUS<b>:LIN:FRAME<N>ISTATUS? e 188
BUS<b>:LIN:FRAME<N>:STOP? .o e 189
BUS<b>:LIN:FRAME<N>ISYSTAtE? ot 191
BUS<b>:LIN:FRAME<N>:VERSION? ..o 189
BUS<b>:LIN:POLarity <POlarity> ..ot 185
BUS<b>:LIN:STANdard <Standards> ......ocoiiiiiicice e 185
BUS<b>:PARallel:DATA<mM>:SOURCE <SOUICE> ...iiiiiiiiiiiiiiiiiee et 142
BUS<b>:PARallel:WIDTh <BUSWIAth> ..o 142
BUS<b>:POSItioN <POSITION  .oiiiiiiiiiiiii 141
BUS<b>:SPI:BORDEr <BitOrder> ...oooiiiiiiieii e 147
BUS<b>:SPI:CLOCK:POLarity <Polarity> ... 146
BUS<b>:SPI:CLOCK:SOURCE <SOUICE> ..iiiiiiiiiiiiiee 146
BUS<b>:SPI:CS:POLarity <POIArity> oo 146
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BUS<b>:SPI:CS:SOURCE <SOUICE> ittt 145
BUS<b>:SPIDATA:POLarity <POlarity> ..o 147
BUS<b>:SPI:DATA:SOURCE <SOUICES  .iriiiiiiiiiiiiiii ettt 147
BUS<BD>1SPEFCOUNT? oo 149
BUS<b>:SPEFRAME<N> DATA? e 150
BUS<b>:SPEFRAME<N>:STARL? oo 150
BUS<b>:SPIFRAME<N> ISTATUS? oottt 149
BUS<b>:SPI:FRAMe<n>:STOP <StOpTIME>  ooiiiiiiie i 150
BUS<b>:SPLEFRAMe<n>:WCOUN? ..o 151
BUS<b>:SPI:FRAMe<n>:WORD<0>MISO? .. e 152
BUS<b>:SPI:FRAMe<n>:WORD<0O>MOSI? . 152
BUS<b>:SPI:IFRAMe<n>:WORD<O>STARL? ..o 151
BUS<b>:SPI:IFRAMe<n>:WORD<0>STOP? ..o 151
BUS<b>:SPI:SSIZe <SYMDOISIZES oo 148
BUS<b>:SSPI:BITime <BUrstldIeTIME>  ..voiiiiiiiiiiiie e 154
BUS<b>:SSPI:BORDEr <BitOrders> ....ooiiiiiiie e 154
BUS<b>:SSPI:CLOCK:POLarity <Polarity>  ....oooiiiiiiieie e 153
BUS<b>:SSPI:CLOCK:SOURCE <SOUMCE>  ..iiiiiiiiiiiiiiee et 153
BUS<b>:SSPI:DATA:POLarity <POIArity> ..o 154
BUS<b>:SSPIIDATA:SOURCE <SOUIMCE>  .oiiiiiiiiiieeee e 163
BUS<b>:SSPI:SSIZe <SymbolSize> ..o 155
(1T o D AN [T ¢= ) (= R 139
BUSKD>TYPE <TYPE> oo e 140
BUS<b>:UART:BAUDrate <Baudrates> .......coiiiiiiiiiiii it 168
BUS<b>:UART:BITime <BuUrstldleTimes> ... 168
BUS<b>:UART:DATA:POLarity <Polarity> ... 166
BUS<b>:UART:DATA:SOURCE <SOUICE>  .iiiiiiiiiiei e 166
BUS<bh>1UARTFCOUNT? e 170
BUS<b>:UART:FRAMeE<n>WCOUNT? . oot 170
BUS<b>:UART:FRAMe<n>:WORD<0>:STAR? .. oo 171
BUS<b>:UART:FRAMe<n>:WORD<0>:STATE? ..ot 171
BUS<b>:UART:FRAMe<n>:WORD<0>:STOP? ... e 171
BUS<b>:UART:FRAMe<n>WORD<O>VALUE? ...oiiiiiiiiieee e 170
BUS<b>:UART:PARItY <Parity> ..o 167
BUS<b>:UART:SBIT <StopBIitNUMDBEr> ... e 167
BUS<b>:UART:SSIZe <SymboISizes> ... 167
B A L e 28
CALCulate:MATH<m>:ARIThmetics <ArthmetiCS> ......cccoiiiiiiiiiiiieci e 111
CALCUIAtEMATH M > D AT A ? et 99
CALCulate:MATH<mM>:DATAIENVEIOPE?  ..oeeeiiiiieeieeee e 100
CALCulate:MATH<m>:DATA:ENVelope:HEADEI? ..o 101
CALCulate:MATH<m>:DATA:ENVElope: XINCrement?  .......ueeeeeieieieieieieieeiieieieieeeeeeseeeeeeveeeennenes 101
CALCulate:MATH<mM>:DATA:ENVelope: XORIGIN?  oiiiiiiiiiiieeiieeee et 101
CALCulate:MATH<m>:DATA:ENVelope:YINCrement? ......ccccccvviiiieiiiiiiiiiiieeee e 102
CALCulate:MATH<m>:DATA:ENVelope:YORIGIN? ..o, 102
CALCulate:MATH<m>:DATA:ENVelope:YRESOIUtION? ..o 102
CALCulate:MATH<M>:DATAIHEADEI? .o 99
CALCulate:MATH<mM>:DATAXINCIrEMENT? ..o 103
CALCulate:MATH<mM>:DATAXORIGIN? oo 103
CALCulate:MATH<mM>:DATAYINCIrEMENT?  ..oiiiiiiiieecee e 103
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CALCulate:MATH<M>:DATAYORIGIN? oo 104
CALCulate:MATH<mM>:DATAYRESOIUTION?  1oiiiiiiiiiiiice e 104
CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplEXpr> . .ccoociiiiiiiiiiiiiiceciiiee. 98
CALCulate:MATH<m>:FFT:AVERage:COUNL ..ot 112
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJUStEd?  ........evveiiiiiiieiiiiiiieiieeieieiees 112
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:AUTO <SpanRBWCoupling> .............. 113
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBWRatio> .........cccccuuv.e. 113
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <ResolutionBW> ................... 113
CALCulate:MATH<m>:FFT:CFRequency <CenterFreqs> .....ccocoiiiiiiiiiiiiiiieeeccccieeee e 113
CALCulate:MATH<M>FFTIFULLSPAN oottt 113
CALCulate:MATH<mM>:FFT:MAGNItUde:SCALE .. oo 112
CALCulate:MATH<mM>:FFT:SPAN <FreqSpan=> ... 14
CALCulate:MATH<m>:FFT:SRATe? <Sample_Rate> ... 115
CALCulate:MATH<mM>:FFT:STARt <StartFreq>  .oooviiiiiiiiieeeeeeeeeeaeeeaeaes 14
CALCulate:MATH<mM>:FFT:STOP <StopFreqs> ... 114
CALCulate:MATH<m>:FFT:TIME:POSition <Window_Position> .......cccccciiiiiiiiiiiiiccee e 115
CALCulate:MATH<m>:FFT:TIME:POSition <Window_Width> ........ccccciiiiiiii, 116
CALCulate:MATH<m>:FFT:TIME:Range <Window_Position> ........cccccciiiiiiiiiiiiiiiieceeecc 116
CALCulate:MATH<m>:FFT:TIME:RANGe <Window_Width> ... 115
CALCulate:MATH<m>:FFT:WINDowW:TYPE <WINdOWTYPE> ....ovviiiiiiiiiiiiiiiee e 114
CALCulate:MATH<mM>:LABEl <Label> .. oo, 100
CALCulate:MATH<mM>:LABEL:STATE <State>  .oooiiiiiiiie e 100
CALCulate:MATH<mM>:POSItion <POSItION> .. ..o 98
CALCulate:MATH<M>:SCALE <SCAlE>  iiiiiiiiiiii e 97
CALCulate:MATH<M>:STATE <STAtE> oot 97
CALCUIATE I AM AT N D AT A ? et 94
CALCulate:QMATIDATAIHEADEI? oo 95
CALCulate:QMATh:DATAIXINCIEMENT? .o 95
CALCulate: OMATHh:DATAXORIGIN? oo 95
CALCulate:QMATH:DATAIYINCIEMENT? oot 95
CALCulate:QMATNDATAIYORIGIN? oottt 96
CALCulate:QMATh:DATAIYRESOIUTION? it 96
CALCulate:QMATh:OPERation <Operation=> ......cooiiiiiiiiiiiieiie e 94
CALCUlate:QMATNIPOSIHION it 94
CALCUIAtEIQMATNISCALE oo 94
CALCulate:OMATN:SOURCE SM> oo 93
CALCuUlate:QMATNISTATE <STATE>  oiiiiiiiiiiiiii et e et e e e e e tabreee s 93
(07 I o] = (o o SRS 203
CALIDIAtIONISTATE? ettt e 203
CHANRNel<m>:ARIThmetics <TrAMthMETIC> ..ot 37
CHANnNel<m>:BANDwidth <BandwidthLimit> ... 42
CHANNEel<mM>:COUPHNG <COUPINGS  ooiiiiiiiii et 40
CHAN N M S D AT A et e e oottt e e e e e ettt e e e e e e et bt e e e e e e e sstbbaeaaeens 51
CHANRNEl<M > DATAIENVEIOPE? oottt 53
CHANRNel<m>:DATAENVEIOPeHEADEI? oo 54
CHANRNel<m>:DATAENVelope: XINCIremeNt? ..ot 54
CHANRNel<m>:DATAIENVelope: XORIGINT oot 54
CHANRNel<m>:DATAENVelope:YINCIrement? ..o 55
CHANnNel<m>:DATAENVEIOPE:YORIGIN? oo 55
CHANRNel<m>:DATA:ENVelope:YRESOIUTION? o oo 55
CHANRNEI<M > DATAIHEADEI? oottt abre e e s 52
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CHANRNEel<mM>:DATAIPOINTS <POINTS>  .iiiiiiiiiiiiiiiiiie e 56
CHANRNEl<mM>:DATAIXINCIEMENT? oottt e et 52
CHANRNEl<mM > DATAIXORIGIN? et 52
CHANRNEl<mM>:DATAIYINCIEMENT? oottt 53
CHANNEI<M>DATAIYORIGIN? oottt e et e e 53
CHANRNEl<mM>:DATANYRESOIUTION? oo 53
CHANRNEl<M>LABEl <Lab@l> i 44
CHANRNEl<mM>:LABELSTATE <SIAtE> oottt 44
CHANRNEl<mM>:0FFSet <OffSET>  oiiiiiiiiiii e 41
CHANRNel<m>:0OVERIoad <OVErIoad> ..o 42
CHANRNel<m>:POLarity <POIArity> ... 42
CHANRNEl<mM>:POSItION <POSITION>  ..iiiiiiiiiiee e 41
CHANNEl<M>RANGE <RANGE>  .ooiiiiiiiiiie e 41
CHANRNEISM>:SCALE <SCAIE> oottt ea s 41
CHANNEI<M>ISKEW <SKEW> oo 43
CHANRNEISM>ISTATE <STATE> 1ottt e e 40
CHANRNel<m>:THReShOId:FINDIEBVEI ..o 43
CHANnNel<m>:THReshold:HYSTeresis <ThresholdHysteresis> .......ccoccviieiiiiiiiiiieecceecciiee. 43
CHANnNel<m>:THReshold <Threshold> ... 43
CHANRNel<m>:TYPE <DecimationMOde>  ......oooiiiiiiieee e 36
SO S TSRS 28
COMPonenttest:FREQUENCY <FrEQUENCY>  ...viiiiiiiiiiiiiiieieiiieieieieeeieterereeeeeeeeesesesssesssesnseresessnenes 134
COMPONENTIESTSTATE <STATE>  oiiiiiiiiieii it e e e et 134
(01U Yo R o P AN O o SRS 79
CURSOr<mM>:FUNCHION STYPE> ottt ettt 80
CURSOIr<M>IRESUI? oottt 84
CURSOIr<mM>ISNPEAK<N> oo 81
CURSOr<mM>:SOURCE <SOUMCE>  ..oiiiiiiiiitie e 81
CURSOIr<mM>ISPPEAK<N> oot 82
CURSOIr<M>ISSCREEN oottt e e e e e e e taraaaa s 81
CURSOIr<mM>:STATE <STAtE> oottt et e e 79
CURSOI<M>ISWAVE oottt 81
CURSor<m>:TRACKING:SCALE[:STATE] <STate>  oiviiiiiiiiiieiiie et 83
CURSor<m=>:TRACKING[:STATE] <STAtE>  iiiiiiiiiiiiiiciie et 82
CURSor<m>:XTPosition <XpoSItioNT> i 82
CURS0r<m>:X2P0Sition <XPOSIIONZ2>  oiiiiiiiiii et 82
CURSor<m=>:X3P0oSsition <XPOSIION3>  iiiiiiiiiiiiiiiit ettt 82
CURSor<m=>:XCOUPHNG <COUPING>  coiiiiiiiiiiie et 84
CURSOr<m>:XDELLIAIINVEISE? ..ot 84
CURSOr<mM > XD E LA VA LU ? oo 84
CURsor<m=>:XRATIO:UNIT <UNIT> oo 85
CURSOI <M= X RATIO IV A LU ? e 85
CURSor<m>:YTP0oSItioN <YPOSITIONT > oiiieiiiiiei ittt 83
CURSOor<m=>:Y2P0Sition <YPOSIION2>  ..oiiiiiiiiiieie e 83
CURSor<m=>:Y3P0osition <YPOSItIONS>  ooiiiiiiiiiiiiiiiiiie ettt 83
CURSor<m=>:YCOUPIING <COUPIINGS  1oiiiiiiiiiiie ettt 84
CURSOr<mM>:YDELta:SLOPE? ..ot 85
CURSOr<mM > Y DELLA[:VALUE]? oo 85
CURSor<m>:YRATIO:UNIT <UNIT> oo 86
CUR SO Y R AT O A LU 2 e 86
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DISPIaY:DIALOGICLOSE oo e 73
DISPlay:DIALog:MESSage <MessageText> .....cciiiiiiiiiiiiiiiiiii e 73
DISPlay:DIALog: TRANSparency <TranNSParENCY> ......ccciciiiiiuiiiieeeeeeiiiiiiee e e e e e eeiiee e e e eeiiaraee e 73
DISPIay:GRID:ISTYLE <StYIE> oot 76
DISPlay:INTensity:BACKIGht <INtENSITY>  1oviiiiiiiiieiiiee e 75
DISPlay:INTensity:GRID <INt@NSItY> .o 75
DISPlay:INTensity:WAVeform <InNtenSity> ..o 74
DISPIAYILANGUAGE  .oiiiiiiiiiiei ettt e et e e e e e et e e e e e e et bt e e e e e e e taraaaae s 73
DISPIaY:LANGUAGEIADD oottt ettt ettt ettt et e bt e e et e e e eeenae e 74
DISPIay:LANGUAGE:CATAIOF? et 74
DISPlay:LANGUAgE <LanNQUAGE>  ..iiiiiiiiiiiiiee ettt 204
DISPIay:LANGUAGEIREMOVE ittt 73
DISPIay:MODE <MOGE> ..o 71
DISPlay:PALEttEe <Palettes> oo 72
DISPIay:PERSISTENCEICLEAr ..o 76
DISPlay:PERSistence:INFinite <INfPersistence> ......cccccciiiiiiiiiiiicccc e 76
DISPlay:PERSIStENCE:STATE <STATE>  1iiiiiiiiiiii e 75
DISPlay:PERSistence: TIME:AUTO <AULO>  oviiiiiiiiiicitc ettt 76
DISPlay:PERSIstence:TIME <TiMe> oo 75
DISPIAY I STYLE <O Y E> oo 76
DISPlay:VSCReen:ENABIe <ENable> ..o 72
DISPlay:VSCReen:POSItion <POSItION> ..o 72
DISPIay:XY: XSOUICE SSOUICES  wiiiiiiiiiiiiiiie ettt e e e e et e e e e e e aaraa e e s 74
DISPIaY: XY Y TSOUINCE SSOUMCES  .iiiiiiiiiiiiiiii ettt e e e traae e 74
DVIMIENABIE ettt ettt ettt e sttt e et e et e et e et e et e et e et e e etaeenabe e 131
DVM <> RESUR L ACTUAI? e e 131
DVM<m>RESURLEACTUAI? oo 133
DVM<m>:RESUR[:ACTUAI:STATUS? oo 132
DVM<mM>:RESUITRESET oo 132
DVM<MSISOURCE ottt e e e e et aa s 131
DAY B g Pl I o PP PP PPRRURTP 130
DVIMIPOSITION  otiiiiii ettt ettt e e sttt e et e st e e stb e e et e e stb e e etbeesnbesetaeesabeea 133
FESE <VaAlUB> e 29
B S R 2 ettt et e et ere e 29
EXPort:WAVeform:NAME <FIlENAME>  ..ooiiiiiiiiiii e 59
EXPOrtVWAVETOIMISAVE e 59
EXPort:WAVeform:SOURce <WaveformSourCe> .....cccoiiiiiiiiiiiiee e 58
EXTErNICOUPIING oottt e e et e e 135
[ Q=10 g H AN A P PR RSP 137
EXTern:DATAHEADEI? e 138
EXTEIrNIDATAIPOINTS oo 137
EXTern:DATAIXINCIEMENT? ..o 138
EXTern:DATAIXORIGIN? oottt e et e e e e ettt e e e e e s e tabraae s 138
EXTErn:DATAIYINCIEMENT? oottt ettt e e et e e et e e e e ret e e et e e s enaeees 138
EXTErN:DATAIYORIGIN? oottt ettt ettt sttt ettt e et e st e e st e e etbeesnbe s etaeennbeeas 139
EXTern:DATA:YRESOIUTION? .. 139
EXTIrNIPOSITION e 135
EXTEINISIZE oo 136
EX TN STATE] oo 135
EXTErn:THRESNOIA oo 136
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[ Q=T 2 L e = SO SOO P PP P RRRR PRSPPI 136
FORMat:BORDEr <BYtEOIUEI>  ..oiiiiiiiiiiiiiie e 58
FORMat[:DATA] <DataFormat>, <ACCUIACY> ..iiiiiiiiiiiie ettt 57
GENerator:FREQUENCY <FreqUENCY>  .oiiiieiieiieee e 123
GENerator:FUNCHON <FUNCHIONS  ..ooiiiic e, 122
GENerator:FUNCHION:PULSEIDCYCIE  oiiiiiiiiiiieeee et 123
GENerator:FUNCtion:RAMP:POLarity <Polarity> . .occoiiiiiiiiiiiec e 123
GENerator:QUTPULENABIE] oo 124
GENerator:-VOLTage <AMPIITUAE>  ..ooiiiiiiii et 123
GENerator:VOLTage:OFFSet <OffSEt>  .viiiiiiiiiiiii e 123
HCOPy:COLOR:SCHeme <ColorSChemes> ... 195
[ (OX @ LV I A AN SR 193
HCOPyY:DESTINation <Medilm> ... 194
HCOPYIFORMAL e e 194
HCOPYLIMMEIATE] vttt 195
HCOPY:LANGUAGE <FOMMIA> oottt 195
HCOPy:PAGE:ORlentation <OMentation>  ......cccooiiiiiiiieiee et 195
HCOPY:PAGESIZE <SIZE> .o e 195
[ (OO L ] 7 U 194
[ (OO L ] 7 e R 194
B DN 2 e e 29
LOGic<I>:LABEl <Label> oo 46
LOGic<I>:LABel:State <lLabels> ... 46
LOGIic<I>:POSIHION <POSIION oottt 45
LOGICKISISIZE <SIZE> oo 45
LOGICKI>ISTATE <STATE>  oiiiiiiiiiiiiiee et e et a e 46
MASK:ACTion:PRINt:EVENt:MODE <EVEeNt MOAE>  ..ooiiiieiieee e 121
MASK:ACTion:PULSe:EVENt:MODE <Event_Mode> . ..occcoiiiiiiiiiicee e 121
MASK:ACTion:SCRSave:DESTINAtION  ..oiiiiiiiiece e 122
MASK:ACTion:SCRSave:EVENt:MODE <Event_Mode> .....ccccccooiiiiiiiiiiieiiieiiee e 121
MASK:ACTion:SOUNd:EVENt:MODE <Event_Mode> .......cccoviiiiiiieeieee e 121
MASK:ACTion:STOP:EVENTCOUNL oo 122
MASK:ACTion:STOP:EVENt:MODE <Event_Mode> ..o 121
MASK:ACTion:WFMSave:DESTINAION  ...veiiiiiiiie e 122
MASK:ACTion:WFMSave:EVENt:MODE <Event_Mode> .....ccccooiiiiiiiiii e 121
MASK:ACTION:YOUT:ENABIE <YOUT>  .ooiiiieiiiiiieie e 121
M A S K CH C OPY oottt e e e e e e e e e e 118
MASKICOUNT? et 119
Y AN N B AN 1 A USRS 120
MASKIDATAIHEADEI? oo e 120
MASK:DATAXINCIEMENT? et 120
MASKDATAIXORIGINT ettt et e e e te e eae e eaaeeenae e 120
MASKDATAIYINCIEMENT? .ot 121
MASKIDATANY ORIGIN? oo 121
MASKDATANYRESOIULION e 121
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MASKLOAD <FIlBNAME>  ..oeiiiie e 118
MASKIRESEECOUNLEI oo 122
MASK:SAVE <FIlENGME> oo e 118
MASKISOURGCE SSOUICES  oiiiiiiiiiii ittt e e ettt e e e ae e ettt e e e s taee e s es 118
MASKISTATE <STAE>  ooiiiiei i 117
MASKITEST <TBSE> oo 117
MASKIVCOUNT? et 119
MASKXWIDth <Xaddition> ..o 119
MASK:YPOSIHION <YPOSIIONS  1oiiiiiiiiiiiiiii et e 118
MASKIYSCALE <YSCAIE> oottt ettt e e e e e ettt e et e e e naeeas 119
MASKYWIDth <Yaddition> ..o e 119
MEASUremMent<mM > AOFF e 87
MEASUrement<mM>AON e 87
MEASUrement<m>:ARESUI? ..o 87
MEASUremMENT<mM>ICATEGONY?  oriiiiieii ittt e e et e e e e e e e e e e e e e tabaaaaea s 89
MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope> ........ccccocvviiiiiiiiinnnnnnn. 92
MEASUrement<m>[:ENABIE] <States> oo 88
MEASurement<m>:MAIN <MEASTYPE>  ..oiiiiiiiiiiiiiiiieee e 90
MEASurement<m>:RESUIt? [<MeaSTYPE>] .o 92
MEASurement<m>:SOURce <SignalSource>[,<ReferenceSource>] .........ccccccovviiiiiiiiiiinnn.. 88
MMEMory:CATalog:LENGth? <PathName> .. ..o 200
MMEMory:CATalog? <PathName>[,<Format>] .......cccccoiiiiiiiiiiiiiie e 199
MMEMory:CDIRectory [<DirectoryName>] ..o 199
MMEMory:COPY <FileSource>,<FileDestination>  ........ccoiviiiiiiiiiiiiiiic e 200
MMEMory:DATA <FileName>,<Datas ... 201
MMEMOIY:DCATAIOG? ettt ettt e e et e e e e e ettt e e e stneeesenaeeas 198
MMEMory:DCATalog:LENGth? <PathName> ........cccciiiiiiiiie e 198
MMEMOory:DELete <FIlESOUICE>  ..iiiiiiiii e 201
MMEMOIY:DRIVES? oo 197
MMEMory:LOAD:STATe <StateNumber>,<FileName>[,<msus>] .......ccccccvviiiiiiiiieiniiiiinennn, 202
MMEMory:MDIRectory <DireCtoryNamMeE> .....coiiiiiiiiiiiiiiiiiiee e 199
MMEMory:MOVE <FileSource>,<FileDestination>  .......ccccooiiiiiiiiiiiceccceeeeeecee 201
MMEMOry:MSIS [<MassStoragelS>] e 198
MMEMory:NAME <FIleName> .. 194
MMEMory:RDIRectory <DireCtoryName> ... 199
MMEMory:STORe:STATe <StateNumber>, <FileName>[,<msus>] ........ccccoevviiiiieeieiiiiiiinee.. 202
O P e 29
RO I T TSP PP U PSP PP UPRRPUPTTPI 29
PGENEratoriFUNCTION oo 124
PGENErator:MANUALESTATECSS  wooieeiii e 130
PGENerator:PATTern:ARBItrary:DATAIAPPENT  ...evveiieii e 128
PGENerator:PATTern:ARBitrary:DATA:APPend:BAND ....oooiiiiiiiiiiiee e 128
PGENerator:PATTern:ARBitrary:DATA:APPend:BOR .. ..o, 128
PGENerator:PATTern:ARBitrary: DATA:APPend:INDEX .....ccocuvviiiiiiiiiiiiiiiceeceeciee e 128
PGENerator:PATTern:ARBItrary:DATAILENGTN .ovveiiiiiiiie e 128
PGENerator:PATTern:ARBItrary:DATALSET] oo 127
PGENerator:PATTern:BURSTINCYCIE ... 126
PGENerator:PATTErN:BURSTISTATE ..o 126
PGENerator:PATTern:COUNTEr:DIRECTION  ..iiiiiiiiiiiiiiie et 129
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PGENerator:PATTern:COUNter:FREQUENCY  ...coiiiiiiiiceiec et 129
PGENerator:PATTErn:FREQUENCY  ..oiiiiiiiieeiee et 126
PGENerator:PATTEINITIME et 126
PGENerator:PATTErN:PERIOA  ....uiiiiiiiiie e 126
PGENerator:PATTern:SQUarewave:DCYCIE ..o 129
PGENerator:PATTern:SQUarewave:POLAITY  ...ocoiiiiiiiiiiciei et 129
PGENErator:PATTEINISTATE ..o e 125
PGENErator:PATTEINISTIME .ottt e e e e tavaaea s 125
PGENerator:PATTern:TRIGQer:EXTern:SLOPE . ..ocuvviiiiiiiiie e 127
PGENerator:PATTern:TRIGGEr:-MODE ... ..uuiiiiiiiiiiee e 127
PGENerator:PATTern:TRIGEr:SINGIE  ...ovueiiiii e 127
POD:CURReNt:STATE:MAXIMUIM? o oo 50
POD:CURReNt:STATE:MINIMUM? oo 50
O ] A A SR 47
POD:DATAIHEADEI? et 47
POD:IDATAIPOINTS .ottt e e 48
POD:DATAXINCIEMENT? oo e 49
POD:DATAXORIGIN? e et 49
POD:DATAIYINCIEMENT? e 49
POD:DATAIYORIGIN? oottt ettt e e e e e e 49
POD:DATAINYRESOIUTION? oo e 49
POD:STATE <STATE>  iiiiiiiiii it e et e e e e e e e e e e e a e e e e aaaa s 47
POD:THReshold <Threshold Mode>  ..oouiiiiiiiiiii e 46
POD:THReshold:UDLevel<u> <Threshold Level> ......c.cccooiiiiiiiiiiiiiiie e 47
PROBe<m>:SETup:ATTenuation[:AUTO]? ... 60
PROBe<m=>:SETup:ATTenuation:MANual <ManualAttenuation> .........cccccoiviiiiiiiiieiieciee. 60
PROBe<m>:SETup:ATTenuation:UNIT <UNit> ..o 60
PROBeE<M > SETUR Y P e 59
B S O A 1 o o P SRR 30
REFCUINE <M S IDATA? e e 108
REFCUrVe<m>:DATAIHEADEI? ..ot 108
REFCurve<m>:DATAXINCIEMENT? oot 109
REFCuUrve<m=>:DATAIXORIGIN? ittt ettt 109
REFCurve<m>:DATA:YINCIEMENT? oo 109
REFCUrve<m=>:DATAIYORIGIN? oottt et e e e et ea e 110
REFCurve<m>:DATA:YRESOIUTION? .o 110
REFCurve<m>:HORizontal:POSition <POSItION>  ....iiiiiiiiiiiiiii e 107
REFCurve<m>:HORIizontal:SCALE <SCale> ... 107
REFCurve<m>:LOAD <FIileNAmME> ..o 106
REFCUNVE <M= LOAD ISTATE ottt 107
REFCurve<m>:SAVE <FileNamMe> .. oo 106
REFCurve<m>:SOURCE:CATAIOG?  ..eeeiieeceie e 106
REFCUrve<m>:SOURCE <SOUICES  .iiiiiiiiiiiiii ittt 105
REFCUINVE <M ISTATE .o 105
REFCUNVE<M>IUPDAIE  .iiiiiiiiiiiieee e 106
REFCurve<m>:VERTical:POSition <POSItION> . .ccuiiiiiiiiiiiee e 108
REFCurve<m>:VERTICcal:SCALE <SCale> ..o 107
REFLevel<m>:RELative:MODE <RelativeMode> .........ccoooiiiiiiiiiee e 89
o1 SRR 30
RUN e 31
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RUNGCONTINOUS oottt et e e e et e e e e e s ettt e e e e e e e ettt e e e e e e e s e tbbaeaaea s 31
10N ST T [ TSRS 32
SIN G oo 32
S BT = 61e] 0] (T ol £SO PSRRI 30
STATUS:OPERATION:CONDITION? oottt sssnessnsnsnennes 207
STATus:OPERation:ENABIe <Enable> ..., 207
STATUS:OPERAtIONEVENL? oo 208
STATus:OPERation:NTRansition <NegativeTransition>  .......ccccoiiiiiiiiiiiiiiecceee e 207
STATus:OPERation:PTRansition <PositiveTransition>  .......ooiiiiiiiiiie i 207
STATUS I PRESET oo 209
STATUs:QUEStIONable:CONDITION?  ..ieiiiiiee e 209
STATus:QUEStionable:COVerload:CONDITION? ..o 209
STATus:QUEStionable:COVerload:ENABIe <Enable>  ......oooiiiiiiieeeeeeee e 209
STATus:QUEStionable:COVerload[:EVENT]? oo 210
STATus:QUEStionable:COVerload:NTRansition <NegativeTransition>  ..........cccoevviiiiiieiiiinnnnn. 210
STATus:QUEStionable:COVerload:PTRansition <PositiveTransition>  ..........cccceviviiiieiieiiiinnn, 211
STATus:QUEStionable:ENABIe <Enable> ... 209
STATUS:QUESHIONADIEIEVENT]? oottt esenesenenes 210
STATus:QUEStionable:LIMit:CONDITION?  ...uiiiieic e 209
STATus:QUEStionable: LIMit:ENABIe <Enable> ..., 209
STATus:QUEStionable: LIMIt:EVENT]? ..o 210
STATus:QUEStionable:LIMit:NTRansition <NegativeTransition>  .......ccccccieiiiiiiiiiiiieceeece 210
STATus:QUEStionable:LIMit:PTRansition <PositiveTransition> .........ccccceviiiiiiiiiiiiieece 211
STATus:QUEStionable:MASKICONDITION?  .uuuiiiii e 209
STATus:QUEStionable:MASK:ENABIe <Enable> ..o 209
STATus:QUEStionable:MASKEVENL]? e 210
STATus:QUEStionable:MASK:NTRansition <NegativeTransition>  .......cccc.coovvviiiiiiieceeece, 210
STATus:QUEStionable:MASK:PTRansition <PositiveTransition> .........cccccvvieeiiiiiiiiiiiceee e 211
STATus:QUEStionable:NTRansition <NegativeTransition> ......ccccccccooviiiiiiiiiiieceiceeee e 210
STATus:QUEStionable:PTRansition <PositiveTransition> . ....cccciiiiiiiiiiiiieeeeccieeee e 211
RS L= T U USRS PR 30
ST P e e 32
SYSTem:BEEPEr:CONTIOISTATE et 206
SYSTEM:BEEPErERROISTATE oottt sneesssnsnsnnes 206
SYSTEM:BEEPEIT:IMMEIATE] .o 206
SYSTeM:BEEPEITRIGISTATE ottt e 206
SYSTem:COMMunicate:PRINTENCSET e 196
SYSTem:COMMunicate:PRINTEICSET e 206
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt? ... 196
SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]? ..o 196
SYSTem:COMMunicate:PRINter:SELect <PrinterName>  .......ccooiiiiiiiiiiie e 196
SYSTem:DATE <Year>,<Month>,<Day> ...c..oooiiiiiiiii e 204
SYSTem:EDUCAtION:PRESET .ot 206
SYSTEMIERROMALL? oo 205
SYSTeMERROI INEXT? e e, 205
SYSTEMINAME o e 204
SY STEMISET <SBIUD S oot 205
SYSTem:TIME <Hours, <MiNUIE>, <SECONAS  ooiorieeee e e 204
SR T =10 H I o =1 =R 205
R S I R 5T =T SRR 205
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TCOUNtErENAB <ENabIe> oo 133
TCOuNter:RESUR[:ACTUAIT:FREQUENCY?  .iiiiieiiie et 134
TCOuUNter:RESUR[:ACTUAIPERIOA? oo e 134
TIMebase:ACQTime <ACQUISITIONTIME> ..ot 33
TIMEDASEIDIVISIONS? ettt ettt e ettt e et e et 33
TIMebase:POSIHION <OFfSET> oo 33
TIMebase:RANGE <ACQUISIIONTIMES  ..vvviiii i 33
TIMEDASE RATIME? oottt ettt e et e e et e e e ettt e e sttt e e e nnteeeeernaeeean 32
TIMebase:REFerence <ReferenCePoiNt> ... e 33
TIMebase:ROLLIENABIE <ROI> oottt ebee e n 37
TIMeDbase:SCALE <TIMESCAIES  ..oiiiiiiiiii ettt e e reaeeens 32
TIMebase:ZOOM:POSItioN <POSITION> ..ottt 77
TIMebase:ZOOM:SCALE <Z00MSCAIE> ..ot 77
TIMebase:ZOOM:STATE <ZOOMSTAIES  ..iiuiiieiiiiie ettt et e e et e e aneeeeeans 77
TIMebase:ZOOM:TIME <TIME> oottt e e et ee e e e e e 77
S T PSPPSR 30
TRIGger:A:CAN:ACKerror <AcknowledgeErrors ..., 176
TRIGger:A:CAN:BITSterror <BitStuffingError> ... 177
TRIGger:A:CAN:CRCerror <CRCEITOI>  ..uiiiiieii e 177
TRIGQErA:CAN:DATA <DAA>  oiiiiiiciii et 176
TRIGger:A:CAN:DCONdition <DataCondition>  .....oiiiiiiiiiiiiiiieeee e 176
TRIGger: A:CAN:DLENgth <Datalengths> ..o 176
TRIGger:A:CAN:FROMerror <FOrmEITOr=> ..o 177
TRIGger: A:CAN:FTYPe <FrameTypes> i 175
TRIGger:A:CAN:ICONdition <ldentifierCondition>  .......cooiiiiiiiiiiiiiii e 175
TRIGger:A:CAN:IDENTtifier <ldentifiers ... 175
TRIGger:A:CAN:ITYPe <ldentifilerTyPe> oottt 175
TRIGQer A:CAN:TYPE <TrQQEITYPES  .oiiiiiiiie et 174
TRIGger: A:EDGE:COUPING <COUPING>  1iiiiiiiiiiiiee et 64
TRIGQer: A:IEDGE:FILTErLPASS <STAte>  ooiiiiiiiiiiiiiie e 65
TRIGger: A:EDGE:FILTEr:NREJECt <State>  .iiiiiiiiiiiiii e 65
TRIGQErAIEDGE:SLOPE <SIOPE> oottt 64
TRIGGer: AIHOLDOTEIMODE ... 62
TRIGGErAHOLDOTIME ettt et et e naee e 63
TRIGENAI2C:ACCESS SACCESSS  oiiuiieiieaetieaitie et et et e et e e atee et eaate e et eatee e teeeteeaaeeeneeenes 157
TRIGger:A:I2C:ADDRess <AdAreSSSINNG ™  ooiiiiiiiiiiiieeeeieciiiei e aeaaea e 158
TRIGger:A:lI2C:AMODE <AIMOAES  .oiiiiiiiiiic et 158
TRIGErAI2C:MODE <IMOTE>  1oiiiiiieeie ettt 157
TRIGENAIZCPATTEIN  ctiiiitie ettt ettt bbbt ettt e e be e beeeae e 158
TRIGger:A:lI2C:PLENgth <PatternLength> ... 158
TRIGger:A:12C:POFFset <PatternByteOffSet>  .ouiiiiiiii e 158
TRIGger: A:LEVel<n>[[VALUE] <LeVEI> ..o 61
TRIGger:A:LIN:CHKSerror <CheckSUMEITOr=>  ..iiiiiiiiiiiiii et 187
TRIGErNAILIN:DATA <DATIAS  iviiiiiieiiiiiii ittt et e e e e e e e tbbaaaaee s 187
TRIGger:A:LIN:DCONdition <DataCondition> ....c.viiiiiiiiiiiiiiieece e 186
TRIGger:A:LIN:DLENgth <Datalength> ... 187
TRIGger:A:LIN:ICONdition <ldentifierCondition> ........cccoiiiiiiiiiiiiiiie e 186
TRIGger: A:LIN:IDENTtifier <ldentifier> ... 186
TRIGger:A:LIN:IPERerror <ldentifierParityError> .. ... 187
TRIGger:A:LIN:SYERror <SynchronisationErrors ... 187
TRIGQErA:LIN:TYPE <TrQQEITYPES oo 186
TRIGger: A:MODE <TriggerMOdes>  .ciuiiiiiiiiiiiiiii e 61
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TRIGger:A:PATTern:CONDItion <CONAITION  ..uiiiiiiiiiiiiiiie e 69
TRIGger:A:PATTern:FUNCtion <FUNCLION> ..o 69
TRIGger:A:PATTern:MODE <PatterNnMOode> . ....iviiiiiiiiiiiiee e 69
TRIGger:A:PATTern:SOURCE <SOUICESTINGS  uvviiiiiei it 68
TRIGger: A:PATTern:WIDTh:DELTa <PatternDeltas  .......ccociiiiiiiiiiiiiiiccee e 70
TRIGger:A:PATTern:WIDTh:RANGe <PatternRange> ....oooiiiiiiiieiiiiie e 70
TRIGger:A:PATTern:WIDTh[:WIDTh] <Numeric_Value> .......cccccoiiiiiiiiiie i 70
TRIGQErAISOURCE SSOUIMCES oottt ittt e e e e e e ee e e e e e 62
TRIGErASPEMODE <MOTE> 1ottt 148
TRIGger:A:SPI:PATTern <DataPattern> ... 148
TRIGger:A:SPI:PLENgth <PatternLength> ... 149
TRIGger:A:SPI:POFFset <PatternBitOffSet>  ....oooiiiiiiiiiiii e 149
TRIGEr ATVIFIELA <Fields> oo 67
TRIGENATVILINE <LiNE> oo 68
TRIGger: A:TV:POLarity <POIAritY> oo 67
TRIGger: A:TV:STANdard <Standard>  .......coiiiiiiiiiiee e 67
TRIGENAITYPE <TYPE> oottt sttt ettt ettt et e et e et e et eentaeeeras 62
TRIGGer:A:UART:IMODE <MOGE>  .oiiiiiiiiiiiiiec ettt 168
TRIGger: A:UART:PATTern <DataPattern>  .......coiiiiiiiei e 169
TRIGger:A:UART:PLENgth <PatternLength> ..o 169
TRIGger:A:UART:POFFset <PatternByteOffset> .. ......cooooiiiiii e 169
TRIGer A:WIDTh:DELTa <DEIAS ..o 66
TRIGger: A:WIDTh:POLarity <POIAritY>  ..iiiiiiiiiiiiiiiec e 65
TRIGger: A:\WIDTh:RANGe <RanNgeMOode> ... 66
TRIGger:A:WIDTh:WIDTH <TIMET> ittt ettt 66
TRIGger:EXTern:COUPIING <EXternCoupling>  .vuviiiiiiiiiiiii e 62
TRIGGENOUTIMODE ottt ettt ettt e et et e et et et e e naeeeeeas 63
TRIGGENOUTIPLENGEN ettt ettt et e et e e e e e e naeeeeeas 63
TRIGGEMOUTIPOLATITY oo 63
LIS T PR RPPRRURP 31
TS TAMPIACLEAI it e e e e e e e 78
TSTAMPICLEAL e 78
RIS E=Ta0] o AV = PRSP PPRSTRN 78
TSTAMPIPREVIOUS oottt ettt e e et e e et e e et eeeeneaeeens 78
LIS = La 0] o o = PP UURURUUUUPPRPRRN 78
B4 A PSP PPRSURP 31
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